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Welcome
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This documentation is intended to serve as a detailed description and tutorial for advanced functions of
CodedColor PhotoStudio. In user interface and dialog design we have tried to stay close to the
Windows Explorer and other important image applications on the market, so this documentation is not
on Windows usage in general.
We will try to update and enhance this document with every new release, but you may find some older
screen shots and incomplete topics. If you would like to help us translate this file and our software into
other languages, or if you have any other constructive input concerning this documentation, or would
like to see a missing topic in the future, we would appreciate your feedback.
We truly hope you enjoy CodedColor PhotoStudio and find it useful to view, publish and share
your growing archive of digital photos. With your help, we will continue to improve this software and
provide you with the features you need.
Thank you for supporting us,
Your CodedColor team
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Contact & Links
Homepage: http://www.codedcolor.com
email: info@codedcolor.com

Feedback & Support: http://www.codedcolor.com/redir.php?lng=EN&dst=support
Version history: http://www.codedcolor.com/redir.php?lng=EN&dst=history
Forum: http://forum.codedcolor.com
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Installation & Registration

2.1

Installation
The installation of CodedColor follows the guidelines of Microsoft Windows.
CodedColor is installed on your hard drive by running the installation program.
There are three locations where files are written to by default:
1.
2.
3.

The program files are usually stored in C:\Program Files\CodedColor (may be changed
during installation)
The database and organization data is stored in the so called Workdirectory, default:
C:\Documents & Settings\All Users\CodedColor (may be changed after installation)
The personal data such as screen preferences is stored in user directory: default
C:\Documents & Settings\<user>\CodedColor

Important
· CodedColor never stores any data or thumbs into your image directories
· CodedColor never changes images without your approval, without one exception: if the image
allows for IPTC information and has R/W permission, then this might be automatically added from
the database.
· File associations can be set or restored in the Tools > Program Settings > Installation panel.
· The Workdirectory can be moved in the Tools > Program Settings > Installation panel. Only
change this if you are low on diskspace!
· CodedColor stays active in the tray-icon after you close the application, ONLY in order to detect
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changes to your directory and image filenames, and to correct broken links in the database. This
also has the positive effect, that a doubleclick on an image in the Windows Explorer will
immediately show the image in fullscreen mode of CodedColor, with all zoom and editing options
available.
· CodedColor never spies on your system, and it does not transfer personal data without your
approval.
· CodedColor checks your installation from time to time (only if there is an online connection), in
order to remind you of new versions.

Related topics
· How do I register from behind a firewall?

2.2

Program Updates
There are two mechanisms for updating your installation of CodedColor:
1. The AutoUpdate feature of the LiveUpdate panel in the Program Settings dialog.
2. The LiveUpdate dialog
The AutoUpdate feature looks for new CodedColor versions at defined intervals. You are always
queried if you want to download and install a new release. The Auto Update feature only looks for
version jumps from "x.y" to "x.y+1", i.e "2.7" to "2.8". It does not care about minor updates (i.e "2.7.1" to
"2.7.2")
The LiveUpdate dialog displays all bug fixes, third party modules and new releases of CodedColor. To
use this dialog, you need to connect to the internet, as the update information is downloaded prior to
the display of the dialog.
Basic facts about AutoUpdate and LiveUpdate:
· Newer versions of CodedColor are usually installed through the AutoUpdate feature.
· Third party tools can be manually downloaded and installed through the LiveUpdate dialog.
· No personal information is lost, if you install a newer version of CodedColor over an existing one.
You can even uninstall CodedColor and later install a newer version, without loosing your
annotation or thumb database.
· All downloaded setup programs are archived in the C:\Programs\CodedColor\LiveUpdate
directory of your installation. If you have to reinstall one of the downloads, look in this directory.

More information
· If you choose to manually download and install a newer version of CodedColor from the Web,
make sure you install into the same directory of your existing installation.
· Make sure CodedColor is not running, if you are doing a manual update! Look into the system tray
(lower right part of the taskbar) and close the program with a right mouseclick, if you see a
CodedColor icon.
· Version History
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Program Settings

3.1

Installation tab
File Associations
By setting the checkboxes in the file type list, you can link the corresponding image files on your hard
drive to CodedColor. Setting a checkbox has the following effects:
· When you double click on an image in the Windows Explorer, it is opened in CodedColor.
· You can still open the image in an alternative Application by selecting Right mouse > Open with
· The CodedColor icon beside the file has no meaning except to show you, that the default
application for opening this file is CodedColor.
· Your images are not changed or edited
· You can always undo the checkbox, and the old file association will be restored.
The Workdirectory
Apart from a number of application files copied to your C:\Program Files folder, the installer writes
some standard file association keys into your registry and creates a Workdirectory which contains
among others:
·
·
·
·
·
·
·

Program settings and log files
The annotation database
The thumb database
Album links
Catalogs and print orders
Batch conversion directories
Export directories

The Workdirectory is usually found under your C:\Documents & Settings\All Users\ directory
or directly below the CodedColor application directory, depending on your Windows version. Since it
also holds the database, it may grow in size over time, and you may need to move it to a different
location later. Never move or rename any directories inside the Workdirectory manually - use the
Installation panel of the Program Settings dialog for this.

Related topics
· Installation

3.2

Explorer tab
Home directory of new explorer window
The default folder which is opened in a new Explorer window
Only show images inside album directories
If the Explorer is in Detailsview, then you usually see little icons beside the filenames. These mini
thumbs may slow down the list view. You can enable this check box to hide these icons, if you are not
inside an album directory.
Only show check boxes inside album directories

© 2013 1STEIN GmbH

Program Settings

5

This option is usually turned on, as check boxes primarily make sense if you are inside an album
directory. Checkboxes can be used to exclude images from Web Albums. If you plan to export nonalbum directories as well, and you want to exclude images from the export, then keep this option
turned off.
Load original image into image preview panel
The image preview panel usually shows only the reduced thumb of the
image. If you are frequently working in the Explorer Detailsview instead of
the Imageview, and you want to be able to zoom completely into the
selected image inside the preview panel, then you should turn this option
on.
Remember, that browsing the files is now slower, since the original image
must be loaded into this panel everytime you click on a new file.
Date Column
This option determines the default sort order for the date column, when an Explorer window is first
opened.
1.
2.
3.

The first setting displays the classic file modification date (Windows Explorer) inside the date
column.
If you are frequently inside a catalog, then it might make sense to activate the second option,
because the file modification date of the linked file (original) is resolved and displayed.
If you want to display the creation date of the image (photo timestamp), then activate the third
option.

To read more, goto the topic Filesystem Sorting.

More infos
What's the difference between file date and photo date?

3.3

View Options
· Automatically play attached sound: most modern digital cameras allow you to attach sounds to
photographs. Often this is used by the photographer to describe the situation in which the picture
was taken. Sound files usually have the same filename as the image they're attached to, but with a
different file extension. CodedColor can automatically play these sound files while viewing the
image. May also be switched on/off by clicking on the speaker icon.
· Antialias (sharpen thumb): see Glossary
Turn this option on to smooth edges inside thumbs (Lanczos3 filter). The creation of a thumbfile
will take slightly longer, however.
· Antialias (sharpen image): see Glossary
· Position navigator panel: Defines the position of the navigator panel within the main window.
Disabled if no position is checked. The navigator panel is a useful tool to simplify scrolling in
images that do not fit on the screen, ie. large images or zoomed pictures. Change the displayed
section by moving and resizing the red selection frame.
· Load navigator only if thumb is available: Since the navigator is a copy of the entire image,
viewing an image with the navigator visible would take double the loading time. This is why
CodedColor only loads the much smaller thumb into the navigator. If no thumb is available, the
navigator is turned off by default.
· MB image size, above which fullscreen preloading of images is disabled: in the screenshow
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(fullscreen) mode, the next image is preloaded while you are viewing the current image. This
usually speeds up viewing quite a bit, but in a directory with very large images, this option can
backfire on you. Usually, you can set this value to at least 10 MB or higher.
· Immediately add files to database when opening a directory
This option always adds all images of the current directory to the database, instead of when
viewed. This is useful for immediate IPTC/EXIF searching. You should enable this option, if you
frequently intend to use the timeline (calendar) feature. The timeline fully depends on the
information from the database, not from the filesystem.
This option also creates all image thumbs for the directory, which may take a while but speed up
viewing afterwards.
The following status dialog appears, when you select this option and browse to a directory the
first time. You can always cancel the dialog, as it will just continue the next time you visit the
folder.

Hint: Records are also added instantly, when you create an album in the directory and enable the
Add or update all database records now option.

Related Topics
· Why does it take long to browse a folder for the first time?
· Are my images stored in the database?
· Database options

3.4

Database tab
Database for file annotations
CodedColor uses a local XML database in the standard version. For the professional version we are
planning to integrate an open SQL database like Interbase or MS-Access, which can be installed on a
network drive. The local XML database is stored in a compressed binary format. The location of the
main database file is Workdirectory\Data\FILES.BIN, but you can export this to FILES.XML in
order to view the data in the Internet Explorer or a simple text editor.
Storage
· Set the Autobackup option, if you are not doing manual backups regularly. This moves the old
FILES.BIN to Workdirectory\Backup, before saving any changes from memory to disk. If
anything goes wrong during storage (i.e. disk full), then you still have the backup file.
· Set the Autosave option, if you are continuously adding annotations and keywords to your
images. In the given time interval, the database FILES.BIN is written from memory to the folder
Workdirectory\Data.
· Press Save Database Now in the annotation dialog, while you are adding descriptions to your
images.
You should not use both Autobackup and Autosave at the same time, since a corrupted FILES.BIN
could overwrite the healthy one in the Backup folder, without your chance of interaction. Read more in
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the Backup database topic.
Thumb database (Miniatures)
The thumb database is currently a directory containing thumb files. These are generated on-the-fly,
when you open an Explorer window and view the contents of a directory. The thumb database (or
cache) can be deleted, if you think that it is no longer synchronous with the annotation database. Use
the Clear Cache button for this.
To learn more about the thumb database, open the newsgroup topic
Why does it take long to browse a folder for the first time?
Options:
· If you have limited disk space, uncheck the option Store large images in thumb database.
· If you are worried about speed, decrease the Width of generated thumbs to less than 250
pixels, and increase the Thumb creation threshold to more than 100 kb.
· Usually, you should Use thumb creation thread checked. Only turn off this option, if you
experience problems with the display of thumbs on your system.

Important Note
If the on-the-fly generation of thumbs slows down the browsing of folders, you have two useful
options:
1.
2.

You can create an Album for the folder and generate all thumbs immediately.
You can enable a view option to generate all thumbs the moment you first visit a directory.

Related Topics
·
·
·
·
·
·
·
·
·
·

3.5

Why does it take long to browse a folder for the first time?
Are my images stored in the database?
Is the database compatible with other programs?
Why does the program stay active in the tray?
How do you handle broken links?
How stable is the database?
Search Database
Database Maintenance
Database Definition
Backup & Restore Database

Slideshow tab
Set the delay (fliptime) in seconds after which the image will be changed (only valid in play mode).
Set the transition duration in 1/10 th seconds. A value of 0 turns off transition effects.
Specify when you want to see the image title.
Auto: displays the title together with the dropdown button ie. when moving the mouse
Always: the title will not be hidden.
Never: do not display the title
Test the Transition effects by clicking through them, and determine the Titlebar Elements that will be
displayed below the image.
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Image Editor tab
Automatically scroll zoomed images
If you zoomed the image with the right/left mouse buttons, this option will softly scoll (pan) the image
when moving the mouse towards it's borders. With deactivated option, you have to use the left mouse
button to manually pan the image.
Preserve original filedates when saving image changes
This option preserves the file modification date (filedate) after changes in the image editor, and when
EXIF/IPTC information is written into the file after editing the image annotations. Preserving the
filedate is not a standard expected behavior, because it should display the time of the last change.
However, some users want to view images in a software other than CodedColor, and this other
application might only allow a sorting of images by the modifcation date. Editing the images would thus
change the original sequence of the images.
In CodedColor, you can sort the images by the original file creation date, which never changes. You
could therefore leave this option turned off, in order to reflect image modifications correctly in the
filedate.
Hints:
· the image rotation dialog always preserves the file modification date, since 90° rotions in
CodedColor are lossless and there is really no need to reflect this type of change in the file
system.
· The top menuitem Tools > Restore Creation Filedates in the Explorer allows you to reset the
filedates of all edited images in the current folder to DateTimeOriginal, which is the
EXIF creation time of the photo inside the camera. That way, you can sort your images in the
orignal creation order in applications like the Windows Explorer.
Remember options when saving image changes
Turn this option on, if you want to remember all Advanced settings in the Save or Save As dialogs.
Careful: if you need to decrease the JPEG Quality for a single image only, then all subsequent save
operations would also decrease the quality of your images. If this setting is forgotten, you could thus
accidentally destroy your images.
Backup into subfolder, Save EXIF annotation changes
When you save annotations to the image in the Title and Annotations dialog, you may loose EXIF data
from fields, that don't belong to the EXIF standard. If you have such fields in your images, you should
deactivate the option Save EXIF annotation changes, or use the Backup into subfolder option
above it. This option also backups your images, before storing changes from the Image Editor.

3.7

Applications tab
CodedColor allows you to use other picture editing software to manipulate your images. Select File >
Send to, or right-click on the thumb and select the editor of your choice. The selected pictures will then
be transferred to the chosen application. CodedColor will automatically detect any changes made by
the third-party tool. You can customize the list of tools by selecting Define "Send to" List.
The Applications tab shows all applications installed on your Windows system, if they are correctly
registered by an installation program. In this list you can select the external editors of your choice, with
which you want to edit your pictures.
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If you want to refresh this list of applications (after installing more image editing programs), press
Refresh list. Please note, that you then have to reselect your preferred image editors.
List of installed Applications
Enable those applications, that you want to
appear in the Send To menu.

Organizer with Applications folder
The Application links in this folder can be
refreshed by clicking on Program Settings
> Applications > Refresh List. You can
start an application by doubleclicking on the
linkfile in the Organizer.

Send To popup menu
This menu appears in the Explorer in
Imageview and Thumbsview, when pressing
the right mousebutton on a thumb and
selecting Send To. The selected image will
then be opened in the desired application,
for instance Photoshop or MS-Paint.

Related topics
· Image Editor

3.8

Additional tab
Select the style of your toolbar and menu by setting the Menu and toolbar theme.
The two options Autorun program at windows startup and Minimize to tray on exit allow for a
maximum database integrity. If CodedColor is always running, it will receive all filechange notifications
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from programs like the Windows Explorer, and correct it's database records accordingly. Other
database oriented image organizers may become async with the file system, and end up with
numerous broken links.
If you are low on resources, then you can turn off these options, but make sure you rename images or
move folders inside CodedColor, instead of the Windows Explorer. However, even if you don't follow
this recommendation, then CodedColor will usually be able to correct broken links on-the-fly.

Related topics
· How do you handle broken links?
· Why does the program stay active in the tray?
· Database tab

4

View Photos & Movies

4.1

Explorer
Explorer Views
1.
2.
3.
4.

Detailsview: classical Windows Explorer layout. Right Mouse opens the Windows Explorer
context menu.
Iconsview: same as 1, only with large icons (thumbs).
Imageview: default CodedColor view. Right Mouse opens CodedColor context menu.
Thumbsview: same as 3, only without image frame.

Explorer layout in Thumbsview

1.

Album shortcut menu: if you create an album link, you can browse quickly to that location by
clicking here

2.

Album location: if you create an album in this folder, the folder background color turns green,
and a shortcut entry is added to the organizer

3.

Infopanel showing image and EXIF information

4.

Thumb frame (filmstrip). the icons at the thumb borders tell you, whether the image has
annotations or has been added to a catalog. A click on the annotation icon opens the annotation
editor. You can select several thumbs by using the SHIFT and CTRL buttons. You can exclude
an image from the album by selecting Right Mouse > Exlude Image.
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5.

Context button: opens a context menu (or use Right Mouseclick as alternative). The popup
menu contains many image editing functions. To rotate an image for instance, you can also
press CTRL+R as a shortcut.

6.

Thumb frame separator: if you drag this separator, you can resize the thumb frame. The
maximum thumbsize is determined in the Program Settings > Database tab.

7.

Image frame: Left Mouseclick zooms into the image, Right Mouseclick zooms out. Holding
the Left Mousebutton pressed in a zoomed image, you can move the display frame.
Hint: If your image is a multimedia file, then you see a navigation bar at the bottom.

Facts about the CodedColor Explorer
·
·
·
·
·
·
·
·
·

4.2

Behaves similar to the Windows Explorer
Knows Multiselection and Drag & Drop
Has two additional views: the ImageView and the ThumbsView
Has an additional special contextmenu just for images.
Displays image parameters, EXIF information, annotations, album shortcuts, etc.
Several instances can be opened at the same time, for instance to browse different albums
Drag & Drop between Explorer instances possible
Thumbs can be resized by dragging the thumb frame separator
Most operations in the Explorer are introduced by a Job-Wizard, which allows several types of
Image Selection.

Screenshow
A picture (or group of pictures) can be displayed in Screenshow mode (also called Fullscreen) by
double-clicking on the thumbnail. You can also press the ENTER key to display the currently selected
picture(s) in Screenshow mode or use the menu shortcut.
This mode is the preferred mode for viewing pictures one at a time. For an overview of your pictures
use the Explorer window. If you want to edit images you should use the Image Editor.
You can use the next and previous buttons, to move between the pictures. The list of pictures is
determined as follows:
· If you only had one image selected or started the screenshow by double clicking on an image all
images of the current folder will be included for navigation. Note: If the selected image was
included in the album only included images will be shown.
· If you had more then one image selected only the selected images will be shown. This allows
complete control over what pictures are displayed.
Title Bar
You can toggle the display of the title bar at any time by selecting view > view title or pressing
CTRL+T. The title bar is also available in the Edit mode.
Zoom

Title or Filename Date

Filename (only if title)

Image#

Start: This starts the automatic slide show. If started, the slide show will automatically
cycle through the pictures using the delay and transition duration set in Slideshow options.
You can use the next/previous buttons or zoom into images while the slideshow is
© 2013 1STEIN GmbH

12

CodedColor Photostudio - Documentation

running.
Stop: This stops the automatic slide show. The button is only visible while the slideshow is
running.
Previous / Next Button: Displays the previous/next image in the list. You can also use the
PgUp or PgDn keys.
Popup-menu: Displays the popup-menu to access the most important options and
controls.
Exit: Closes the current window. You can also use the ESCAPE key in screenshow mode.

Hint
· You can switch between Screenshow and Edit mode by Pressing F6.
· You have access to the most important actions, such as editing and Title and Annotations,
through the popup menu or by using the shortcut keys.

Related topics
· Slideshow options
· Image Editor

4.3

Multimedia Toolbar
The mutimedia toolbar is available in the Explorer and in the fullscreen view, also called Screenshow.
It is automatically displayed for multimedia filetypes (movies).

The toolbar's controls from left to right are:
·
·
·
·

Restart movie
Play / Pause movie
Stop movie
Continuous play (restart when done)
Create thumb from curent frame (only available in Explorer window)

Copy current frame to clipboard
· Loudness slider (bottom = off)
· Slider to position current frame
· Speed (< 1 for slow motion)
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Keyboard Shortcuts
The following shortcuts can be used when viewing videos:
Keys
SPACE or RETURN or
PAUSE
ESCAPE
POS1 / END
INS
ARROW LEFT
ARROW RIGHT

Effect
Start / Pause film
Stop film (press again to exit fullscreen mode)
Reposition movie to the beginning / end * ²
Copy current frame to the clipboard
Previous movie
Next movie

ARROW UP

Fast rewind 5% of the movie length ²

ARROW DOWN

Fast forward 5% of the movie length ²

CTRL + ARROW UP

Pause film and skip 1-2 frames back ²

CTRL + ARROW DOWN

Pause film and skip 1-2 frames forward ²

* This key jumps to the first / last file in a folder, if the current file is an image instead of a video
² Some videos don't support this operation, or take a few seconds to react

Important
· We recommend that you install the latest Windows Servicepack with DirectShow and the KLite Codec Pack
· For more infos see Supported File Types and search for "DirectShow" in the Online FAQ
· Wikipedia: DirectShow

4.4

Timeline Calendar View
The Timeline feature of CodedColor is basically a special and simplified database search option.
When you execute a timeline search, a search result folder with linkfiles to the original images is
created. Since this folder is like a catalog, it can be viewed just like any normal directory with original
images.
The timeline tabsets in the Explorer allow you to view all photos inside the database in a
chronological order. In order to get the most out of this feature, you should turn on the option Add
files to database immediately when opening a directory in the Program Settings. Through this
option, you ensure that all records are added to the database immediately when you open a directory
the first time. Only records inside the database can be searched and displayed in a timeline result.
You have the following basic timeline search options:
1. Doubleclick on a month row: does a search for records of the current year and month only
2. Set checkbox for several years and months and press Execute button: search result for all
checked months is created and opened in the Explorer
3. Doubleclick on a topic row: original folder corresponding to selected topic is opened in the
Explorer. Any filter value (see below) is ignored.
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4. Set checkbox for several years and topics and press Execute button: search result for all
checked topic rows is created and opened in the Explorer
The third option is pretty fast, as the original folder is opened. However, this option ignores any given
filter value (see below). All other options create a search result folder with linkfiles, similar to a catalog
which can be browsed. This may take some time, but you can then chronologically view images from
different locations (folders) in your filesystem. You may then also set the option Display Creation
Date, and sort the result directory by the Created [Ascending] column.
In addition to these basic timeline options, you can further narrow the search result by adding a filter
value in the editfield at the top. This value is checked against all string fields in the database,
including EXIF and IPTC. A search for "Canon" would return all records that have this value in the
EXIF Maker field. A search for "Canon jpg" would further narrow the result to all JPEGs that we're
taken by a Canon camera.

Important
·

The timeline search may produce broken linkfiles in the search result folder. Sometimes
CodedColor is unable to resolve broken links, leading to orphaned records in your database.
Call Cleanup Database to conservatively remove these records. If the search result still shows
broken links after a cleanup, then these records are considered relevant, or the drive may be
temporarily unavailable. You can suppress these broken links by enabling the option Hide
broken links in the context menu of the timeline tree (right mouseclick) and by then recreating
the search result.

·

A timeline search may produce thousands of resulting linkfiles. These may take some time to
load in the explorer, so use the timeline checkboxes with care, if you have limited CPU
resources.

·

If you are missing entries in the timeline tree, then these images probably have not been added
to the database yet. To make sure that all images of a folder are added to the database
immediately when viewing the folder the first time, turn on the option Add files to database
immediately when opening a directory in the Program Settings.

·

Since timeline search result folders can hold thousands of linkfiles (and this may considerably
slow down your file system), these folders are removed again after the program is terminated. If
you want to keep a search result, you should move the corresponding directory to another
location.

·

Use the Keyword View to search for Keywords in a very comfortable way. It can also be used to
assign Keywords to many images at once.

Related topics
·
·
·
·
·

4.5

Search in the Database
Search for keywords
Database Maintenance
How do you handle broken links?
What's the difference between file date and photo date?

Keywords View
There a two places in CodedColor where you can add keywords to selected images:
1. the Annotation Dialog
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the Keywords View of the Explorer

There are two places in CodedColor, where you can search for keyworded images:
1. the Database Search Dialog
2. the Keywords View of the Explorer
The Keywords View is the most comfortable way to assign keywords to several images at once, and to
search for keywords in the database.
To the left you see a typical keyword list.
Lines marked green show the keywords of the
currently selected image. Lines marked blue
show any changes to the keywords of the
currently selected image.
Any change (blue lines) is stored in the selected
image(s) only when you press the green Save
button.

How to assign / remove Keywords to / from images
To assign several keywords to (multiple) images, you must follow these steps exactly:
1.
2.
3.
4.

add any new keyword to the list through the Edit Field above the list.
select the images in the Explorer (use STRG or SHIFT for multiple selection)
check (or uncheck) the desired keywords in the keyword list.
press the green Save button to write the checked keywords to the database and into the
corresponding IPTC field of the selected image files.

Careful: if you selected multiple images, ALL will now have the same keywords.

How to remove Keywords from the list
Keywords are displayed in the keyword list as long as they are assigned to at least one image in the
database. You cannot delete keywords from the list, unless they were just added via the Add Keyword
edit field and were not yet assigned to an image.
To remove any other keyword permanently from the database, and thus also from the keyword list, you
must follow these steps exactly:
1.
2.
3.

search for the images containing the unwanted keyword using the Binocular button.
remove the keyword from each image in the search result, by unchecking the keyword and
pressing the Save button. Do this One by One, otherwise you will assign all other checked
keywords to ALL of the selected images !
now refresh the keyword list via the Refresh context menuitem (Right Mouseclick).

If no other image has the keyword assigned to it, then it will disappear from the list.

How to search for keywords
There are two important options for the keyword search, both found under the context menu, when you
click with the Right Mouse in the keywords list:
1.

Hide broken links: If you enable this option, broken links (i.e. orphaned database records) will
be ommitted from the search result. These records can belong to images on unavailable or
removable drives. (To permanently remove obsolete records, you may consider a
Database Cleanup from time to time.)

2.

All Keywords must match: use this option to toggle between the "All Keywords" (AND) or "Any
Keyword" (OR) search mode. When activated, the search result will be narrowed to images that
contain ALL of the checked keywords. If disabled, the search will be widened to images
containing ANY of the checked keywords.
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To now perform the search, click on the Binocular button. As in the Timeline View, the search result is
written into a temporary folder. It consists of links to the original images. Similar to a Catalog, the
search result can be viewed like any other image folder, for instance in the Screenshow (fullscreen
mode).

Important
· Keywords from the database are always replicated to the IPTC Keywords field and thus stored in
the image. If you send the image to someone by eMail, he will be able to see the keywords, along
with any other IPTC information.
· The Search Dialog and Keywords View will show only those keywords that are found in the
database and have been assigned to at least one image. The Annotation Dialog shows all
keywords that were ever defined by the user, no matter if they were actually assigned to an image.
The keywords are stored in the CodedColor settings file ccolor.ini.

Related topics
·
·
·
·

4.6

Timeline View
Annotation Dialog
EXIF/IPTC fields
Search in the Database

Panorama Viewer
The Panorama Viewer is a freeware application included with and fully integrated into CodedColor. It
allows you to view wide panoramic images in an animated and realistic manner. Panoramas can be
created with any digital camera by shooting a series of images that all have a small overlapping vertical
border, which can then be stitched together by some applications like CodedColor.
You can start the Panorama Viewer from within CodedColor through:
· Main Menu > View, or
· Selecting an image in the Image or Thumbs View > Context Menu > Open with
When you open an image in the Panorama Viewer from within CodedColor, no shortcut to the image is
created in the left hand list of panoramas. If you want to create this shortcut, then press the Open
Panorama button above the list. The current panorama image will already be selected, and you just
need to press the Open button.
Hint: All shortcuts are stored in the Organizer > Local Catalogs > Panoramas 1 folder, and can also
be viewed and managed from there.

Important
The Panorama Viewer needs fast graphics resources in order to render and animate the panorama
in a realistic way. If you're getting a headache (in the true meaning of the word), then turn off
Antialiasing, or decrease the size of the panorama in the Image Editor of CodedColor. You should
then use an antialias filter like Lanczos3 or Fast Linear, in order to sharpen the resized panorama.
To create Panoramas, use the Panorama Stitch dialog.

Options
To view all options and interface elements of the Panorama Viewer, visit the
© 2013 1STEIN GmbH
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Panorama Viewer homepage.

5

Organize Photos & Movies

5.1

Organizer
The Organizer is a special Explorer window, displaying the CodedColor Wordirectory. All write
operations of CodedColor are done in this location on your disk, whether you export albums, convert or
mail images, create album shortcuts or add images to catalogs. Even the Recent List of edited images
is kept here and can be browsed.
In fact, whenever you find images in the Organizer structure, the layout switches to the Explorer
Imageview and you won't even notice you are inside the Organizer. Most images in the Organizer are
linkfiles, like those in Catalogs, Print Orders and Search results, so the storage space in the Organizer
is kept to a minimum. If you export albums or do batch conversions, the converted images are stored
in the organizer file structure.
Organizer layout

1.
2.
3.
4.
5.
6.

Folder for album shortcuts. Example: the album shortcut "Marokko" might point to
D:\Images\2002\Marokko
Catalog folders with linked images: here you collect your favorite images and screenshows
List of album shortcuts: SHIFT+F2 opens the Album editor
Physical location of album (path to album): a Doubleclick opens the selected album in a new
Explorer window
Album information (size and amount of images)
Album locations, that are currently not available (network drive, removable media like CD), are
grayed out

Facts about the CodedColor Organizer
· Only one instance of the Organizer can be opened at a time. The Explorer can have many
instances (MDI children).
· The Organizer is basically a simplified Explorer, pointing to the Workdirectory of CodedColor.
· The main use of the Organizer is to store album and catalog linkfiles, thus acting as a shortcut
navigator.
· Exported albums and converted images are also found in the Organizer.
· The organizer is the first window opened when you start CodedColor.
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5.2

File Management

5.2.1

Drag & Drop
Drag & Drop in CodedColor follows the rules of the Windows operating system. There are a few
exceptions, however, and a few important things to remember:
Dragging between applications
Is supported. You can drag from the Windows Explorer to the CodedColor Explorer and vice versa. If
you use the Right Mousebutton for dragging in Details or Iconsview, instead of the left button, you get
a popup menu allowing you to choose the drag style: Copy, Move or Create Link.
Dragging to the Catalog or Order Panel
When dropping images into the Catalog or Order Panel at the bottom of the Explorer, CodedColor
automatically creates links to the original images. Catalogs are used to collect images from many
different directories, without the disadvantage of redundant diskspace. This concept has one
exception: When you drag images from a CD, CodedColor lets you choose whether to create copies of
the images, since the CD will probably not be mounted, when later viewing the catalog or processing
the order.
Dragging between Explorer Windows
To drag images within CodedColor, you need to normalize all open windows. Source and destination
Explorer Windows must be visible on the CodedColor desktop, in order to move or copy images
between open locations or albums.
Dragging to the CodedColor Desktop
When dragging image files to the empty CodedColor Desktop, or to the Navigation Tabset at the top,
the images will be opened in the Image Editor.
Dragging Thumbs
When dragging thumbs between thumb panels (filmstrip) or from the thumbs view, the Right
Mousebutton menu explained above is deactivated. Dragging thumbs between Explorer windows
always produces copies of the original files, or copies of the linkfiles, when dragging from Catalogs. To
copy the original files from catalogs, use the menuitem Copy & Move > Copy Original Files instead.

Important for Custom Sorting
· Some dragging or cut & copy operations create links to the original files. Remember, that if the
original files are customly sorted, they have prefixes of the form (00003). Changing the sort order
later will create broken links, since the links now point to original images with a possibly changed
sorting prefix. As a rule of thumb, is therefore not a good idea to create linkfiles to original images
having a sorting prefix.
· If you drag from a directory, which is customly sorted, to a directory which has no custom sorting,
the sorting prefixes of the form (00003) are removed. Likewise, sorting prefixes are
automatically added when inserting into a sorted directory.
· Renaming in CodedColor usually preserves sound attachments. This is not the case for renaming
or file operations in the detailsview / iconview of the Explorer.

Related topics
· Catalogs
© 2013 1STEIN GmbH
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· Order quality prints
· Cut, Copy & Paste

5.2.2

Cut, Copy & Paste
Cut, Copy and Paste in CodedColor follows the rules of the Windows operating system. In order to
facilitate the work with linkfiles, an important concept in Catalogs, there are a few additions and a few
important things to remember:
The default Copy (CTRL+C) and Paste (CTRL+V) actions differ from Windows, if the Paste target is a
Catalog or Print Order folder. In this case, CodedColor will create links to the original files. You can
always force a desired behavior, by selecting the appropriate CodedColor action through the Edit >
Copy & Move (see A below) and Edit > Paste (see B below) menu entries.

A. Copy
A.1 Copy Files
Copies the selected files to the clipboard.
Note: If you are changing the Custom Sortorder of your image files, then select another file in the
same folder and call Copy & Move > Insert Before after this.
A.2 Copy Original Files
Always copies original files of the selected files to the clipboard. It differs from the Copy Files above,
if some of your selected files are linkfiles. In this case, the original files are copied to the clipboard,
not the linkfiles. This is useful, if you want to copy & paste the original images of a Catalog to some
other location.
A.3 Copy Image
Copies the bitmap of the last selected image to the clipboard. You can then paste it into any
application that can handle bitmaps, like Paintshop Pro or Winword, or open a new Image Editor
within CodedColor by selecting Edit > Paste > Paste into new image.

B. Paste
B.1 Paste Files
Pastes the files from the clipboard into the current folder. Behaves like the Windows Paste, except if
the target folder is a Catalog or Print Order. In this case CodedColor will create links to the original
files (images).
B.2 Paste Original Files
Pastes the files from the clipboard into the current folder, always using the original files, even if the
clipboard contains linkfiles. This is useful, if you did not call Copy Original Files, or copied the files
to the clipboard from other applications like the Windows Explorer, and you now want to paste the
original files into your CodedColor folder.
B.3 Paste Links to Files
Does not paste the original files from the clipboard, but creates links to all files (images) of the
clipboard in the current folder. This is also the default action for Paste Files into Catalogs and Print
Order folders.
B.4 Paste into New Image
Opens an Image Editor window within CodedColor with the bitmap from the clipboard.
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B.5 Insert Before
If you have enabled Custom Sorting in the current folder, the previously Copied Files are moved
before the selected file.

Keyboard Shortcuts
Lines marked red show shortcuts, that behave differently depending on the Explorer viewmode.
Default keys

CodedColor keys

1. Detail & Icon view

2. Image & Thumbs
view

SHIFT+DEL

Delete files permanently (no bin)

Cut files
=

CTRL+C

CTRL+INS

CTRL+V

SHIFT+INS

Cut files
(also for custom sorting)
Copy files
(also for custom sorting)
Insert files
Copy images to clipboard (then
STRG+SHIFT+N)
Delete files to bin

=

CTRL+X

INS
DEL
CTRL+Y

CTRL+SHIFT+C

Insert files before selected file
(custom sorting)
Paste images from clipboard to new
Editor
Copy files to folder

CTRL+SHIFT+M

Move files to folder

CTRL+SHIFT+N

=
=

CodedColor Delete
Dialog
=
=
=
=

Important for Custom Sorting
· Some dragging or cut & copy operations create links to the original files. Remember, that if the
original files are customly sorted, they have prefixes of the form (00003). Changing the sort order
later will create broken links, since the links now point to original images with a possibly changed
sorting prefix. As a rule of thumb, is therefore not a good idea to create linkfiles to original images
having a sorting prefix.
· If you drag from a directory, which is customly sorted, to a directory which has no custom sorting,
the sorting prefixes of the form (00003) are removed. Likewise, sorting prefixes are
automatically added when inserting into a sorted directory.
· Renaming in CodedColor usually preserves sound attachments. This is not the case for renaming
or file operations in the detailsview / iconview of the Explorer.

Related topics
·
·
·
·

Catalogs
Order quality prints
Drag & Drop
Custom sorting
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ZIP Files & Folders
Three menu items below Tools > Compress allow you to handle ZIP archives beyond the convenient
ZIP integration of the Windows XP Explorer. In principle they correspond to the Windows Explorer
shortcuts of the well known WinZIP software.
1. ZIP Files
Select a number of files or images in the current folder, and automatically compress them to an archive
with the same name as the current folder. The archive is stored in the current folder. If you then move
to another folder or subfolder, you can easily add images to the previously created ZIP archive.
2. ZIP Folder
Select a folder in the Explorer tree, or a directory item in Details View. An archive with the same name
as the selected folder is automatically created in the parent folder, containing all files from all
subdirectories of the selected folder. An extraction of this archive automatically restores all files and
recreates the corresponding subfolders.
Example: you have selected a folder with the path D:\Images\2003\Paris. An Archive with the
name D:\Images\2003\Paris.ZIP is created.
3. Extract ZIP Archive
An archive created with the Zip Folder utility is automatically restored with the exact directory structure
below the current location.
Example: you have selected an archive with the name E:\Holidays\Paris.ZIP. A directory with
the name E:\Holidays\Paris is created, and all files from the original directories are restored in
their corresponding subdirectories, i.e. to E:\Holidays\Paris\Day1, etc.

Related topics
· Mail Files
· Sharing Photos
· How can I reduce the size of images?

5.2.4

Filesystem sorting
You can rearrange the order in which the items are displayed in any of the Explorer Views by using the
Sort By button or selecting File > Sort By. A click on the column header in the detailsview has the
same effect. Clicking twice will toggle between ascending (a..z) and descending (z..a) order.
Available sort orders:
· Name column (alphabetically). If you performed Custom Sorting in the current directory, then this
is the sort order that will reflect your sorting.
· Size column
· Type column (alphabetically)
· Modified column
Set Display Standard Filedate, to show modification time of file or directory (Windows
standard)
Set Display Modification Date, to show modification time of original files. Choose this
sortorder, if you are viewing images inside catalogs. The setting corresponds to the one above, if
your current directory contains only original images.
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Set Display Creation Date, to show timestamp of photo from EXIF record, if available,
otherwise file creation time of original file. This sort order is a good starting point to
Initialize Custom Sorting
· Description column (alphabetically). This column is usually taken from the CodedColor database,
so you will not find it in the Windows Explorer.

Related topics
· Custom Sorting
· What's the difference between file date and photo date?

5.2.5

Custom sorting
Usually your images are already sorted by filename in the creation sequence of your camera, but you
may want to override this for certain images. Also, if you move or copy an image to a folder which
already contains sorted images, then most likely the image will not be in the desired place.
The sequence of files is an important aspect of the organization of images, not only for
web album export or screenshows. To move single images inside a directory, you could manually
rename the files as explained later. A much more efficient solution is to use the custom sorting feature
of CodedColor:
1.

Browse to the folder or catalog where you want to perform custom sorting. If you have already
done custom sorting in this directory, you can skip steps 2-3.

2.

In the Detailsview, define an initial sort order by clicking on the appropriate column header.
Usually you would choose [Creation] ascending for this, as it reflects the time sequence in
which the photos were taken.

3.

Now call Initialize Custom Sorting to add numbered prefixes of the sort (00019).. to the
filenames.

4.

In step 3 the sort order is automatically changed to [Name] ascending. If you performed steps
2-3 at an earlier time, then change the sort order to [Name] Ascending (a..z) manually.

5.

Select the file items or thumbs that you want to reposition.

6.

Press CTRL+C (Copy Files) or CTRL+X (Cut Files). Both have the same effect.

7.

Select the file, before which you want to insert the previously copied files.

8.

Press CTRL-Y (Insert Above).

Hint: An alternative to the steps 6-8 is to use Drag & Drop. Click on the files to be repositioned, hold
the left mouse button pressed, and only let go of it over the image in front of of which you want to
position the selected files. If your image is appended to the end, your mouse pointer was not exactly
over the thumb.
All files in the directory are now renamed accordingly. Whenever
you switch the sort order to [Name] ascending, your custom sort
order will be displayed, even if you are viewing the files in other
programs like the the Windows Explorer.
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Obviously you need to have write access to the directory, so this feature does not work for CD drives.
To resort files on CDs, you have to create a catalog of the images, and then apply custom sorting to
this catalog. As you can already guess, the custom sorting works the same in Catalog folders
containing not the originals, but linkfiles pointing to the originals.
To remove custom sorting from a directory, select the menuitem Remove Custom Sorting. All
filenames of the form (00123)image.jpg will be restored to image.jpg, so you will loose your
current custom sort order. Whenever you repeat the above steps for the first time, all files in the
directory will receive the prefix "(xxxxx).." again.
Besides this automatic batch renaming of images in a directory, you have the following alternatives to
manually change the sort order of your images:
Manually renaming original images
· If you rename a file from sunset.jpg to x_sunset.jpg, it will move to the bottom of your
directory.
· If you rename a file from sunset.jpg to _sunset.jpg, it will move to the top of your directory.
· You can add numbers or characters to the beginning of the filename to move it alphabetically into a
desired position. This action is done automatically by the custom sorting feature explained above.
Manually renaming catalog linkfiles
If you add the selected images to a catalog, you can manually rename the linkfiles in the catalog to fit
your desired sort order. The original filenames will not be changed. So along with the advantage of
putting the same image into several catalogs, you can also have different sort orders in separate
catalogs. The easiest way of resorting the linkfiles inside a catalog is to add the prefix "10..", "20..",
"30..", etc. to the beginning of the filenames. If you now want to position the file 30_sunset.jpg
above the file 20_beach.jpg, you could for instance rename it to 15_sunset.jpg. But again, it is
much easier to use our custom sorting feature explained above.

Important
· A big benefit of the CodedColor physical sorting technique over sorting methods that involve a
database is the fact, that the sorting is not lost in other applications. The sort order is preserved in
the Windows Explorer, when archiving the files to a CD or when creating a web album. The
drawback is, that this physical sorting is only possible in directories that have write access - i.e.
you cannot sort images on a CD after it has been burned.
· For another drawback in relation to linkfiles, see Important Information in the Drag & Drop or
Cut, Copy & Paste topic.
· Custom sorting is not supported when dragging images onto the explorer tree or in detailsview /
iconview of the Explorer.
· Renaming in CodedColor usually preserves sound attachments. This is not the case for renaming
or file operations in the detailsview / iconview of the Explorer.

Related topics
· Filesystem sorting
· What's the difference between file date and photo date?

5.2.6

Batch Rename
Batch Rename is a very powerful tool to transfer photos from A to B or to include additional information
in often cryptic filenames coming from typical digital cameras. You can:
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· Rename files in the same directory
· Rename and move files to another directory, most likely from a camera or removable drive to your
local drive
· Rename while creating copies in another directory
· Create links in a Catalog (this can also be done directly in the Explorer)
Example:
Original filenames:

10140008.jpg
10140009.jpg

New filenames:

Jamaica 2004_11_01(056432).jpg
Jamaica 2004_11_02(056433).jpg

The new filenames were accomplished through the following steps in the Rename Mask:
·
·
·
·
·
·

Dropdown #1:
Separator #1:
Dropdown #2:
Separator #2:
Dropdown #3:
Separator #3:

Custom Text: Jamaica
Space Character
Modification Date format: yyyy_mm_dd
Open bracket
Database Record-ID
Close bracket

The following renaming options can be selected in the 3 Renaming Mask dropdowns:
1.
2.
3.
4.
5.

Original Name: use this to preserve the original filename
Name extract: copy a part of the original filename by defining the start and end positions
Replace Part: replace a string in the original filename with another string
Custom text: add a prefix or suffix to your original names
Incremental #: destination filenames are numbered starting with 0; leading digits are filled with
0
6. Creation Date: taken from the file. For format options see Date Format String
7. Modification Date: taken from the file. For format options see Date Format String
8. Title or Filename: uses the title from the Annotation Editor, or if empty, uses the original
filename
9. Image Resolution: width of the image in pixels
10. Database Record-ID: unique number taken from the CodedColor XML database
11. EXIF field: select the EXIF field from the dropdown
12. IPTC field: select the IPTC field from the dropdown

Important
· Renaming looses the original filenames. If you don't want this, then set one of the three
Renaming Mask dropdowns to Original name.
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· Sometimes you may get name collisions, if two different source names result to the same
destination name. You can prevent this by adding an Incremental number in one of the renaming
mask dropdowns, preferably the third one.
· Never change the filetype in the renaming mask. Do this only, if all your source images are of the
same fileype, and you want to change something like JPG to JPEG or TIFF to TIF. If you actually
want to change the filetype of the images, use the Batch Conversion utility instead.
· Renaming in CodedColor usually preserves sound attachments. This is not the case for renaming
or file operations in the detailsview / iconview of the Explorer.

Related topics
·
·
·
·

5.3

Batch Conversion
Custom sorting
EXIF/IPTC fields
What's the difference between file date and photo date?

Catalogs
Catalogs in CodedColor are collections of images. Physically they are folders in the Organizer,
containing links to image files, which can be located anywhere on your system. You can add, rename
and delete Catalogs. Since they are folders containing links to images, they can be filled and viewed
like any other directory.
Properties:
· The images are only copied physically to Catalogs, if they lie on removable media, like CDs.
Otherwise they are linked to.
· When you browse in a catalog, you can work with these linkfiles, as if they were the originals. Thus it
is possible to export a Catalog to a Web Album, because it is only a directory with (linked) photos.
· Catalogs can be used for screenshows, print orders or just collections of favorite photos. If you
rename a Catalog linkfile, you are not renaming the original image. Thus it is possible to change the
order of photos in a Catalog.
· Editing (for instance rotating) a Catalog photo changes the original image.
· Catalogs contain shortcuts to images. Albums are shortcuts to directories.
The beauty of CodedColor is that it does not differentiate between linkfiles and originals. Thus it is
possible to have a photo in many Catalog collections and save disk space, because there is only one
original image file. Other programs try this as well, but usually have "broken link" problems when the
original is renamed or moved. CodedColor has a unique algorithm to track all file changes on-the-fly
and correct broken links and database records, even if CodedColor is not running. You will not loose
your annotations, if you rename directories or move photos in the Windows Explorer.
Tutorial: Create a new catalog
Take a few minutes to learn the basics about Catalogs by following the steps below:
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· Open an Explorer window and browse to a
folder containing images
· Select Organize > New Catalog and
change the name of the new folder item
· Press OK
The Catalog Panel is opened at the bottom
of the screen. This panel will display the
images contained in the catalog.
Images in catalogs are only links to the
originals somewhere on your harddrive. You
can add the same image to different catalogs
without wasting diskspace.

To add images to the catalog, just drag
thumbs from the Explorer to the Catalog
Panel. You can add many images at once,
by doing a multiple selection in the Explorer.
1.
2.
3.
4.

Current catalog "Screensaver1"
Explorer thumbsview: selected image
Drag & Drop operation
Linkfile in catalog, displayed in Catalog
Panel

You can switch directories in the
Explorer and add images from different
locations on your harddrive. You can even
drag images onto the Catalog Panel from
different Explorer windows.
If you want to browse a catalog like a normal
directory, choose the menu item Organize >
Browse Catalog. The current catalog is
opened in the Organizer (where the catalog
linkfiles are stored), and you can browse,
annotate and edit the (original) images just
like in any normal directory.
If you edit and annotate images in the
catalog, you are actually editing the originals.

Related topics
· What's the difference between albums and catalogs?
· Custom sorting
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Albums
Albums are only links to directories (folders) on your disk, stored as shortcuts in the Organizer under
"Local Albums". A linked directory usually contains original photos and subfolders with photos.
Properties:
· Albums can be exported to HTML, including subfolders.
· Albums can be described in the Organizer.
· All photos found in an album are immediately added to the database, and can be searched (option
Immediately add files to database when opening a directory). The photos in other directories
are added on-the-fly, as they are viewed. Read the View Options topic for an alternative.
· Albums are shortcuts to directories. Catalogs contain shortcuts to images.
Tutorial: Create new album
Take a few minutes to learn the basics about Albums by following the steps below:
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1. Open an Explorer window and browse to a
folder containing images
2. Select the menuitem Organize > New
album
3. Enter an album description in the dialog
and press OK
4. A new album shortcut (linkfile) is added to
the Organizer\Local Albums folder,
and all images inside the current folder
(and subfolders, if checked) are added to
the database.
Are my images stored in the database?

Once you have created the album shortcut,
the corresponding folder turns green. You can
have albums within albums.
In the example to the left we have an album
"2002" containing all images of 2002 and
below that another album containing only the
"Marokko" vacation.

In the Explorer window showing the
"Marokko" vacation images, you can now
exclude images from the album. If you are in
Detailsview or Iconview, you can edit the
checkboxes - in Imageview and Thumbsview
you can choose Exclude Image with the
Right Mouse contextmenu.
If an image is excluded, it is "fenced" out, and
won't appear in exported web albums.
Before you actually export your album to the
web, you might edit the album description.
This description is shown in the HTML
startpage of the exported album.
To edit the description, choose the menuitem
Organize > Edit Album and select the
Album Info tab. At the bottom you can add
own user fields, like "Camera" and "Location".
You can also edit the album description inside
the Organizer, by pressing F2 on the album
linkfile.

Related topics
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· What's the difference between albums and catalogs?
· Custom sorting
· View Options for immediate generation of thumbs

5.5

Search Database
Take a few minutes to learn the basics about the CodedColor Database Search by following the steps
below:
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1. Open an Explorer window and press F3
2. Select the database fields you want to
include in the search. The search value
combination will be applied to every field in
an OR manner.
3. Enter the search values. Several values can
be separated by spaces. In the example
here we are searching for all images from
"Carbarete" in "2002" OR "2003". This
information is found in the filepaths, so
make sure you included this field in the
fieldlist (2).
4. Check Only existing files in searchresult,
if you want to exclude files that are currently
not available (CDs)
5. Check Search in catalog paths, if you want
to include the filenames of catalog linkfiles.
6. Press Search.
The found records have been prefiltered. You
have not yet created the physical searchresult.
Press Yes, if you want to create the linkfiles of
all found images in the searchresult directory of
the Organizer.

Since you checked Only existing files in
searchresult, the final search result is actually
smaller than the number of prefiltered records.
Those records of the searchresult have been
omitted, where the original image is currently
unavailable, maybe because it's on a removable
media like a CD.
The Organizer window is opened, and the
created linkfiles are displayed in Detailsview. In
the type column you can see the actual location
(path) of the image.
You can switch to the Imageview and browse the
found images in the samer manner as you would
in a normal directory.

Example with keywords
You have 3 images with the following keywords:
1.

Sail, Surf, Water
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Sail, Surf
Sail, Storm, Water
Search option

Seach value

Result

at least one of the words

sail surf

1, 2, 3

all of the words

sail water

1, 3

contains phrase

sail surf

finds nothing, because multiple
keywords must be separated by
komma (no empty spaces) for this
search option

contains phrase

sail,surf

1, 2

equals phrase

sail,surf

2

equals phrase

sail,water,storm

finds nothing, because keywords are
listed in alphabetical order in this
example

Note: The search is not case sensitive.

More Information
· You can also view the search result in the screenshow (fullscreen view), edit annotations, open the
image in the image editor, rotate, etc. You are not editing a copy of the image or the linkfile
pointing to it, but the original image.
· You can refresh the search result anytime by pressing F5 in the search result folder. The search is
repeated with the original search parameters, and any new images in the database matching the
query will be inserted into the result folder. Alternatively press Open & Refresh in the search
dialog, and select the search result you would like to refresh.
· To delete old or empty search result folders, press Cleanup in the search dialog. Remember, that
search results are actually only catalogs containing links to your original images.
· To search for EXIF and IPTC information read the topic about EXIF/IPTC fields.
· You can use the Keyword View to search for keywords in a more comfortable way. It can also be
used to assign Keywords to many images at once.
· To perform easy searching with a chronological priority, use the Timeline Calendar View.

Related Topics
·
·
·
·
·
·
·
·
·
·

Search Similar Images
Can I narrow the database search to a specific folder?
Title and Annotations
Are my images stored in the database?
Can I view the contents of the database?
Database definition
Backup Database
Database Maintenance
Why are not all keywords displayed in the dearch dialog?
Timeline Calendar View
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Archive Pictures on CD/DVD
Burn exported albums
An Album CD is a compact disk or DVD with all necessary files to display your albums and pictures on
another person's PC. You can view Album CD's on any system with a webbrowser installed. For best
compatibility and permanent protection of your pictures, your Album CD's do not need any software
other than a browser to view the CD, with any Operating System capable of reading your CD format.
Follow these steps to create your CD/DVD archive:
· If you haven't done so already, define the albums you want to preserve, and describe the images
inside the folders.
· Open the Export Album dialog consecutively for each album
· Uncheck the option Resample, and define your layout. Also make sure you use the Web safe
image and thumb format.
· Define a CD root folder, and create a subfolder for each album. Enter this subfolder in the Output
To field.
· Start Export for each album. Check the total size of your albums. If it grows larger than your CD
storage capacity, remove one of the albums.
· Create and edit a start page in HTML, containing links to your albums in the folders below. Call
this file home.html or index.html, and copy it into your CD root.
· Burn the CD using your preferred CD/DVD-Burner software or the Windows assistent.
You can also use the CodedColor CD/DVD Burning Wizard directly from the export dialog, in order
to burn the current album only. Select Add autorun files for CD/DVD, if you want to automatically
launch the exported album in a webbrowser when inserting the CD/DVD.
Archive images, albums & catalogs with the CD/DVD Burning Wizard
The CD/DVD Burning Wizard can be launched from different menu locations in the Explorer. If you are
inside the thumbs or list view, you current file selection will be added to the burn project. If your focus is
inside the folder tree, the whole selected folder or album incl. subfolders will be added. Leave the
wizard's File Selection tab open, if you want to add further images, files or folders from the explorer.
Drag & drop is currently not supported, so just use the same Burn on CD/DVD menu item again.
Hint: Linked images from catalogs will be automatically added as original images to the burn project.
Image annotations will be included in the image files, if the filetype supports EXIF/IPTC, which is the
case with with JPG.

Related topics
· Web Album
· Title and Annotations
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6.1

Print a single picture
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You can print a single picture in photo quality from several locations, including

1.
2.
3.

Screenshow
Explorer
Editor

Choose Pop Up Menu > Print Image
Choose Print > Print Images > Single Image
Choose Print > Print Image

Define your print options and printer settings and then hit the OK button to start the print.
Gamma Correction
If your printer does not produce the color results you expected as compared to the picture on your
screen, you can adjust the Gamma value. This correction will be applied before sending the picture to
your printer. Your original image will not be changed! A value of 1.0 indicates that no correction will be
applied.
Gamma correction is used to control the overall color luminance (brightness) of an image. Images,
which are printed directly from software to photo paper might look either bleached or too dark. Gamma
correction can fix this discrepancy.

Hints
· You can make full use of larger photo paper by selecting an appropriate orientation and position
and feeding the paper for your next picture into the printer again.
· If you want quality prints from multiple pictures, we recommend ordering them in a photo lab
online. You probably won't be able to beat the price, quality and convenience by using your home
photo printer.
· You can place several images onto a single sheet of paper by using the Collage feature, or the
DTP tools of the CodedColor Publisher. This however creates a new image with layers, which
can then be stored as a single JPEG.

Related topics
·
·
·
·

6.2

Print a contactsheet
Order quality prints
Create Collage
Export Multipage Documents (PDF, TIF)

Print a contact sheet
You can print a Contact Sheet from the Explorer window by following these steps:
· Select the images you would like to print. Use the CTRL or SHIFT buttons to select several
images at once.
· Choose Share Images > Contact Sheet
· Define the Page Options, Image Options and Page Layout. Look below for more details.
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To the left you see a printed contactsheet,
including header and footer lines.

Page options
· Choose your print options and/or printer settings.
· If you want to include a Header, Title and/or Footer, activate the checkbox and enter the text you
would like to display on each page.
· Select page borders. If the footer is not shown on the page, you should set the bottom border to
about 25 mm.
Image options
· Select the Image Information to be included in your contactsheet.
· Wrap long words: Enter the number of characters after which you want to force a word wrap. All
printing and export is done in HTML. Very long words can cause an image cell to become wider
than the contained image, resulting in less columns displayed on the page. If you have words that
are longer than your image width you might want to adjust this option to force the desired cell
width.
· If you are exporting screenshots or detailed images, you should Use Original Images to gain
maximum quality on a high resolution printer. Use this option carefully, as you might run low on
graphic resources.
Page layout
· Select the paper orientation and number of columns. If not all columns are shown, then enable
Wordwrap in the image options, to force the desired cell width. You can also try a smaller vertical
border in the page options, or a smaller fontsize.
· For a quick preview, select Refresh Preview
· Once you are satisfied with the layout, select Print to send the contactsheet to your printer, or
Print Preview, to first have a full preview of the created pages.
Note: you cannot make further layout modifications in the preview form.

Hints
· Call HTML Indexpage instead, if you want to create a contactsheet for online viewing. Basically,
the only differences to the printed contactsheets are:
1. The HTML contactsheet has no headers or footers
2. The HTML contactsheet can contain links to the original images
· Printed contactsheets are stored in HTML, but removed after printing, whereas the HTML
indexpages remain at the designated location.
· You can also place several images onto a single sheet of paper by using the Collage feature, or
the DTP tools of the CodedColor Publisher. This however creates a new image with layers,
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which can then be stored as a single JPEG.

Related topics
·
·
·
·

6.3

Print a single picture
Order quality prints
HTML Indexpage
Create Collage

Order quality prints
CodedColor allows you to order quality prints of your pictures online in a lab of your choice. In
comparison to printing on your home photo printer, the cost for online prints is usually less than half.
The process consists of the following steps:
1.
2.
3.
4.

Collect the desired images in order catalogs
Review the images
Specify size and quantity of you prints
Transfer the images to the Online Lab through the use of an Order Client.

CodedColor currently offers the following third party order clients:
Fotowire Client
Fotowire is one of the largest photo mailer
services worldwide. The client lets you
choose among participating labs in many
countries.
The client is available in German and
English.

Silverlab Client (Foto Quelle)
Use this client to order pictures from within
Germany. You can also select local pickup
locations for your prints.
The client is only available in German.

The Order Wizard guides you through the process of ordering prints in 4 easy steps. Activate the
Wizard by selecting Print > Print Order Wizard, and follow the instructions. As an alternative you can
use the shortcut steps described below to prepare and place your order:
Order Selected Images Immediately
If you want to skip the process of collecting and reviewing images, you can select images with the
mouse (in combination with the CTRL or SHIFT buttons) to place an order directly. Please note, that
with this shortcut you will not be able to collect pictures from different folders.
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Print Order
Unless you call Order Selected Images Immediately, all pictures you want to have prints from are
collected in a Print Order Catalog. You can work with these collections as with any other catalog.
Add to Print Order
Adds the images to the current print order catalog (collection). You can always review or remove
pictures from the collection later.
New Print Order
Allows you to create a new catalog for collecting pictures.
Order: 030424
Displays the current print order, in this case a folder (catalog) with the name 030424 containing links
to the images. Select this menuitem to change the current print order catalog. You can also reopen
previous orders and add more images.
Select Client
CodedColor uses third party Order Clients of participating Labs, to do the actual transfer and
processing of the images. Here you can select the installed order client or download a new client by
selecting Look for Updates.
Process Print Order
Transfers the pictures from the print order catalog to the selected client. Specify size and quantity of
your prints in the client program.
Show Print Order Panel
Display or hide the panel showing the pictures of your current print order. This panel is similar to the
catalog panel, because print orders are actually catalogs containing links to images.
Browse Print Order
Opens the current print order in the Organizer window. This allows you to review and edit (rotate)
your photos before placing an order.

Related topics
· Catalogs
· Print a single picture
· Print a contactsheet

7

Editing Pictures

7.1

Introduction
If you are new to digital image correction, there are a couple of simple, but ingenious automatic tools in
CodedColor you should try first. These tools (conservatively) improve your images with a few clicks
only. SmartFix and SmartFlash can also be found in Batch processing, so that you can improve a
whole folder of images at once.
The most important One-Click improvement tools are:
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· Gamma Correction: adjustment of brightness and color balance
· White Balance: exposure correction and removal of color stains
· Auto Colors: histogram stetch to improve color balance and saturation
· SmartFlash: exposure correction in underexposed areas (shadow highlighting)
· SmartFix: all of the above, but with optional sensitivity values (see Program Settings)

Important
· To get an impression of the possibilities, read our Before/After Tutorials first.
· CodedColor has a very conservative way of improving your photos, thus preserving contrast and
reducing resulting artefacts. Many image editors use more primitive algorithms, which might
destroy valuable details in your photos or create unwanted artefacts (noise).
· If you don't see an effect after using one of the above tools, then CodedColor has determined, that
the photo is either already very good, or any further change would destroy valuable details or lead
to unrealistic effects.
· Remember, that the color settings of your computer screen might lead to a false assumption, that
the photo needs to be corrected.

7.2

Basic Operations
The Image Editor is a versatile editor tool to enhance, rotate, crop and scale your images. Use the
Screenshow mode (fullscreen) instead for best viewing experience, if you only need to rotate your
images.
You can open the Image Editor by selecting one or more images in the Explorer or Organizer, and
then pressing Shift+F6, or by calling the Edit > Open Images in Editor menu entry.
Area Selection
All image manipulations, such as brightness, color, contrast, red eye, and copy work on your current
selection, or the whole image, if there is no selection active. You can select an area of the image by
using any of the following modes:
Rectangle select a rectangular area
Circle
select an oval area
Lasso
perform a freehand selection
Wand
select adjacent pixel within a color range. You can change the magic wand sensitivity
if the selected are is either too large or too small.
· Pressing Shift while doing a selection will add the area to your existing selection. Otherwise the
existing selection is replaced by the new selection.
· You can move the selection area by clicking inside the selected area and dragging it with the
mouse.
· You can clear the current selection by using a right mouse click and selecting Clear Selection.
· If you resize a rectangular selection with the ALT key pressed, the aspect ratio of the
selection/image is preserved.
Magic Wand Sensitivity
Specifies the color range, when selecting areas using the magic wand tool. A higher value will result in
a larger area of the image selected.
Feather radius
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Specifies the area in pixel around the selection where to apply the algorithms with reduced amout. This
gives a smoother appearance.
Selection Intensity
Specifies the intensity, with which any image operation is performed inside the selection. In most
brushes, this corresponds somewhat to Opacity.
Magic Wand Mode
· Global: The selection includes all areas in the entire image which match the clicked color
· Inclusive: The selection includes all connected pixels of the clicked color, and areas enclosed by
these pixels
· Exclusive: The selection includes all connected pixels of the clicked color
Red-Eye Correction
CodedColor has an advanced red-eye correction mechanism. For best performance, you should zoom
into the face containing the red-eye, start the Red-Eye Tool and do the correction.
Resizing (Scaling)
The resize dialog allows you to scale the picture. We recommend the Lanczos3 Filter for best results
with photos. Using an antialias filter is also called Resampling.
Note: The values for the new size will be preset to the current zoom factor of the image when the
dialog is opened. When changing the size in the dialog (Aspect ratio must be enabled), the image in
the background is automatically sized accordingly, so you can see the final size of the image.
Crop
If the image is completely fit into the viewing area, the crop frame is prepositioned with a 10% border
inside the image (crop by view). If the image is zoomed, the crop frame is prepositioned to the exact
size of the viewing area (crop by zoom).
You can also manually select the cropping area by using any one of the selection tools.
Do an Edit > Crop to reduce the image to the current selection. If there is no selection active, a default
rectangle will be preselected, which you can then use to capture your area of choice.
Extend Workspace
The editor panel, which contains the image, normally has the same size as the image itsself. If you
want to extend this workspace, for instance to paste other images beside the current one, then you
need to enlarge the working area with Edit > Extend Workspace.
If you set the Horizontal and Vertical amount avalues to 10-30 pixels, then you can create a simple
frame around the image. This can also be done in a nicer way through the dialog Borders & Shadows.
Another cool way of adding frames is using the Image Frames dialog.

More Editing Tools
·
·
·
·

Rotate Images
Watermarks
Brightness, Contrast and Color
Basic Effects

Hint
· You can switch between Screenshow and Edit Mode by Pressing F6.
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· The Convert File menu from the Explorer allows you to convert or resize multiple images or add a
watermark-text.
· From the Image Editor, you can check and correct you image and navigate to the next picture in
the list by selecting PgDn or PgUp.
· Before you start manipulating the picture, you should Zoom into the area you want to manipulate.

Related topics
·
·
·
·
·
·
·
·

7.3

Image Editor options
Image enhancement tutorial
Screenshow
TWAIN capture
Batch Conversion
Title and Annotations
External Editors
How can I reduce the size of images?

Rotate Images
CodedColor provides lossless rotation for JPEG images.
You can rotate and/or flip images from the
· Explorer or Organizer windows
· Image Editor
· Screenshow mode (Using the popup menu or the shortcut keys)
To rotate a picture use CTRL+R (rotate right) or CTRL+L (rotate left) shortcuts or the corresponding
entry in the Edit menu.
Use the Rotate Images dialog, if you need to rotate your images by other than 90° or want to flip
them.
Note: You can only rotate pictures in the explorer mode, that have an editable format. Kodak PCD
images for instance cannot be rotated. If you want to rotate these pictures, you should open them in
the image editor and save them in an alternative format such as JPEG.
Automatic horizon alignment
Usually, images need to be rotated by 90° in either way, depending on the alignment of the camera
when taking the picture. (Some cameras write this information into the EXIF Orientation field, but this is
not reliable, thus obstructing any software automatism).
In most other cases, the picture needs to be straightened only slightly along a horizontal line, like the
horizon. CodedColor offers a very intuitive tool for this: in the Rotate dialog, just click onto the image
preview and draw a line along the horizon. You can move this line by clicking and dragging the red
edges. Then enable the Crop option and presse OK. The image will be justified along the line, and a
best fit crop frame is positionend in the image. You can change the frame size and position, and then
press the Crop button in order to finally cut the image.
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Step1: draw horizon line

Step2: suggested crop frame

Important
As long as an edited image is not stored as JPG in the Editor (it's then considered a BMP), a
Left/Right Rotation will not be lossless and can lead to unwanted artefacts. Always save an edited
images as JPG file, before you do a Left/Right rotation.

Related topics
· Image Editor
· Glossary: Lossless rotation
· Supported File Types

7.4

Create Collage
The Collage feature allows you to place more than one image into a large workspace. This becomes
necessary, if you want to print several images at once onto a single sheet of paper. For more
sophisticated DTP work however, you should use the CodedColor Publisher instead.
Each Layer of the collage contains exactly one image - also called layer image. Layers can be
reordered, i.e. any image of the collage can be moved in front of another one. Layers can be added or
deleted, and a layer image can be replaced by another image. Shadows and watermarks can be added
to the images. Floating text elements however can only be added in the CodedColor Publisher.
How to create a new collage:
1.
2.
3.
4.
5.
6.
7.
8.

Select a number of images in the CodedColor Explorer.
Click on Create Collage in the right mouse context menu.
In the dialog, select Height, Width and the number of Rows and Columns.
Select an Antialias Filter to smoothen the images when they are downsized in the collage.
After pressing OK, CodedColor creates a collage with the selected images. Each image has it's
own layer, which you can move or resize using the mouse.
Select individual image layers and use the right mouse menu to define effects like Shadow or
Watermark.
Click on Merge Layers, in order to normalize the collage into a single image.
Save the collage as an image (for instance JPEG), in order to print or mail it.
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Collage after realigning the images

Options:
You can move selected Images using the mouse. You can change the size of an image by dragging
the right or lower border of the image. Images can be moved in front or behind other images with the
context menu of the right mouse button.
Click on the Open symbol of an image, in order to load an image into a new layer or to replace an
existing image.
Use the context menu of the right mouse button for additional options. You can Delete or Rotate
images, and add Watermarks or Shadows. You can also copy an image into the Clipboard.

More Information
· The Aspect Ratio is automatically preserved when manually resizing an image in the collage.
· Images of a collage are always downsized automatically, in oder to save resources. The Antialias
Filter of the collage dialog is used to smoothen the edges when resampling the image. Whenever
you manually change the size of an image in the collage, the original image is temporarily loaded
and resampled. All previous changes to the layer image, like shadow, watermark or SmartFix, are
lost and must be repeated. You should therefor always add all images and resize them first, before
you add any effects.
· Press Ctrl+V to paste an image from the Clipboard into a new layer. If you already selected an
existing layer, the contained image is replaced. Images with only a single layer, i.e. after opening
an image in the editor, are switched to the layer mode after inserting another image from the
clipboard (layer 1 = base image, layer 2 = pasted image).
· By Doubleclick on a layer image, you can replace the image with another one from your drive.
· When you finally merge all layers, you can no longer select or change the layer images. Only
through an Undo command, you can return to the layer mode. Once the collage is merged, you
have a normal image which you could edit more and then save as a JPEG.
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Red-Eye Correction
CodedColor provides an
advanced red-eye correction
mechanism. The example
shows a face with the left eye
already corrected.
The tool is simple to use, yet
produces some of the best
results compared to others
solutions on the market.

For best results, follow these steps carefully:
1.

Zoom into the face, enlarging the eyes which are to be corrected. You can use the Left & Right
mousebuttons for this, and drag the face to the area containing the red eyes.

2.

Start the Red Eye dialog by selecting Edit > Red Eye, or by clicking on the Red-Eye shortcut
button. If you need to do more zooming, use the Zoom Control buttons in the toolwindow.

3.

Select the original eye color. You can use the
tool and click on the pixels directly adjacent to
the red area. You can also use a previoulsly stored Custom Color, or select a color from the
Palette. The eye in the Preview window displays the color used for the replacement.

4.

Select the
eye.

5.

Click on the center of the red eye, and keep the mouse pressed to draw over the red area,
applying the replacement color.

6.

If you accidentally replaced correct parts of the eye or face, you can use the
restore the original pixels, including color and texture.

7.

Save your changes, once you are satisfied with the replacement.

tool and adjust the Brush Size to a circle equal or smaller to the red area in the

eraser tool to

Example: The replacement brush barely covers the red area of the
eye. When you apply too much replacenement color, you can undo
groups of pixels by switching to the eraser mode.
With a little practice, red eye removal is a matter of seconds.

Toolwindow buttons
Paint Tool
Color Picker
Eraser Tool

Replace the red area with the new eye color.
Select the new eye color by clicking onto a color in the picture (Pipette)
Restore the original color (undo color replacement for fine tuning)

Zoom into

Increase size of displayed image by one step

Zoom out

Decrease size of displayed image by one step

Related topics
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· Image Editor
· General Brush Settings

7.6

Batch Conversion
Use the batch conversion tool, if you want to apply the same manipulation to multiple pictures. This
operation is introduced in the Explorer by a Job-Wizard, which allows several types of Image
Selection.
Supported conversions in the batch dialog:
·
·
·
·
·
·
·
·
·
·
·
·
·
·
·
·
·

Resizing
Clipping: cut off edges, i.e. from scanned images
Adding text watermarks
Adding clipart watermarks
Adding borders
Adding shadows
SmartFlash image correction
SmartFix image correction
White Balance (careful: does not work for all images)
Color Balance (careful: does not work for all images)
Auto Exposure
Auto Color
Brightness, Gamma, Contrast, Saturation
Noise Reduction
Despeckle
Editing EXIF/IPTC data, in/decrementing date values
Convert file types (output format) and compress (see More options button)

Other batch conversions in the Explorer:
·
·
·
·
·
·

Encrypt images (see Mail Images)
Rotate images
Add GPS coordinates to images
Batch rename image files
Restore file creation dates (see Image Editor Options)
Burn on CD/DVD

Steps
To apply batch conversion to your images or image folders, follow these steps:
· Activate the tool from the Explorer window.
· Select multiple images using the Ctrl and Shift buttons.
· Choose Tools > Batch Conversion
· Uncheck Resample, if you just want to add watermarks or change the output format (filetype).
· The button More options allows you to change many properties related to the selected filetype.
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The dialog to the left shows the conversion options for
the GIF filetype. You can change the color space,
transparency, interlace factor and background color.

· Define the output (destination) folder, or select Store in source folder, if you want to store the
converted files along with the originals.
In this case, make sure you define a Prefix, so your original files are not overwritten!
· Before applying the SmartFix, White Balance or Color Balance algorithms to your selected
images, first preview some of the results in the Improve tab. Use the Display Original checkbox
to see the exact result. (Without this checkbox, the preview uses the smaller thumbs for speed.)
You can then zoom into and compare the Before/After images.
Note, that SmartFix is a lengthy procedure, and that you may want to press ESCAPE during the
processing, if you find that you selected too many files at once.
How to correct EXIF / IPTC date values
Date parameters can be:
1. Date values of the form "12.11.2006 21:23:24"
2. Filedate tokes: "FileCreationTime", "FileModificationTime", "FileMinimumTime"
If you enter these tokens, the file dates are transferred to the corresponding EXIF/IPTC fields. This
may become useful, if image files lost their EXIF data after image editing in programs outside of
CodedColor.
FileMinimumTime is the smallest of the two others. Since the CreationTime designates the
time, at which the file was copied to the hard disk, the ModificationTime can be closer (or equal)
to the time the picture was taken by the camera.
3. Relative increments of the format [+/-]value[type], where type must be one of the
following. Note, that month is m and minute is n:

d = day, m = month, y = year, h = hour, n = minute, s = second
Example: +24h is the same as +1d, and it will increment the date by one day. The following
example sets the EXIF field DateTimeDigitized to a fixed value, and corrects the IPTC field
DateCreated by one hour:

Important
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· The JPEG quality value is relevant for most batch operations, even if Size & Quality is not
checked. This is due to the fact, that new images need to be created, except when you do simple
EXIF/IPTC field changes. For an optimal quality/filesize ratio, or if you intend to overwrite your
original images, make sure to use values around 94.
· If you deselect the Output tab, then your original images will be overwritten. You should not do
this, unless you only intend to change EXIF/IPTC fields.
· The IPTC fields ObjectName, Caption/Abstract and Keywords cannot be changed via batch
processing, because they are replicated from the corresponding Database fields Title, Description
and Keywords in the Title and Annotations dialog. If you want to annotate several images at once,
you have to select the thumbs in the Explorer before opening the annotation dialog.
· Read here, how to assign keywords to several images at once.
· When you save your annotations to the image, you may loose EXIF data from fields, that don't
belong to the EXIF standard. If you have such fields in your images, make sure you don't overwrite
the originals by selecting a distinct Destination folder or Prefix.

Related topics
·
·
·
·
·

Image Editor
How can I reduce the size of images?
Watermarks
Rotating Images
Change Image Filetype

7.7

Adding Objects

7.7.1

Watermarks
Creating watermarks inside of images is useful in the following cases:
· You want to mail images to your friends, and the title should be permanently displayed in the
image file.
· You want to upload your best photos to the web, including a copyright protection.
· Friends should be able to order photos by means of a unique file ID.
· When presenting photos in fullscreen mode (local or web album), you want to be able to read the
image title and creation date.
Watermarks can be added in the following dialogs of CodedColor:
1.
2.
3.
4.
5.

Mail images
Batch conversion
Export web album
Image Editor
Video Capture

Items 1-3 create a copy of the image in the Organizer structure and then add the watermark. Item 4
adds the watermark permanently to the original image. Of course, you can still use the Undo feature of
the image editor, as long as the changes have not yet been stored to disk.
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To the left you see a watermark with two lines of text. The first line
displays the image title as entered in the annotation dialog. The second
line shows the Record ID taken from the database, to uniquely identify
the image.

The following text items can be combined two at a time and positioned at top or bottom, left, center or
right positions of the image:
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.

Custom Text1 and Text2 (common information about all selected images)
Photographer
Copyright
eMail Address
Homepage
Location, Camera (or any other additional information)
Filename
Title or Filename (if no title exists in the database, the filename is displayed)
Creation Timestamp
Unique RecordID

Items 1-6 are taken from the album description, if the images are below an album location. All selected
images will receive the same watermark. Items 7-10 are dynamically taken from the database and are
thus different for each image. You can combine a static with a dynamic field in the same watermark.

Remember
· Watermarks cannot be removed from the image, once stored inside the file. You are actually
changing the pixels of the image when adding a watermark.
· Add image titles in the annotation dialog, if you want to display dynamic information in the
watermark.
· The freeware version of CodedColor uses the bottom center location to display a copyright notice.
You can only place your custom watermarks at the top of images in this version. Register
CodedColor to remove this limitation.

Related topics
· For another way to add text, see the Text Labels dialog.
· To add keywords to the database, use the Title and Annotations dialog or the Keyword View.
· Automatic watermarking of multiple images: Batch Conversion

7.7.2

Text Labels
Use this dialog to point to persons or locations in photos, to mark places in maps, to hilight objects in
landscapes or panoramas, etc. There are millions of purposes, and you will never want to miss this tool
again.
Usage and options:
· Click on the New Label button. The button now appears pressed.
· Click into the image and place the new label.
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Change the Caption of the label in the textbox below the button.
Change the Position of the label by selecting it and moving the drag points around.
Delete a label by selecting it and pressing the DEL key.
Change the Font of all labels by clicking on the Font Color panel.
Add a Frame to the image, if some labels lie outside of the image bounds.

Example:
To the left you see a photo that was documented with
text labels (markers), enlarged by a frame and
enhanced with a shadow.

The label storage works in the following way:
All labels are stored in metafiles. Whenever you open an image in the labeling dialog, CodedColor
looks for an existing metafile, and if not existent, it creates a new one. For this you need write access
in the directory of the original image.
After you add or delete labels, or change positions of existing labels, you should save the image to a
filename different from the original one. You then have 3 files, als you can see in the following
example:
1. 06120039.JPG: the original image without labels. Always open this image to edit the labels or
add new ones. The original image will not be changed by this!
2. 06120039.CCO: the metafile containing the labels (text and arrows).
3. 06120039_info.JPG: the merged image containing the labels, and possibly a frame & shadow.
So, whenever you reopen 06120039.JPG in the labeling dialog, the CCO metafile is also loaded and
the labels can be edited. The result is stored in the 3rd file again, where you can decide on the
filename and filepath as you wish.
Please note, that Frame Width, Background color and Shadow are not stored in the metafile, and
may have to be restored manually if you reopen a labeled image.

Related topics
· For another way to add text, see the Watermarks dialog.
· The PDF Export Dialog adds captions to a collection of images, which are then stored in a PDF
document.
· To add keywords to the database, use the Title and Annotations dialog or the Keyword View.
· Read Frames and Masks for a more creative way to add frames and borders.
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Layer Objects
Add Floating Text Layer
Apart from typical font settings, you can set Transparency and add a Shadow to layered text.
Notes:
· If the image is fit (downsized) into the editor desktop, your text may display artefacts before you
merge the layers. If you click on No Zoom, in order to display the image in it's original size, the
artefacts will disappear.
· Try not to manually downsize the text layer by dragging it's edges. This will apply the Antialias
Filter from the Layer Options. It's better to choose a smaller font size in the text dialog in the first
place.
· Watermarks and Text Labels are alternatives, if you want to add non-layered text to an image.

Add Clipart Layer
Allows you to add drawings and cartoons to your image. The files are of type PNG and include an
Alpha Channel (Transparency). In the clipart dialog you can also add a Shadow or change the Size of
the clipart. If you can't find your clipart in the file dialog, click on Browse Cliparts. This opens the
Explorer, from where you can add cliparts by following these steps:
1.
2.
3.

Select the clipart in the gallery and press INS (Copy image)
Switch to the Image Editor and press CTRL+V (Paste into new layer)
Resize, rotate and position the clipart, then call Merge Layers

Note: if the clipart gallery is not yet installed, you will get an installation prompt, asking you to download
the 80 MB compressed file from the internet. It will be installed into the folder
C:\ProgramData\CodedColor Common. Make sure you have Administrator rights and full access
to ProgramData.

Add Map Layer
Adds a map to your image. If the EXIF section of your image contains GPS coordinates, originating
from certain cameras and mobile phones with GPS sensors, the corresponding map will be loaded
automatically. After the map dialog you can add Borders and Shadows and call Merge Layers.

More layer options
· Call Add Layer to add an empty layer, and click on the top left Folder symbol to load an image
into the layer. You can also call the menu item Paste into new layer, in order to paste an image
from the clipboard as a new layer.
· You can also rotate layers. Switch to the Rotate Layer mode and rotate the layer by dragging its
handles.
· In the right mouse button context menu you will find the Layer Options dialog, which allows you to
define Transparency, Shadow and Antialias Filter. The antialias filter comes into effect after
rotations, or in layers that are smaller than the contained image. When you call Merge Layers, the
antialias filter is then applied to the image.
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Overview
CodedColor provides advanced picture manipulation
through an easy to use interface. The left screenshot
shows the result of a Histogram Equalization, used to
brighten up the image.
All operations work on the selected area or the whole
image if there is no active selection. Before starting
the dialog to manipulate your picture you should
check your active selection.
Select the appropriate image manipulation through
the Edit menu or by using a shortcut button.

You can make your adjustments by changing the slider positions or by entering the value into the input
box.
If you have the Lock Preview
enabled you will immediately see the result of your changes in the
Result window. Otherwise you will have to press the preview button to see your changes.
All changes will only be applied to your image bitmap after you press OK. They will not be applied to
your original image before you press Save. You can always Undo your last changes.
Press
Copy Result to Original to preserve your changes before changing to a different image
manipulation tab.
Tutorial
There are always several alternatives for improving digital photos. Which to use depends on many
factors: your taste, monitor, printer and what atmosphere the image should create. Therefore, is is
almost impossible to give exact instructions valid for all cases - you just have to experiment! Try out
the the following image editing functions on an image, which you feel is too dark and unsharp. Most
likely the Equalization described above already leads to a pretty satisfying result, but depending on
your taste, you might find the following options for fine tuning better:
Brightness & Contrast
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You can enhance some of your pictures by changing
the brightness and contrast sliders in the Contrast
tab. For many pictures, the result using Equalization
is better than using brightness and contrast (see
screenshot at top).
In the Equalization tab, you can first try an automatic
equalization by pushing the Equalize button. For
manual control you can adjust the sliders.

Color (HSV, HSL, RGB)
CodedColor allows you to manipulate the colors by
changing the Hue Saturation Value (HSV), Hue
Saturation Lumination (HSL) or the Red Green Blue
(RGB) values.
You can also convert your picture to gray scale by
using the Fast Fourier Transformation (FFT)

Sharpness & Effects
The effects provided range from Bump map, Lens,
Wave, and Morphing filters to user defined filters,
which allow you to select custom filter values using a
Convolution Matrix. See the internet for examples
on how to set the values for different effects.
A useful filter to experiment with the values is the
High Pass1, normally used to make an image
sharper. If you set the middle row, right value to 2 or 3
and the divisor next to it to 3 (see left screenshot),
you can brighten and sharpen the image at the same
time.

Gamma Correction
Gamma correction is used to control the overall color brightness (luminance) and color balance of an
image. Varying the amount of Gamma changes not only the brightness, but also the ratios of Red to
Green and Blue. Usually, Gamma correction is a matter of trial and error.
The Gamma panel of the Improvements dialog allows you to change the overall Gamma, or only
distinct color channels of the image.
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Related topics
·
·
·
·
·
·

7.8.2

Before/After Tutorials
Automatic enhancement tools
Image Editor
HSV & HSL
RGB & CMYK
Basic Effects

White Balance
The Automatic White Balance in digital Cameras tries to make the camera more sensitive to the color
temperature of specific light situations. However, you can also easily do this adjustment on the final
image.
The White Balance tool of CodedColor searches for the lightest area in an image, and - according to
this area - removes any color stains and underexposure in the whole image. Please note, that this
automatic correction does not work very well for images taken in dawn or in backlight situations. A
romantic sunset atmosphere, for instance, might turn out much to bright.
However, if you select parts of the image using the selection tools, all corrections apply to these
selections only. Selections can also have a feather (fade area), reducing the effect of the correction
close to the selection borders.
The width of the fade area can be changed in the Program Settings.
Example
In the following example, the white balance was first applied to the whole image. This caused an
unwanted overexposure of the sky. Since only the sailboat really has a disturbing color stain, we
selected the bottom area in a second try with the selection tool, and then added a feather, in order
to soften the border of the correction towards the sky.
This way we can accomplish an improvement superior to any lens filter or camera internal white
balance.

Original image

White Balance
on whole image

White Balance
on lower part only

Remember: The selection tool of CodedColor allows you to reduce corrections and brush
operations to selected areas.

Related Topics
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· SmartFix Correction
· Remove Color Stains
· Before/After Tutorials

7.8.3

SmartFix
The SmartFix tool is one of the most sophisticated image analyzing and correction tools of
CodedColor. This Tool can be applied on almost any picture, as it leaves good pictures untouched.
Also, it is independent of monitor settings, so you don't have to worry about a badly calibrated monitor.
Try SmartFix on any picture you think is already "perfect" - you will be surprised.
The following corrections are included in the SmartFix algorithm. They are only applied if necessary:
·
·
·
·

Stretch RGB channels
Adjust the Saturation of the colors
Adjust Shadows and Hilights
Bring details to light using a Smart Flash

These corrections will work well for most of your pictures. However, because of the smart flash, you
may not want to use it in some cases, such as sunsets or highly contrasted portraits.
Note, that when the smart flash needs to be applied, the whole process can be noticeably slower
because of the complex analysis involved.
SmartFix sensitivity
These sliders change the intensity of the 3 main SmartFix operations. Decrease the values, if you
frequently produce noise, artefacts or high contrast in the resulting images. Remember however,
that every image reacts differently to the SmartFix algorithm, and that only series of similar images
(under same lighting situations) lead to good results with the same settings. The batch processing
dialog, for instance, allows SmartFix corrections to multiple images at once, and this is where the
sensitivity values should be carefully adapted.
Example
In the example below, a slightly foggy sky lead to overall washed out colors. Even though the sun
was present (as seen by the shadows), the colors don't look very vibrant. By automatically stretching
the histogram, contrast was improved and the gray color stain in the walls was removed. This
becomes clear when looking at the top left wall, which already has a distinct satellite dish shadow,
but now also reflects the sunlight correctly. Also, the meadows in the back appear more "sunny", and
the clothes on the line have gained in color vibrancy.
Also have a look at what we did to this picture in the Fill Bucket topic.

Before

After

See also the Cloning example, which incorporates 2 further steps to dramatically improve an image.
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Related Topics
· Since the SmartFix tool causes noticeable (yet defensive) improvement in almost any picture, we
have also added it to the Batch Conversion utility.
· Before/After Tutorials

7.8.4

Exposure Correction
This dialog corrects exposure problems in a picture. You will be surprised at the positive effects the
following 4 tabs can have on many of your photographs:

Auto
Performs automatic contrast adjustment. The contrast is adjusted automatically by stretching the
histogram between the minimum and the maximum optimized values. The Stretch All Channels
option is provided in case you want to stretch each color channel separately.
Example of Auto Contrast:

Before

After

Brightness
Performs 3 adjustments on Brightness, Contrast and Gamma. All 3 RGB channels are changed at
same time with these operations.
Brightness
Brightness is a linear function applied to the histogram range. Increasing or Decreasing brightness will
affect all values in the histogram of the picture by the same amount. So dark and bright pixels will
result brighter or darker by the same amount.
Contrast
Contrast is also a linear function applied to the histogram range. Increasing or Decreasing the Contrast
will modify differently dark and bright pixels. Increasing Contrast, dark pixels will become more dark
and bright ones will become even brighter.
You can use the Un-linear contrast option to decrease the contrast, without loosing color information
in the picture. To Adjust Brightness and Contrast more precisely you should use the Levels Tab, where
it's possible to modify separately at the same time Shadows, Midtones and Hilights.
Gamma
Gamma correction is a non-linear correction that is based on an exponential formula. A Gamma curve
represents the way usual monitors reproduce and display RGB values. This monitor conversion is
necessary since the human eye has a nonlinear response curve, in fact it is more sensitive to
variations in low light than to an equal variation in bright light.
Applying a Gamma correction curve can thus simulate the effect of viewing a picture on a brighter or
darker monitor.
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Example of correcting Brightness, Contrast, Gamma

Before

After

Levels Tab
In the Levels Tab it's possible to regulate the Exposure, even for each RGB channel separately, by
changing the amount of Shadows, Midtones and Hilights.
See the Histogram & Curves topic for more information.

Smart Flash
Sometimes, there are parts of the picture which are under-exposed and need to be corrected. To
recover details in these dark regions, it's not useful to use one of the more common regulations,
because we will risk to over-expose the part of the picture that doesn't need any correction.
In order to solve this problem, we invented a smart algorithm, which affects only parts of the picture
that need to be brought to light. You can regulate the amount to be applied on the picture by simply
using a slider.
The algorithm is especially effective in some situations that will always happen, no matter how good a
camera you have:
· where there's strong sunlight shining into small streets (as seen in the example below)
· when you take indoor pictures without a flash, and the light through the window is very bright
· when you photographed someone against the sunlight
Example of Smart Flash

Before

After

Important
· Remember, that correction tools permanently change the appearance of a photograph, and that
some of the original information of the picture may be lost. While the algorithms in CodedColor are
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not as aggressive as in many competing programs, always make sure that it's not your monitor
that is causing the apparent flaw. That way, you would actually ruin an image because of a badly
adjusted monitor. If in doubt, it's a good habit to keep your original pictures in a backup folder.
· If you only want to apply Exposure corrections to certain parts of an image, you can create
Selections or use the Retouch Brushes.
· When selecting parts of the image using the selection tools, all brushes and correction dialogs
only apply to these selections. Selections can also have a feather, reducing the effect of the brush
or correction close to the selection borders.

Related topics
· A short introduction to Histograms
· Before/After Tutorials

7.8.5

Color Correction
This frame allows to adjust and finetune the color appearance of the picture. You can also achieve very
surprising or proffessional effects with a combination of the following 5 tabs:

Auto Colors
The auto tab applies 3 automatic adjustments in a single step. The automatic corrections applied are:
·
·
·

Stretch: an automatic histogram stretch for each channel of the histogram
Color Balance: automatically detects color casts and balances the colors accordingly
Saturation: adjusts the level of saturation of the colors

You can regulate the amount of Auto Colors to be applied on the picture by using the slider.
Example of Auto-colors

Before

After

Balance
In this tab you can specify for each of the Ranges Gamma, Shadows, Midtones, Hilights and All the
balance between complementary colors, that are: Red-Cyan, Green-Magenta, Blue-Yellow. The tool
lets you precisely change the color of your pictures, without loosing their original appearance and
details.
You can visualize the correction curves applied by looking at the Histogram Display. Press the
Suggest Button for balancing colors automatically.
Example of Color Balance

© 2013 1STEIN GmbH

56

CodedColor Photostudio - Documentation

Before

After

Color Cast
To remove a color cast:
1) Select the color picker tool
2) Click on a point in the picture that you know should be of neutral color (for example white or gray)
3) The color cast in the whole photograph will be removed assuming that the selected source color
must be neutralized
4) You can regulate the amount of Cast Removal to be applied on the picture by using the slider
If you are unsure which source color to choose, try the Suggest Button.
Example of Color Cast removal
In this example, the neutral point was chosen in the background. As you see in the result, the blue
color stain was removed in the whole image, including the face of the boy.

Before

After

Hue, Saturation & Lightness (HSL)
The Hue is a gradient change of color. In the color spectrum, you can distinguish between Reds,
Yellows, Greens, Cyans, Blues and Magentas gradations.
The Saturation refers to the vividness of a color. A fully saturated color is very pure and deep; as you
reduce the saturation, the colors become progressively more washed out until - at zero saturation they are just shades of gray.
The Lightness is the amount of white of the colors.
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1) First select the color range you want to adjust, by using the color bar or the color range menu.
You can also select a color range through the color picker tool and by clicking on the picture.
2) Change the hue shift slider to adjust the color gradation, the saturation slider to adjust the
vividness and the lightness slider to add or subtract white to the colors.
Example of HSL
In this example, a dramatic effect was achieved by applying a hue shift of yellow to red.

Before

After

Levels Tab
See the Histogram & Curves topic for more information.

Important
· Remember, that correction tools permanently change the appearance of a photograph, and that
some of the original information of the picture may be lost. While algorithms in CodedColor are not
as aggressive as in many competing programs, always make sure that it's not your monitor that is
causing the apparent flaw. That way, you would actually ruin an image because of a badly
adjusted monitor. If in doubt, it's a good habit to keep your original pictures in a backup folder.
· When selecting parts of the image using the selection tools, all brushes and correction dialogs
only apply to these selections. Selections can also have a feather, reducing the effect of the brush
or correction close to the selection borders.

7.8.6

Sharpness
The purpose of this dialog is to improve sharpness and edges of the pictures, thus solving focus
problems. Many blurred pictures can be dramatically improved by the algorithms provided.

Sharpness
This tab allows you to regulate the precision of details in a picture: you have both the option to increase
or decrease sharpness, moving the slider to the right or to the left.

Enhance Edges
This correction increases the contrast of those pixels that are near the borders or edges inside a
picture, thus making the borders more visible and precise.

Unsharp Mask
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This is a progressive technique to increase the sharpness of a picture without increasing background
noise, that is the grain of the picture itself. Many simple sharpness tools produce unwanted artefacts
and thus ruin the image.
To distinguish between true edges and normal noise (grain), a copy of the picture is heavily blurred
using a Gaussian algorithm with a given radius. The unsharp algorithm then uses this copy to decide
where to apply a sharpen filter and where not.
The correction has 3 parameters: Amount, Radius and Threshold.
· Increase Amount to increase the sharpness effect
· Increase Radius to reduce the noise. The bigger the picture, the bigger the radius should be,
though rarely you will need to use values greater than 3.
· The threshold represent the selectivity of the algorithm to edge detection: the greater the
threshold, the less edges will be detected.
Common values for these parameters are:
· Amount: between 0.5 and 2
· Radius: between 0.6 and 2.5
· Threshold: between 2 and 6
Example of Unsharp Mask
Note, that in this example the grain of the blurred background is sharpened only minimally, and the
effect of distance is thus preserved. Use the Unsharp Mask for delicate sharpness adjustments to
otherwise proffessional photographs.

Before

After

Important
· If you only want to apply Sharpness or Blur to certain parts of an image, you can create Selections
or use the Retouch Brushes.
· When selecting parts of the image using the selection tools, all brushes and correction dialogs
only apply to these selections. Selections can also have a feather, reducing the effect of the brush
or correction close to the selection borders.
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Histogram & Curves
Curves
The Curves panel is an effective tool for correcting Exposure as well as Color of pictures. The Curves
let you adjust the whole tone range of an image. You can adjust any point along a 0-255 scale while
keeping other values constants.
The horizontal axis of the graph represents the original intensities of the pixels or input values. The
vertical axis represents the new values or output values for the same pixels. On the diagonal line all
pixels have identical input and output.
Click any point on the curve that you want to remain fixed. For example if you want to adjust the
midtones, click on a point in the center of the diagonal: this will create a new fixed point. Move, by drag
& drop, this point horizontally to the right to decrease midtones or to the left to increase midtones. You
can add more "control points" the same way.
To remove a control point just right click on it. You cannot delete the endpoints of the curve, but you
can move them. To move a point, pass the mouse over it and when the cursor becomes a hand
symbol, click and drag the point to the desired position.
You can edit all 3 RGB channels at same time (luminance) or just a channel per time.

Levels
In the Levels Tab it's possible to regulate the Exposure (Contrast) and Color for each RGB channel
separately, by changing the amount of Shadows, Midtones and Hilights. The tab is divided into Input
Levels and Output Levels. You can modify the original levels in the picture (input), and then further
modify the resulting levels (output). Basically, this dialog is a more advanced version of the Curves
panel described above.
Input Levels
· Shadows: here you can increase the amount of Shadow in the picture, by moving the so called
black point of the picture to the right.
· Hilights: the same way you can increase the Hilights, by moving the so called white point to the
left.
The combination of these 2 operations on Shadows and Hilights is called the Contrast Stretch and is
provided to increase the level of Contrast in the picture. It is recommended that you don't move the
Shadows & Hilights points beyond the histogram left and right limits, which you can easily visualize on
the histogram display.
· Midtones: moving the slider to the left increases the level of light in the midtones range, moving to
the right decreases the same level.
Output Levels
Oppositely to Input Levels where you can only increase contrast, in Output Levels you can decrease
contrast by moving the Shadows and Hilights sliders. It's not very common to use this correction, since
it looses part of the color information of the picture, trying to achieve a washed-out effect. To reduce
contrast and hilights more easily, you can also use the Exposure correction dialog..
Example of Levels adjustment:
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Before

After

Related topics
· A short introduction to Histograms
· Before/After Tutorials

7.8.8

Noise Removal
Digital cameras as well as other digital instruments have to deal with noise and artefacts. Noise in a
picture can be considered as a random variation in the normal pixel distribution. In other cases, noise
is not random when caused by a digital process like JPEG compression, leading to so-called JPEG
artefacts. A small amount of noise is normal for a photo, due to the limits of the camera's sensor.
When the amount of artefacts or noise is too big, it's possible to reduce it with special digital
corrections. Keep in mind, that reducing noise will loose some of the photograph's original information,
so you have to accept a compromise when using these tools.

Noise
This applies a smart smoothing operation that preserve the true edges (high frequencies) of the
picture, removing artificial disturbance in the low frequencies.

Jpeg Noise
As you probably know jpeg is a lossy format and saving a picture in this format with a high
compression can degrade it noticeably. A common mistake is to reload and save a jpeg file several
times: even using low compression each time this process will degrade the quality of the picture.
Jpeg can present small and big artefacts: Small artefacts are visible as halos near the edges of the
pictures. They appear when the jpeg has a medium compression. Big artefacts are blocks of pixels of
the same color and they appear when jpeg files are heavily compressed.
To reduce both these problems use this Remove Jpeg Noise tool.

Moirè (Despeckle)
When acquiring a picture from a scanner it may appear a problem called Moirè Artifacts. It consists in
the presence of slightly visible stripes all over the picture, equally distant one from the other.
The Remove Moirè filter can reduce this problem in your picture. Use the slider to regulate the amount
of filter to be applied.

Important

© 2013 1STEIN GmbH

Editing Pictures

61

· Remember, that correction tools permanently change the original information inside a photograph.
Noise may appear less annoying on different monitors or if the image is zoomed. CodedColor, for
instance, applies a non-permanent display filter to the image during zoom operations by the user,
thus temporarily reducing noise and artefacts.
· When selecting parts of the image using the selection tools, all brushes and correction dialogs
only apply to these selections. Selections can also have a feather, reducing the effect of the brush
or correction close to the selection borders.

7.9

Brushes

7.9.1

General Settings
All paint tools have common brush settings: Radius, Opacity and Feather are 3 parameters that can
always be adjusted. Also, it's possible to choose a Custom Brush from any picture file on your
filesystem.
· Move the Radius slider to change the size of any brush.
· Move the Opacity slider to change the intensity of the brush on the canvas.
· Move the Feather slider to smoothen or intensify the borders of the brush.
If the Paint Over option is checked, the brush will act more like a real brush, i.e. with reduced Opacity,
repeated paint strokes increase the color intensity. When unchecked, the brush will not paint on parts
of the picture that were already painted. The effect becomes obvious when selecting an Opacity of
~50.
You can also choose the painting Step. The Step is the distance between two consecutive brush
strokes. A large step is similar to lowering the Opacity, and is somewhat contrary to Paint Over. A
large Step value is also useful in combination with a Feather, as the feather tends to disappear during
slow painting movements.
Example: The following settings simulate a Spray Gun:
·
·
·
·

Paint Over on, Step 30
Opacity 60
Feather 100
Blend Mode Normal

Blend mode
Imagine there are 2 colors you want to mix: a background color and a foreground color. You can mix
them in many different ways, for example you can average the amount of each color (Average blend
mode). CodedColor provides you with many other blend modes to experiment with.
The Replace Hue blend mode replaces all colors under the brush with the current brush color, but
preserves grayscale pixels and thus the underlying image texture. You can reduce the effect with the
Opacity slider, but feathering is not available in this mode. A more flexible alternative is the
Color Replacer Brush. The Red Eye Correction applies a similar algorithm.
Paint modes
The paint modes are usually 2 for every paint tool: Painting and Erasing.
The Erasing mode lets you correct mistakes by restoring the original picture using a brush. This eraser
can only be used for the current tool changes. To undo changes completely, use the Eraser Brush
dialog. It allows you to restore parts of the original image after several consecutive tool changes.
Some tools also have a Color Picker (pipette) mode to select a color inside the picture. See the
Red Eye topic for a complete button overview.
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Important
· When going into Zoom or Selection mode, the Brush Paint mode is disabled. You have to press
the Brush button again, in order to resume painting.
· When selecting parts of the image using the selection tools, all brushes and correction dialogs
only apply to these selections. Selections can also have a feather, reducing the effect of the brush
or correction close to the selection borders.

Related Topics
· Red-Eye Correction
· Before/After Tutorials

7.9.2

Paintbrush
The paintbrush tool can work in two ways: with Color or with Textures.
Color
The Color selector automatically stores the last colors used. To select a specific color, first select the
basic gradient (reds, greens, etc.) from the Rainbow Column, and then click on the left Gradient Box
to finetune saturation and luminosity of the color.
If you want to load a color you used previously, just click on it in the Color Palette on the right.
Texture
The Textures selector allows you to choose a folder of textures on your computer and to load a single
texture file. Textures are just picture files or photographs of any format supported by CodedColor.
If you load a photograph or texture, it may be useful to change the scale of the image with the spin
buttons below the texture preview.
Painting with transparency
In the following examples, we are painting with a red color on a green background. Feather is 100 and
Blend Mode is "Normal" in all examples.

Paint techniques and settings:
1.
2.

One short brush stroke (= one mouse click)
Several circular strokes of the brush while keeping the mouse button down. Notice that the
feather effect reduces with every stroke.

3.

In the color selector dialog, increase the transparency (vertical slider) to 80%. Then analog to
1.
With above transparency, analog to 2. Notice the pink border, due to the circumstance, that the
feather also reduces the transparency effect at the rims of the brush.

4.
5.
6.

In the color selector dialog, increase the transparency (vertical slider) to 100%. Then analog to
1.
With full transparency, analog to 2. Now there is no disturbing border.

7.

Set Opacity to 50, then analog to 2.
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Activate Paint Over, then analog to 2. The color intensity (in this case a transparent color)
increases with every mouse movement.

More Information
· There are many places on the internet where you can download textures for free. You can also
use the Google image search to find icons, symbols and pictures. That way, you could add a flying
bird to an otherwise neutral sky, or insert a large moon into a night photograph.
· See the General Settings topic for brush options and Blend Modes.
· Before/After Tutorials
· Defining a transparent color
· Removing transparency
· Removing a color (wash out)

7.9.3

Replace Brush
Steps in replacing a color:
· Open the Replace Color tool panel
· Select a Source Color by clicking in the image with the SHIFT key pressed
· Set the Tolerance to a value below 255, if you want to widen the selected color range, i.e. if you
selected blue, you may want to include green
· Use the Color Picker or the Color Panel to select the color you want to replace the source color
with
· Activate the Brush, and define Radius and Opacity
· Start painting (replacing)
· Use the Eraser Brush to correct overflows
Important: shades of gray will not be replaced, including black and white. The Color Replacer is a very
innovative tool, which preserves the texture in colored areas. Since shades of gray make up the texture
of an image, they are not touched by the color replacer brush. If you want to replace black or white with
a color, or a color with black or white, turn off the Preserve Texture option.
Currently, the Replace Brush does not support transparency.

Related topics
·
·
·
·
·

7.9.4

Red Eye Correction: Manual mode
Paintbrush: Replace Hue
Remove a Color
Remove Alpha Cannel
Transparency

Retouch Brush
This tool allows you to apply local improvements to your pictures.
The retouch modes are:
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·
·
·
·
·
·
·
·

Blur:
Sharpen:
Dodge:
Burn:
Lighten:
Darken:
Saturate:
Desaturate:

Reduce the sharpness of edges, remove details and artefacts
Increase sharpness of edges
Lighten hilights
Darken shadows
Increase midtones
Decrease midtones
Increase vividness of colors
Decrease vividness of colors (eventually turning to gray)

More Information
· See Exposure Correction, Sharpness and Noise Removal for overall image improvements.
· See the General Settings topic for brush options and blend modes.
· Before/After Tutorials

7.9.5

Fill Bucket
The fill tool lets you apply Color or Texture to a photograph by filling areas of similar color. All pixels
near the mouseclick in the image, that have similar colors, will be filled with the current brush color or
texture.
To regulate the tolerance for detecting similar color pixels, move the Tolerance slider. Higher
tolerance values will fill greater areas.
If you are not satisfied with the result, change some of the settings (tolerance, blendmode, opacity,
etc..) and see an immediate dynamic reflection in the photograph. This unique behavior was developed
for CodedColor in order to give you superior flexibility as compared to other programs on the market.
Example of Fill bucket:
In this example, the gray sky and the walls were "vamped" up a little by filling in blue and yellow color
with opacity. The opacity is necessary in order to preserve the texture of the filled regions. Since the
sky region "spills" a little into the forest on the horizon, you could reduce the tolerance a little more.
Also note, that the satellite dish on the left turned yellow, as the tolerance level could not distinguish
between the gray of wall and the gray of the satellite dish. You could use the Eraser brush to correct
this mistake, brighten the dish by using the Retouch Brush or just do another Fill with white and a
very small tolerance.

Before

After

More Information
· There are many places on the internet where you can download textures for free.
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· See the General Settings topic for brush options and blend modes.
· Before/After Tutorials

7.9.6

Clone Brush
With this tool you can copy part of a source picture onto a target picture. Source and target pictures are
usually the same. When the tool is first loaded, the current picture in the Image Editor is assumed both
as source and target.You can see the source picture as a miniature in the thumb display.
Source Point: the point on the source picture from which you want to start the copy process
Target Point: the point on the target picture where you want copy the source to
How to Start Cloning:
1. At first, the source point is unassigned: to assign an initial source, SHIFT+Click on the picture in
the miniature display or, if you want to copy from the same current picture in the editor, just
SHIFT+Click there.
2. After having selected the source point, just start to paint normally on the picture in the editor. The
target point will be the one where you first click when starting to paint.
If source and target images are of different size, you can also change the scale of the source picture,
by using the Scale spin buttons below the miniature preview.
Press New Target, if you want to repeat the cloning with the same source point, but in another target
location.
Example: you want to place a number of birds into an otherwise empty sky. The bird is taken from a
source picture, and painted in several steps (with different scales) into multiple locations of the sky in
the target picture.
The Synchronize Source and Target option lets you to set the same XY coordinates for the target
and the source points, in order to copy parts of a picture of the same size as the target picture with a
pixel precision.
Example: Cloning and Retouch Brush
In the image to the left, the oranges from the
source fruit bowl were copied in different sizes
(Scale) to the target image.
The border of the oranges was then blurred
using the retouch brush.
You could now use the paintbrush to add
shadows.

Example: Cloning, Rotation and SmartFix
In this example, the person at the left side of the original picture was removed using the Clone
Brush. Also, the horizon was straightened using the Rotate dialog, and SmartFix image correction
was applied to remove the red color cast and increase the contrast of the sky. Remember, that this
is exactly the same image, much improved in only three steps.
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Before

After

More Before/After Tutorials...

7.9.7

Smudge Brush
The Smudge Brush is a combination of the Retouch and Paint brushes. It smears (wipes) pixels in a
similar way that a paint brush would do with wet paint, and it is used to correct edges, remove artefacts
or simulate movement.
It has a Radius and an Intensity option, similar to the Opacity of the Paint Brush.

Example with low intensity

Example with high intensity

Related topics
· Retouch Brush
· Eraser Brush

7.9.8

Eraser Brush
The innovative eraser brush allows you to restore parts of the original picture by painting over
previously changed areas. You can soften the undo effect by defiining an Opacity and Feather. Turn
off Paint Over, if you want to have an equal undo effect in larger areas.
The eraser undoes all image improvements or paint operations. Some typical situations:
·
·
·
·

the Fill Bucket spilled color into unwanted areas
the Red Eye Correction was too intense in one eye
too much contrast in Exposure correction removed the texture of the sky
Noise Removal also deleted important detail in the face of a person
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· you forgot to use a feather on the Paintbrush, and now you can see the brush borders
· the removal of a blue stain in Color Correction unfortunately also faded the clothes of a person in
the image
· a Histogram stretch to lighten the foreground also ruined the colors of the sunset
Note, that some eraser operations can be prevented beforehand, if you create selections (with
feathers) before applying corrections or brush tools.

Important
· When going into Zoom or Selection mode, the Eraser mode is disabled. You have to press the
Brush button again, in order to resume.
· When selecting parts of the image using the selection tools, the eraser brush applies only to these
selections. Selections can also have a feather, reducing the effect of the eraser close to the
selection borders.
· See the General Settings topic for brush options.
· Before/After Tutorials

7.10

Effects

7.10.1 Basic Effects
Basic Effects
Provides a dialog with some basic effects, common to most image editors.
User filter
This is a mathematical transformation which is applied to the image pixel by pixel. The center value of
the matrix designates the pixel (anchor), while the surrounding values are included in the mathematical
calculation.
Morphing
Morphing uses a similar mathematical procedure to remove some details in the image, while
accentuating others. The size of the matrix and the number of pixels to be combined are determined by
the Window Size.

Add Borders & Shadows
If you add a shadow to the image, you are also adding a transparent area around the image.
Transparency can only be stored in image filetypes which contain an Alpha Channel, like PNG. If you
store the file as JPG, you will be asked for a color replacement, where you would usually pick White.
· Also see Frames and Edges.

Invert Colors
This feature can come in handy, if you scanned color negatives, i.e. where the colors are inverted.

Convert to Sepia
This feature is similar to the Duotone Image of the Advanced Effects, when using a blend of yellow.
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Convert to B/W
An alternative to this shortcut is the Color > HSL toolpanel, where you would set Saturation to 0.

Define Transparent Color
There are several ways to define transparent areas in an image. The transparency tool works best with
objects, that have a bounding frame with a distinct color. However, setting this color to transparent
would also include areas of the object having the same or similar color (example 2). To overcome this,
you would select the object, invert the selection, and use the transparency tool on this inverted
selection only (example 3).
A more flexible method is using the Paint or Fill brushes with a transparent color, allowing for more
options, like the Inclusive fill mode (example 4). Read about the identical Magic Wand Modes to
understand this option. The transparency tool only works in Global mode.

1. Original image

3. Transparency tool with an
inverted Selection of the basket

2. Transparency tool with a
Tolerance = 60

4. Fill tool with transparent color,
Tolerance 60, Fill Mode Inclusive,
Blend Mode Normal

Careful: JPG files don't have an Alpha Channel, so you would have to save the image to a PNG file
instead.

Remove Alpha Channel
Does the opposite of the transparency tool above, i.e. removes transparency in an image and asks for
a Replacement Color. Transparency is stored in the Alpha Channel of an image.

Remove a Color (Washout)
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This tool opens the Color toolpanel in HSL mode and asks you to use the Pipette to select a source
color. This color can then be reduced to grayscale by moving the Saturation slider to a value below 0.
The washout tool can be used for so-called Colorkey effects, i.e. to enhance objects while blending
out the background. It can also help you to remove unwanted Color Stains or to shift color ranges.

Replace a Color
· See Replacement Brush

Correct Perspective
· See Perspective Correction

Radial Stretch (correct lens distortion)
Radial Stretch uses a mathematical matrix transformation to correct lens distortion. Usually you need
to move the sliders only a couple of ticks up or down. Higher values can be used to create a fisheye
effect.
· see Advanced Effects for more transformations

Deskew
Deskew uses an intelligent image recognition algorithm to detect horizons in images and automatically
correct minor rotations. The algorithm does not work for all images, but the results for scanned text
documents are the more better, as required in preparation of OCR. This is why the option is also
available in the Scan dialog.
If you want to determine a horizon manually, use the Rotation dialog instead.

Separate Images
Automatic separation of images can become useful for multiple photo scans. Make sure the photos are
not overlapped when placed on the scanner. The function tries to detect distinct photos in the scan,
which are then automatically separated and rotated.

Related topics
· Basic Operations
· Advanced Effects

7.10.2 Advanced Effects
To see all available effects (pixel modifications) and transformations (image geometry), visit this link.

Notes
· The effect parameter settings are highly dependent of the size of the image.
· If you want to limit an effect to a certain area, define a selection incl. feather before opening the
dialog.
· To erase or weaken effects, use the Eraser brush on designated areas afterwards.
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Related topics
· Basic Effects
· Before/After Tutorials
· Frames and Edges

7.10.3 Frames and Edges
CodedColor offers two techniques of adding frames to images. The 1st technique produces typical
frames in different colors, while the 2nd technique feathers the edges of the photo in an artistic way.
1. Adding a typical frame by means of a layer above the photo
In the frame dialog, all files with names similar to frame[x].[y] are added as layers, where [y] is
the filetype. There are currently 8 different PNG frame files provided, but you can add your own in the
Organizer Resources directory. If you add own frames, make sure they have an Alpha Channel and
the center color is a very rare color, like Pink for instance. This color is used by CodedColor as the
transparent color, thus displaying the photo behind the frame layer.
2. Masking the photo with a frame image (feathered edges)
In the frame dialog, all files with names similar to mask[x].[y] are merged (masked) with the photo,
where [y] is the filetype. There are currently 8 different JPG mask files provided, but you can add your
own in the Organizer Resources directory. If you add own masks, make sure the image contains only
Black, White or Gray pixels, where Black is used as the transparent color. If White should be the
transparent color, then you have to set the Invert Mask option.
Image Displacement and Background Color can be used to find the optimal position of the photo
inside the frame.
Filmstrip example
The image to the left was framed using the mask5.jpg
file with the following options:
·
·
·
·

Rotated by 90°
Inverted Mask
Displacement 25%
Background Color Black

Try the frame5.png file for an even cooler result.

Remember
You can add your own frames in the Organizer Resources directory. Make sure you use the right
filenames and transparent colors, as described above.

Related topics
· Borders & Shadows
· You can also add simple borders to an image by calling the Extend Workspace dialog in the
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image editor.

7.10.4 Perspective Correction
A typical case of perspective distortion involves architectural photos. The example below shows a
church, with narrowing towers towards the top of the image. If you move the top left & right red
handles outwards, you can correct this distortion. You will, however, loose portions of the image (2). If
you want to decide yourself, which parts of the image should remain visible (clipping), you can either
pan the image behind the red handles, or start by extending the workspace (3), in order to position a
separate crop frame (4) after the correction.

1. Original image

3. Using an extended workspace to
create room for a manual crop frame

Extended perspective correction:
·
·
·
·
·

Press Extend Workspace several times
Move the red handles to change the perspective
Klick Apply Changes
Klick on Crop, and position/resize the crop frame
Klick Apply Crop

Related topics
· Rotate Images
· Correct barrel distortion
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Title and Annotations
With CodedColor you can add captions, descriptions and keywords to your picture database.
Select Edit > Edit Annotations, or simply press F4 to start the annotations dialog, whenever you have
highlighted a picture in the Explorer window, the Fullscreen (screenshow) mode or from the
Image Editor.
You can enter or change the following information:
·
·
·
·
·

Include: remove this checkbox, if you want to exclude this image from your Web Album
Creation Date
Title: if provided, the title displayed alternatively to the filename
Annotation: description of the image or photo
Keywords: use these Keywords to later search for groups of images

All information is stored in the CodedColor database. You can search for this data. Depending on your
settings, you can include the information in your Web-Album, Contactsheet and display it in any view
mode of CodedColor. You can also physically add watermarks to your images from the database
records.
Note: Some of the information is also copied into the IPTC fields of image file. The advantage is, that
you can exchange these images including the information, by simply sending the image files per mail.
The image must be a supported filetype, such as JPEG with write access.
The following fields are kept synchronous with the IPTC fields, and can only be edited in the DB tab:
· DB Title = IPTC Objectname
· DB Description = IPTC Caption/Abstract
· DB Keywords = IPTC Keywords

Hint
To enter the same Title, Keywords and Description to several images, follow these steps:
·
·
·
·

Open the annotation dialog
Pick the source image in the explorer and enter the information in the floating dialog
Press the Copy button beside the record navigator
Move to or pick the the destination image and press Paste. The data is added to the current
record. If the record already contains information, you have the choice of overwriting this or just
filling in the blank fields.

To enter the same EXIF or IPTC data to several images at once, don't use the annotation dialog, but
the Batch Processing dialog instead. Also read some important information on this in the following
chapter EXIF/IPTC fields.
To assign Keywords to several images at once, you can also use the Keyword View of the Explorer.

Related topics
·
·
·
·

Search in the Database
Search for Keywords
Why are not all keywords displayed in the dearch dialog?
Database definition
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· Web Album
· Glossary: IPTC
· What's the difference between file date and photo date?

7.12

EXIF/IPTC fields
CodedColor allows to read from and write EXIF and IPTC information into images. This information is
also stored in the XML database, so if another software destroys it in the original image, it can be
easily restored in CodedColor.
The information can be entered or changed in the corresponding tabs of the Annotation editor. There
you can also find a Field Editor, with which unwanted fields can be disabled, and captions of displayed
fields can be changed.
The Info tab displays an information summary with the currently enabled fields.
Each of the two EXIF and IPTC tabs have two subsections named Editor and Raw. The Raw section
displays the information as it is stored in the XML database. By clicking on a raw value link, you can
search for all images in the database that have this value.

Important
· The IPTC fields ObjectName, Caption/Abstract and Keywords are locked, because they are
replicated from the corresponding DB fields Title, Description and Keywords. Please use the DB
(database) tab to edit these values. EXIF fields like ImageDescription and Copyright have no
database equivalent, and are only editable in the EXIF tab. Also, as a backup and for search
reasons, all raw EXIF and IPTC data is replicated from the image file to the database.
· Sometimes, other image editors loose EXIF and IPTC data from the original image file when
changes are stored. CodedColor may restore this information, since the original data exists as a
backup replica in it's database.
· When you save your annotations to the image, you may loose EXIF data from fields, that don't
belong to the EXIF standard. If you have such fields in your images, you should deactivate the
option Save EXIF annotation changes in the Program Settings under Image Editor, or use the
Backup option above. This option also backups your images, before storing changes in the
Image Editor.
· If you selected several images, before opening the Annotation Editor, then only changes in the
fields Title, Description and Keywords are applied to ALL selected images. To enter the same
EXIF or IPTC data to several images at once, don't use the annotation dialog, but the
Batch Processing dialog instead. A more comfortable way to assign many Keywords at once is
provided by the Keyword View.
· The EXIF minithumb of the image is refreshed by CodedColor during all write operations. If you
edit or rotate an image, the EXIF thumb is kept synchronous with the main image, allowing
applications like the Windows Explorer to show correct previews of the photos inside a folder. This
also means, that the image orientation will be the same as the thumb orientation, and the flag
EXIF_Orientation will be 1. You don't need to worry anymore about false miniature
orientations or asynchronous thumbs. Even Batch Conversion writes the correct thumb into the
EXIF data.

Related topics
· Title and Annotations
· EXIF definition
· IPTC definition
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·
·
·
·

7.13

What's the difference between file date and photo date?
Changing EXIF / IPTC in multiple images at once
Correcting date values in EXIF / IPTC fields
Rotating images

Change Image Filetype
A common image editing task is conversion of one file type to another. You can convert a whole
directory using Batch Conversion, or change the file type of the current image in the Image Editor,
even if you have not performed any other changes on the image.
Call the menuitem File > Save As for instance, to transform a loaded BMP file into the JPEG format.
When the dialog for the destination filename appears, you can select the desired file type JPEG and
click on the Advanced button, maybe to reduce the quality (and thus the file size) or to enable a
smoothing factor. Each file type has it's own dialog containing color, quality and storage options.

Hints
· A JPEG quality of 96 is an optimal compromise between image quality and file size.
· GIFs only allow for a maximum of 256 colors, so be careful when you change your JPEG photos
to GIFs.
· You can change the color of BMP images to black & white, a common task of professional
photographers.

Related topics
· Batch Conversion
· How can I reduce the size of images?
· Export Multipage Documents (PDF, TIF)

7.14

External Editors
CodedColor allows you to use other picture editing software to manipulate your images. Select File >
Send to, or right-click on the thumb and select the editor of your choice. The selected pictures will then
be transferred to the chosen application. CodedColor will automatically detect any changes made by
the third-party tool. You can customize the list of tools by selecting Define "Send to" List.
The Applications tab shows all applications installed on your Windows system, if they are correctly
registered by an installation program. In this list you can select the external editors of your choice, with
which you want to edit your pictures.
If you want to refresh this list of applications (after installing more image editing programs), press
Refresh list. Please note, that you then have to reselect your preferred image editors.
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List of installed Applications
Enable those applications, that you want to
appear in the Send To menu.

Organizer with Applications folder
The Application links in this folder can be
refreshed by clicking on Program Settings
> Applications > Refresh List. You can
start an application by doubleclicking on the
linkfile in the Organizer.

Send To popup menu
This menu appears in the Explorer in
Imageview and Thumbsview, when pressing
the right mousebutton on a thumb and
selecting Send To. The selected image will
then be opened in the desired application,
for instance Photoshop or MS-Paint.

Related topics
· Image Editor

7.15

Tutorials

7.15.1 Complex Tutorial: Postcard
Note: before you try the following professional tutorial, we advise you to read our
Before/After Tutorials, which are also displayed within CodedColor in the left hand toolbar of the Image
Editor.
The following tutorial combines some of the unique editing capabilities of CodedColor PhotoStudio. In
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case you ever envied the perfection of photos in magazines, postcards and photo contests, have a
close look at the tricks we will show you in this short tutorial. After this you might see "expert" photos
from a different perspective, and you'll probably think twice about dumping some of your "novice"
shots.
As you can see below, the original picture was taken during bad weather and light conditions, and with
some annoying objects in the image. Here are some of the comments you might hear from a critical
expert:
·
·
·
·

I thought you said the weather was good... Where's the sun?
I can't really see your face, it's too dark. Next time use a flash.
Bad composition - the ski in the foreground is somewhat annoying.
Was it really a skitour, or did you actually use the lift?

Original image

Edited image

It's not easy being green, right? Especially not at -15 degress. Well, don't worry, from now on you can
fix all of these little flaws and turn boring photos into amazing postcards in a few easy steps.
And here's how it's done:

1. Add some sunlight (easy)
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Even though there are several approaches to adding sunlight,
I found that the most flexible result can be achieved in the
Curves > Levels panel. You can also try the
Exposure Correction tools in addition to this.
The idea is to stretch the histogram, in order to get more
contrast in the high tones. For this you should move the Hight
Tone slider from 255 to about 240, and then press Apply.

Next, you might want to remove the blue stain resulting from a
faulty white balance in the camera, which often happens in
snowy environments.
Using the Automatic White Balance of CodedColor turns out
to be too radical, so open the Color > Color Cast panel and
use the Pipette to select a stained snow area, which will then
be "cleaned" to a shade of white and gray.

2. Add some flash (very easy)
This feature is very innovative, as it automatically detects the
underexposed areas in the image and brightens them up,
leaving everything else untouched.
In the Exposure > Smart Flash panel, move the Slider to
about half the scale, and press Apply. You will notice, that the
person in the image lights up as if you had used a flash on
location.

3. Remove the ski (advanced)
Now comes the fun part where you can be somewhat more
creative, much like an artist touching up a painting.
Open the Clone Brush tool, select a brush radius of about
30 and a feather of about 75, then press the SHIFT button
and click on a snowy part of the image next to the ski. Then
just paint over the ski, replacing it with snow.
You can select several different source points, in order to
make the result more realistic. If you are unsatisfied, press
the Undo button and try again. You will need some practice
with this, as the coming clone task is a little more difficult.

4. Remove the skilift (expert)

© 2013 1STEIN GmbH

78

CodedColor Photostudio - Documentation

The ski lift runs through the whole image, and you will need a
steady hand in order to remove it without a trace.
To start of, undo the zoom with the No Zoom button, and pan
to the left part of the image. Again, open the Clone Brush, but
this time select a much smaller brush radius of about 10 and
an even smaller feather. Now SHIFT+Click in the snow
above the cable, then slowly paint over the cable from left to
right.
If you need more practice, then start with the fence at the
bottom of the image, which you might also want to remove.
Once you get to the lift station behind the person, you may
also need the Eraser brush and the Retouch Blur tool, in
order to correct some mistakes and soften the borders.
Note, that the Eraser brush undoes all changes to the image,
including the exposure corrections at the beginning of the
tutorial. So you might want to save the image under a different
name prior to any cloning, in order to clear the undo memory.
Once you're done with the removeal of unwanted objects, you
might touch up some of the cloned areas showing obvious
texture redundance, again using the clone and retouch
brushes.

5. Change the weather (play god)
Finally, we come to the most dramatic improvement to the
original image, where we will replace the rainclouds with a
sunny sky.
For this, we need to find another image close to the same
size, with the sky we would have liked to have on that
overcast skiing day. Load this image in the Fill Tool texture
panel.
We then move the tolerance slider to about 15, click on the
fill bucket and then in the sky above the mountain. We will
immediately see the gray sky area filled with our source
image.
Since the sky will probably spill over the mountain, there are 3
measures we can take:
1.

decrease the tolerance slider and see an immediate
decrease in spill
2. use the eraser brush at the top of the Fill Tool to
manually remove the spill
3. use the lasso to restrict the area which will be
filled
For best results, you can combine any of these measures.
An alternative to the Fill Tool is the Paint Tool, where you
can also paint with a texture from an external source image.
This may take a little more time, but the result can be more
exact.
There you go - with a little practice, you can produce amazing postcards from your favorite images,
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even without the use of expensive tools and complicated layer techniques. Especially the Clone,
Retouch, Paint and Fill brushes in CodedColor PhotoStudio provide you with a huge palette of
professional improvement techniques. Have fun - this may become more enjoyable than painting
itsself.
Footnote: All photos were shot with a Pentax Optio digital camera with 5 million pixels. The flash and exposure modes
were set to fully automatic. No camera internal correction was applied, and the output format of the images was JPEG (not
RAW). While the autofocus rendered mostly sharp images, different color and exposure errors occurred. The digital
improvements were all done with the CodedColor PhotoStudio image editor, but were also compared to Adobe PhotoShop,
Paintshop Pro and Gimp. While these programs sometimes had more options, the results were not significantly better in
quality, but often took longer to accomplish. Picasa and IrfanView were not included in this comparison - since the few
editing tools provide even less options, they cannot be considered classic image editors.

8

Sharing Photos

8.1

Overview
CodedColor offers the following options of sharing your photos:
· EMail: send a collection of images to your friends. You can send the original files, or compress them
to a ZIP archive. You can create and send a ZIP archive with selected images on-the-fly, or add
images to a ZIP archive from any image folder.
· Web Album: upload an HTML based album to your personal webpage. This album includes
Javascript, which runs on all latest versions of IE, NS, Mozilla and Opera. You can choose among
many frame and stylesheet based layout options, and your photos or images can be organized in
folders and subfolders.
· Self-Executable-Archive: create an EXE archive of your Web Album, which extracts itsself and
opens automatically in the users web browser, when he doubleclicks on it. Note, that these archives
usually cannot be sent by email, as Outlook disallows such attachments.
· CD/DVD: burn your Web Album to CD. Make sure you check Origial Images, if you plan on
archiving your photos this way. CDs containing CodedColor Web Albums can be played on any
operating system, since they only contain standard HTML and Javascript.
· Skype: share photos "the easy way" with your Skype contacts
· Byngo: send SMS and MMS (photos) directly to your Outlook contacts
· Index Page: similar to a contact sheet, but suitable to publish on web pages, incl. links to original
images
· PDF/TIFF: export photos to multipaged PDF documents, suitable to send via email
· Flash: export photos to a standalone flash application or embedded presentation
· Photobook: use the Pixpedia Publisher (Desktop Designer), to create and print professional
photobook layouts with text elements and colorful effects. The Pixpedia Publisher is usually installed
together with CodedColor PhotoStudio.

Related topics
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· ZIP Files & Folders
· Encrypt images
· Upload Album

8.2

Album Export

8.2.1

Web Album
CodedColor allows you to create customized WEB albums from your pictures with a few mouse clicks.
The albums only require a browser capable of Javascript, such as Internet Explorer, Netscape, Mozilla
or Opera.
You can use the albums for
· Sharing - place them on your web page and give the URL to your friends
· Archiving - store them with the images on CD / DVD and show them on any computer with a
browser installed
You can customize the Web
album to your needs by
· changing text and background
colors
· hiding or showing the frames
· including/excluding
information, such as
title & annotations, EXIF and
image information.
· adding own HTML pages
· adding watermark text
· resizing the images

Create a new Web Album
Take a few minutes to create your first Web Album, by following the steps below:
· Open an Album or Catalog containing the images you want to export. If you do not want all
images, you can exclude images by unchecking them.
· Custom sort your images, if you want to override the default filename sorting.
· Select Share Images > Generate Web Album to start the Export Dialog.
Step 1: General Options
· Specify which File Information (Title and Annotations) to include into your exported Web Album
· If you want to resize the images, check Resample and set the size and quality for the resampling
operation
· Select the option Add originals, if you want to allow the viewer to open the original image in a
new browser window by clicking on the image title or filename below the image.
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· If Show thumb frame is checked in the Color and Layout tab, the thumbs will be created for all
images with the size defined in Thumb width.
· All images will be converted into the specified Image and thumb format. For Web-Browsers use
JPG, GIF, PNG.
· Check Add Watermark if you want text to be added to your images. You can also specify which
text to use, and the position of the watermark.
· You can also Include own HTML documents into the exported album. If this option is checked,
HTML files located within your source directories will be added to the exported album. Note, that
all images referenced by these documents should lie outside of the album directories, otherwise
they are included as thumbnails!
Example: if you have a directory D:\Images\2003\ with all your trips in 2003, then you might want
introductory HTML pages at the top of your trip directories. If such a document trip01.htm points
to an image D:\Images\2003\trip01\sunrise.jpg, then this image will be displayed as part
of the album in the thumb filmstrip. If you only want to display this image in the introductory HTML
document, then you could change the link to <img src="..\..\Outside\sunrise.jpg"> and
move the image outside of the album directory structure to D:\Images\Outside\.
· Set Autoplay Seconds to a value other than 0, and the images are automatically transitioned
when the album is opened. You can also add ?autorun=xx to the album url to produce the same
effect.
· Set Start with Image# to a value other than 0, if you want to skip the intro screen and display
directly a designated image of the album. You can also add ?ImageID=xx to the album url to
produce the same effect.
· If you check Include Startpage, then you might want to check and edit the album information by
pressing Edit Album Info.
Step 2: Color and Layout
· Select any of the predefined Style Templates. You can also download templates from the internet
by selecting <search online..> or use *.cctmpl files from other CodedColor users by selecting
<search local..>.
· Adjust text and background colors of your liking
· Add or change images for your background. If you are using a background image you should
adjust the background color correspondingly.
· Specify which frames to include
· Select Save Options if you want to use your settings for future albums or share them with other
CodedColor users.
· Save as Default
Stores all of your settings as default for new web-albums. The selected template is also
updated.
· Save to Template
Updates the selected Template with your current settings. If you also want to store your
general settings such as thumbsize, image compression size use Save as Default above.
· Create Template
Uses your current settings to create a new Template or update an existing *.cctmpl file. The
template file youtemplatename.cctmpl will be stored in your Album Export -> _TEMPLATES
folder and can be used to pass your template to other CodedColor users. Mail it to
webtemplate@codedcolor.com if you want to include it into the template list for download.
· If you select Reset Options, you can discard your changes and revert to your previous settings.
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Step 3: Start Export
· Select the Output directory for you Web Album, and the name for your index page.
· Check and change the Export Options
· When you press Start Export, the HTML pages will be created in the directory specified for the
index page. You can transfer this directory (including the subdirectories!) to your web space or
burn it on a CD. It contains all required information for the Web Album.
Note: Don't upload from the location of your original images!
· If you want to create a single album file, select Create Album to Archive. A self extractable
archive allows anyone to view your album without having CodedColor installed.
· You can send the created single file archive via email. When the attachment is opened, the album
will be automatically extracted and opened in the browser. Note however, that many email clients
and POP servers don't allow EXE files as attachments. To overcome this, select a compression
format other than EXE. If your album is saved as a CCA (CodedColor Archive) or ZIP archive, it
can be easily imported in CodedColor. The CCA format requires the recipient of the email to have
CodedColor installed.
Step 4: Upload Album
· See the FTP upload

Example Templates
For a larger selection of templates, please visit http://www.codedcolor.com/cctmpl/. We're always
happy to add good templates to our collection, so feel free to send us your favorite templates along
with an example album link.
CC Classic1
To the left you see a CodedColor template consisting of XP style
navigation buttons and marble background images in different
shades for the different frames.
Hint: Always try to select a background color for the scrollbars,
which is similar to the color of the background image.

Hint
· To start the slideshow automatically, add the parameter autorun=x to the URL, where x is the
delay in seconds.
Example: http://albums.codedcolor.com/Snapshots/index.htm?autorun=6
· To open the album in full screen mode, add the parameter fullscreen=1 to the URL
Example: http://albums.codedcolor.com/Snapshots/index.htm?fullscreen=1
· To open the album with a particular image loaded, add the parameter ImageID=x, where x ist the
image at position x to be loaded.
Example: http://albums.codedcolor.com/Snapshots/index.htm?ImageID=4 would
open the fourth image
· You can combine parameters ie. fullscreen and ImageID
Example:
http://albums.codedcolor.com/Snapshots/index.htm?ImageID=3&fullscreen=1
would open the third image in full screen mode. Currently you cannot combine fullscreen and
autorun.
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Related topics
·
·
·
·
·
·
·

8.2.2

HTML Indexpage
Flash Album
Custom sorting
Mail Files
Export Multipage Documents (PDF, TIF)
Album Upload
Archive Pictures on CD/DVD

Flash Album
The Flash Album is very similar to the Web Album, but it has a few less options and no template files.
A disadvantage is however, that not every browser or corporate network allows Flash.
More differences:
· While the Web Album mirrors Subfolders from the file system, the Flash Album generates
subfolders into one sequential image list. However, you can enable Add gallery to existing flash
project and thus combine several galleries (albums, catalogs, folders) in one Flash application.
· The Web Album uses filename sorting. You can call Custom sorting in the Explorer to manually
change the sequence of the images. In the Flash Album, you can alternatively sort the images
through drag & drop in the initial Selection Wizard by activating Custom Images.
· In Flash Albums you can display the following movie types: FLV, MOV, AVI, MPEG, ASF,
WMV. All movies are converted to the flash format FLV (MPEG-4, H.264 Standard), which is a very
kompressed and stable format for web applications. Please note, that CodedColor can currently
not display FLV movies, except in your exported Flash Album. To view FLV movies on your PC,
we recommend the VLC Mediaplayer.
· Flash Albums can play a background music file.

Create a Flash Album
Step 1: General Options
This step is mostly identical to the Web Album
Step 2: Colors and Layout
Experiment with the color and layout settings, and activate the option Quick export, which only
generates 3 images at a time.
After export, you may want to locate the file STYLE.CSS in the output folder and edit it in a text
editor. You need some knowledge in the style language for this. You can modify the fonts (fontsize) and the transparency (background-alpha) of the panels. Since the style language has
several more attributes, these options were omitted in the export dialog.
Step 3: Start Export
This step is mostly identical to the Web Album
Step 4: Upload Album
See FTP upload

Add another Gallery to a Flash Album
To add images to an existing flash album,
© 2013 1STEIN GmbH

84

CodedColor Photostudio - Documentation

1.
2.

Click Add gallery to existing flash project
Open the folder of your existing flash project

You can add as many galleries to an exiting project as you like, however, you current dialog settings
will always overwrite the existing project settings.
After export, you need to add the following files/folders to your existing online album:
· CONFIG.XML, GALLERIES.XML and STYLE.CSS from the DATA subfolder
· The complete subfolder of the added gallery, containing the subfolders IMAGES, ORIG and
THUMBS. It is located right below the project main folder.

More information
CodedColor uses FFmpeg to convert movies. What to do, if FFmepg is not found on my system.

Related topics
·
·
·
·
·
·
·
·

8.2.3

Web Album
HTML Indexpage
Multipage Documents (PDF, TIF)
Albums and Catalogs
Custom sorting
Title and Annotations
Mail Files
Album Upload

HTML Indexpage
The HTML indexpage corresponds in layout and options to the Contactsheet, except that it's purpose
is merely online viewing. The Contactsheet is used for printing, and can contain page numbers,
headers and footers. HTML indexpages, just like Web Albums, are stored in the
<Workdirectory>\Organizer\Album Export location.
From the Explorer window, choose Share > HTML Indexpage for the current file selection or the whole
folder.
Follow the options described in the Print Contactsheet topic. On top of that you can enable the option
Filepath (with link to original image) to open the full sized image in a new browser window.

Related topics
· Web Album
· Print Contactsheet
· Title and Annotations

8.2.4

Multipage Documents (PDF, TIF)
When sharing images with friend and relatives, you always have to worrry about the software they
need in order to look at your photos. JPG is a common format, which can be viewed on any PC.
However, mailing single images does not allow you to sort the photos into a certain order or to
annotate them. The intuituve Multipage Export Dialog of CodedColor overcomes these limitations,
and allows you to compress your photos into a PDF and add borders (shadows) at the same time.
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Another common use is to combine several scanned document pages into a single TIFF file.
The Multipage Export dialog has the following options:
Page Size: The page size has 2 major settings: Adjust to image size and Userdefined. The other
page sizes like A4 or Letter are only listed for historic reasons, when the Acrobat Reader did not
have a print option to adjust the pages to the paper size. Now, if the image is larger than the paper
size, you can simply choose Adjust to print margin in the Acrobat print dialog, in order to fit large
image pages to the current paper size.
You should choose Adjust to image size, if the print quality is most important. Then the images are
not resized, and the size of the PDF document is the sum of its images. You should choose
Userdefined and Downsize images to reduce filesize, if you want to keep the filesize at a
minimum, and if the document is mainly used to view the images.
Whatever the Width and Height of the page size, the images are always displayed with correct
aspect ratio. If you intend to mail the PDF, then values around 1024x768 are sufficient for most
computer screens, while still keeping the filesize small.
Add Pages: when you first open the dialog, you already see those photos in the thumbs list, that
were selected in the CodedColor Explorer beforehand. You can add more photos from the file
system, and reorder them by dragging the thumbs. Delete pages by pressing DEL.
Image Annotation: Each image page can have a centered title at the top or bottom of the image. If
you choose Above or Below, then you have to define a Background color as well.
Add Shadow: By pressing the little button to the left of the shadow option, you can define the
shadow width, color and offset.
The Create Document button allows you to choose one of the filetypes PDF, TIFF or PS
(Postscript).

Example of an image collection that was
exported to PDF and opened in the
Adobe Acrobat Reader. You can
browse and print the images (pages) just
like in the thumbsview of CodedColor.

Related topics
· Mail Images
· Web Album
· TWAIN Capture
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Album Upload
Automatic album upload per FTP is directly supported inside CodedColor. The upload utility uses a
synchronize strategy, so you can easily upload small changes in little time.
Enter a Work Directory of the form /photos/2004/sailing. The path is automatically created
for you in the FTP home location.
The Checksum (synchronize) option allows you to upload only changed or new files, and thus speed
up the transfer considerably. This is very helpful if you only want to change small details in the layout
or colors of the album and the exported images are not affected. You can also cancel an upload and
continue later.
To create an Album Archive, see Step3 of the Web Export topic. An album archive can be easily
downloaded and extracted by the viewer.
The View FTP Directory button opens the Internet Explorer in the designated FTP directory. Note,
that for this option you should have at least Windows 2000 or XP installed. Use this button if you
want to delete an album later, or just browse your FTP directory.
When you press Mail Invitation to Friends, the same URL you tested in Preview in Browser is
sent via eMail. (You need to have MAPI installed on your system, i.e. Outlook or Outlook Express.)
To change the URL, you can press the little Edit button. In most cases, the Viewing URL is different
from the Upload URL.
Example:
Upload location:
ftp://ftp.mydomain.de/photos/2004/sailing/
View album
URL:
http://www.mydomain.de/private/photos/2004/sailing/index.htm
Manual Upload with other tools
To manually upload an exported album outside of CodedColor, you need to install an FTP client like
WS_FTP, or use the integrated FTP features of the Windows Explorer (> version 6). Make sure, that
you transfer all files in and below the export destination. This directory is usually found in the
CodedColor Work Directory under Organizer\Album Export\<My Album>. Manually create
folders like Fotos\<My Album> in your FTP area, before you start uploading the files.
Note, that if you change the images of an album (add, delete, edit), you must manually upload the
whole album including all images, thumbs and HTML files again. If you only want to change the
appearance of the album, make sure to enable the option Step3 > Quick Export (color settings).
Then you can omit the subdirectories images, orig, thumbs and pics during upload. (This
optimization is done automatically for you when using the Auto-FTP feature of CodedColor described
above!)

Important !!
· If you are using a firewall, make sure the FTP port# is opened in the firewall. Even the Windows
Firewall of VISTA does not automatically authorize an application for FTP. You may have to
explicitly enable CodedColor in your Windows Firewall Settings.
· If your FTP server is using SSL, turn off command filtering in the firewall.
· Remember that most FTP servers are case sensitive, i.e. /Photos and /photos are actually 2
different subdirectories!

Related topics
· Web Album
· Flash Album
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Album Download
Album download is not yet directly supported inside CodedColor. The following features will be
available in the future:
· Automatic download of Public Albums, or albums to which you have an invitation from other
CodedColor users.
· Download of albums submitted for photo contests, including photo rating.
· Download and rate best shots from all over the world, and include them in your CodedColor
Community Screensaver.
Public Albums
From time to time we publish interesting albums on our webpage, and provide you with links to these
albums. If you have created such an album, please mail us the URL including a short description as
demonstrated below, and we will consider letting other CodedColor users become aware of your
album. This will certainly increase traffic to your webpage.
[CC\Organizer\Online Albums\Travel\Diving]
URL=http://albums.codedcolor.com/CaboVerde
Author=Henning Kuersten
eMail=xxxxxx@web.de
Homepage=http://www.1stein.de
Information=This album was shot with a Casio QV-200UX digital camera.
Some images are from a Kodak underwater camera.
Title=Cabo Verde treasure dive
Description=In 2000 the company Arqueonautas Worldwide discovered the
famous "Hartwell" on a reef in the middle of the Capverdian archipel. The
author accompanied the "Polar" for two weeks on a journey into history.
These fotos document the discovery and restauration of valuable
artefacts, and give insight into the beautiful island of Santiago.
To view all current public albums, connect to the internet and select the menuitem Share > Public
Albums. A list of album descriptions will be downloaded to your computer, and the corresponding links
(album URLs) will be created in the Organizer\OnlineAlbums folder, where a doubleclick opens
the public album in your browser.
Online Albums
To view albums of other CodedColor users, we advise searching for the album in Google.
Example: http://www.google.com/search?q=codedcolor

Related topics
· Web Album

8.5

Mail Images
CodedColor provides you with an easy way to send emails with picture attachments. The attached
images can be compressed or zipped, and watermarks can be added. You can even store images with
title annotations inside a small PDF attachment. This single file attachment can be viewed with the
widely installed Adobe Acrobat Reader.
Create a mail with images or ZIP attachment:
· Select the picture(s) you wish to attach to the e-mail.
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· Call Share > Mail Files or the Mail Files shortcut button.
· If Resample is unchecked, the original files are attached, otherwise all images are resized
according to your pixel setting, to allow for smaller email messages. If you are mailing JPEGs at a
smaller size, you can also decrease the quality to reduce the email size even more.
· Add Watermarks to you pictures by activating the checkbox. You can, for instance, add your
image titles from the database, or display Copyright information.
· Select Test filesize, if you first want to check the size of your mail.
· Select Create Attachments to create and preview the attachments. The Organizer will be
opened, and you can look at the (compressed) images and watermarks.
· Select OK to open your existing email application, such as Outlook or Outlook Express, including
the (converted) files as attachments.
· You can now enter the email body and recipients, and then send the message.
Create a mail with a PDF attachment containing the images:
· Select Multipage Document (PDF, TIF) as the attachment file format
· Press the Create Mail with Attachment button.
· Create the pages of the PDF attachment. See Export Multipage Documents (PDF, TIF) for more
information.
· Make sure you select the Userdefined paper size and enable the option Downsize images to
reduce filesize. If you enter width and height parameters between 800x600 and 1024x768, the
resulting PDF attachment may be much smaller than the original photos.
· Choose PDF as the output format, when creating (saving) the document.
· Close the export dialog. A mail with the PDF attachment will be prepared. You can now enter the
email body and recipients, and then send the message.

Hints
· Activate Encrypt images, to render the attached images invisible. This merges the pixels in a
way, that they can only be fully restored via Password. The receiver must call Decrypt Images
in the Batch Processing menu of the CodedColor Explorer.
· Test the filesize. If you are sending email messages of > 2 MB, you should ask your recipient first.
You should also consider the download time, when mailing images to recipients with slow internet
connections.
· You can split large email messages into multiple messages.
· Upload a Web Album instead, if you have more images or want to include your
image annotations.
· Compress the images to a ZIP or EXE archive. The ZIP archive can be automatically extracted by
a CodedColor user, by simply dropping it into the CodedColor\Inbox directory, or by
doubleclicking on the file.
· The EXE archive is not very common for emails, as most mail clients disallow executable files as
attachments, due to virus danger. Therefore, an extra extension .ccsfx is added to the
selfextractable archive, which the recipient of the attachment must remove first. Example:
archive.exe.ccsfx. Simply rename the album to archive.exe and doubleclick it. A folder
Archive below the executable file will be created, into which the images are extracted.

Related topics
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Web Album
Watermarks
ZIP Files & Folders
Export Multipage Documents (PDF, TIF)

Send images with Skype
CodedColor allows you to share images on-the-fly with over 5 million Skype users worldwide. Not only
can you exchange your favourite photos with your friends and family, you can get in contact with other
photographers and discuss your snapshots or photo locations in the chat window or during a free voice
conversation.
There are 3 locations in CodedColor, from where you can send an image to a Skype user:
1.
2.
3.

in the Explorer
in the Screenshow (Fullscreen)
in the Image Editor

The Skye dialog allows you to compress (resize) an image, in order to save bandwidth, and to add a
watermark title to the image. The compression is useful for slow connections over intermediate relay
servers, which occur when one of the users is behind a firewall. Also, Skype reserves most bandwidth
for phone conversations, so file transfer can be slow.
Another very useful feature of the Skype dialog is the intuitive crop feature. By zooming and panning
(moving) the image, you can crop away unwanted parts. Make sure to also enable compression,
when you select only a very small area of the photo, so that the image can be blown up to the desired
width.
Shared images are stored in the Organizer Conversions folder, if you compressed, cropped or
watermarked the image. Original images are not cached in this folder but sent directly.

More information
Skype is free and can be downloaded from http://www.skype.com

9

Tools

9.1

Screen Capture
CodedColor has one of the most versatile screen capture features on the market. Not only can you
capture distinct regions and objects, but your captured bitmaps can be automatically resized,
converted to any image filetype and stored in designated folders. This greatly simplifies the task of
creating software documentations or collecting images for web publishing.
Basically there is only one thing to rember when using the screen capture component: the application
in which you want to capture bitmaps must be opened and active prior to CodedColor. That means for
example, if you want to capture a region of an image in the Internet Explorer, first activate the Internet
Explorer, then activate CodedColor and press CTRL+SHIFT+S to open the capture dialog.
Now select Source and Destination and then press CTRL+SHIFT+S again. If you selected Area as
the source, then you must now draw a frame around the region of the screen you would like to capture.
If you disable the checkbox Capture outside of application, you can capture a region, object or
window inside of CodedColor. This can come in handy, if you want to send us a screenshot along with
a problem report.
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Related topics
· TWAIN Capture
· Video Capture

9.2

TWAIN Capture
A common source of images is an external device, such as a scanner or digital camera. Most
manufacturers provide a TWAIN interface to transfer images from the device to the application.
With CodedColor, you can use this interface for importing images in one of three ways:
· Single page
Use this option, if you want to import/scan one image and open it directly in the Editor window.
· Multiple pages
If you have several scans to do and want to save some time.
· Multiple pages to TIFF
Use this option, if you want to create a multipage image (TIFF or GIF file) from multiple input
sources or documents.
To acquire further frames after the first document page is scanned, click on TWAIN: Add Frame
in the toolbar of the Image Editor.
· Multiple camera files to disk
Use this option if you want to acquire multiple images, each into a seperate file. Recommended for
digital cameras.
With this option you can also set the Output format and folder. If you choose JPG as your
destination format, set a compression of about 96 (More options) to achive the best compromise
between filesize and quality.
To import images from your device, follow these steps:
1.

Connect your scanner or camera to your computer and turn it on.

2.

Call File > TWAIN Image Capture.

3.

If you do not see your device in the Select device dropdown list, first check all cable
connections to your device. If you have an SCSI device, then most likely Windows has not yet
detected that you turned it on. To force this, click on Detect SCSI Device, activate the
Hardware tab and start the Device manager. Select SCSI Controllers, and select Search for
changed hardware from the right mouse menu. You may need to restart the TWAIN capture
dialog of CodedColor after this.

4.

Enable the checkbox Device dialog visible, to open the user interface of the TWAIN driver.

5.

Disable buffered transfer, if you experience problems acquiring the image.

6.

For Single and Multiple pages, you can rotate or resize the acquired bitmap in the image editor,
choose Save As and store the image in the desired format. For text documents or graphs, you
should use the GIF format. An image with multiple frames (pages) must be saved as TIFF. For
single photos, JPEG usually produces the best result (size vs. quality)

Important
· If your TWAIN input device is a digital camera, you most likely have access to your photos via
drive letter in the Windows Explorer or through a memory card reader. You should then always
copy the files manually to your local hard drive. An external software like CodedColor, which uses
the TWAIN driver of the camera to import the files, will always transfer your photos as bitmaps,
which would naturally result in a loss of all EXIF/IPTC information.
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· After you store the files to disk, you can do further batch processing, like SmartFix,
Noise Removal and Rotation. Only do left/right rotations on the stored JPG files, because then the
rotation will be lossless and you won't produce artefacts.

Related topics
· Screen capture
· Export Multipage Documents (PDF, TIF)

9.3

Video Capture
If you have a Video or TV card in your computer, you can use that to capture images in Codedcolor.
You can capture single images or arrange them in a collage.
After opening the Video & TV Capture dialogue, you need to configure your video device.
1.

Select your Input Device from the List.

2.

If your Input Device has several inputs such as Composite or SVideo click Input Source.

3.

Click Video Format to configure the format of the images that you want to capture

4.

Click Video Settings to configure the video settings of your capture card.

5.

Click Tuner if you need to select a tuner channel for a TV device.

In Single mode click Capture Frame to capture a single frame into the image editor.
Using Multiple mode you can capture a set of images and arrange them into a collection. Click
Capture Frame to capture a frame into the thumbnails view at the top. You can change the
Brightness, Contrast & Colors of either captured frames (Apply to left), or of the source itsself
(Apply to right).
You can add watermarks to each of the captured images using the Apply Watermark button. If you
select Timestamp in one of the 2 available lines of the watermark dialog, the exact creation time is
added to the selected frame. If you selected several frames at once, then timestamps are added to all
selected frames.
When you're done, click Create Collage to create a collage according to the settings in the Layout
section.

Additional Hints
· Select Antialias to apply an antialias effect on zoomed images. Zoomed images will look nicer,
but it might also reduce the frame rate of the live video stream.
· If you are asked for the video standard, select NTSC for USA and PAL for Europe (except
France).

9.4

Panorama Stitch
The Panorama Stitch dialog allows you to glue together adjacent photos, in order to create horizontal
or vertical panoramas. Panoramas can be created with any digital camera by shooting a series of
photos that all have a small overlapping border.
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To start stitching a panorama from your photos, select the corresponding frames in the Explorer, and
open the stitch dialog. You can then add more frames, or change the order of frames with the Reverse
Order button or by Drag & Drop.
Even though CodedColor has an ingenious algorithm for stitching panoramas with almost no user
interaction needed, the dialog has number of useful options for fine tuning:
Maximum overlap area: see the following example
To the left you see 2 frames that were not stiched correctly,
because there are several possible stitch lines.
If you reduce the maximum overlap area from 60% to 40% for
instance, you may exclude the faulty stitch line. To find the
optimal value sometimes requires trial and error.

Downsize frames
Panoramas can become very large, and the stitching can consume a huge amount of resources. For
instance, if you have 10 frames from a 5 Million pixel camera, then the resulting panorama can have
a filesize of up to 150 MB (= 5 Million Pixels x 3 Bytes x 10 frames), depending on the JPEG
compression when storing the panorama. This is usually no problem, however, the stitching can take
up to 3 times the amount of memory, that is 450 MB. If your PC only has 500 MB memory, then a lot
of virtual memory will be needed, slowing down the process of stitching or even crashing your PC.
Usually, you don't need a resulting panorama of this size, so a Max. Height of 800 pixels is a good
start to experiment with stitching, and to view the resulting panorama in the Panorama Viewer.
Careful: Don't enter values below 200. Naturally, you'll always get the best stitch lines with
maximum frame resolution. (also see "Important" below).
Equalize Exposure and Color
Due to the rotation of the camera, the frames in a panorama sequence were frequently shot in
different light situations. In the following example, the first two frames of the panorama were taken
against the light and are therefore too dark (underexposed). This will cause a bad stitch area with
the bordering third frame.
In order to correct the overexposure and improve the stitching, all frames should be manually
equalized to the same Gamma (brightness) and Color Saturation. This is best accomplished by first
dragging the slider beneath the thumbs, so the corresponding thumbs are reduced in size and
become visible at the same time. Next you can equalize the Gamma of the first two frames. Since
an increase in brightness also washes out color, you can then increase Saturation to overcome this
problem.
If frames differ only slightly in color and brightness, it may be more efficient to use AutoColor and
AutoExposure instead. If all frames are already similar, you may only want to increase the number
of matching points in shadow areas by means of SmartFlash.
Note: Image improvements are usually non-destructive in CodedColor, except AutoRotation. This
option may remove some image details (sharpness), apart from the fact that it might not work at all.
Better results can be achieved by aligning the frames in the image editor rotation prior to the
panorama dialog. Leveling the horizon in tilted frames usually leads to a noticeable improvement in
stiching quality.
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After

Flatten
Since the frames of the panorama were never taken in a perfectly horizontal manner (unless you
used a tripod), the stitch line detection causes the panorama to warp. This is a problem of all
Panorama Stitch utilities, resulting in "snakelike" panoramas. CodedColor has an ingenious flatten
algorithm in order to overcome any disaligment. The downside is, that some frames may become
slightly distorted themselves.
Read the chapter about Parallax, to learn how to reduce warp effects in the first place. You can
also align the frames in the rotation dialog of the image editor.
Crop
Only use this option with Flatten above. This hides the problem, that some frames may have an
unwanted vertical displacement, which the Flatten algorithm cannot correct. Crop cuts off
overhanging borders resulting from any vertical displacement. Usually, a value of 5% is good
enough, if you had a steady hand while moving the camera during the panorama sequence. For best
results of course, you should use a tripod.
Fade Area
Select Large as a default, and only reduce the value, if the stitch line causes intense blurring of the
affected image area.
Background Color
Used to fill in areas resulting from frame disalignment. Dark colors like Gray or Black usually
blend in best with the frames.
To finish stitching, you can Save the panorama to a file right away, or Open it in the Image Editor for
further manipulation, like additional cropping. Saving will allow you to immediately look at it in the
Panorama Viewer.

Important Tips
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· The more you reduce Max. Height, the more detail is removed from the frames before stitching.
Since this detail is needed for determining the ideal stitch line between two frames, it is always
better to create the panorama first (provided you have enough resources), and then resize it later
in the Image Editor.
· Turn off the Crop option, if you prefer to manually crop the resulting panorama in the
Image Editor.
· If two frames have a poor match quality, while the other frames match good or excellent, you
can experiment with Exposure, Color and Overlap. If you cannot achieve a better match quality,
you may try to exclude outer frames or split the panorama into two frame sections. Also watch out
for identical focal lengths when shooting the frames: wideangle and fisheye frames don't match!
You may want to zoom single frames in the image editor, so that important overlapping elements,
like buildings or trees, have similar sizes.
· More tips for shooting panoramas

Related topics
· Panorama Viewer
· The Parallax effect
· Gamma correction

9.5

Geo Tagging (GPS)
GPS coordinates are stored in the EXIF data section of an image, so they are limited to certain
filetypes like JPG. You can add location coordinates to several images at once. Select the images in
the Explorer and call Tools > Geo Tagging. You can then assign coordinates manually or through
GPX files. GPX track files are collections of GPS coordinates + timestamp sets, recorded at
continuous intervals by a GPS tracking unit (logger).

Assign coordinates manually
· Select the images you want to tag in the left hand image list
· Select Synchronize to copy the photo timestamp into the UTC track time, otherwise the current
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time is used
Enter a location in the search field, select the result row and press RETURN
To adjust the default location, scroll the map with the left mouse button (drag & drop)
Click onto a new position in the map and press Apply Coordinates
Press Save to close the dialog and write the new GPS data to the EXIF fields of the image(s)

Assign a GPX track file to the images
· Select the images you want to tag in the left hand column, or by means of the Image Selection
dropdown
· Select Synchronize, if you want to copy the photo timestamp into the UTC track time, i.e. override
the logger clock with the camera clock, when you Save the images
· Set the Time Zone of your GPX track file, i.e. where you recorded the track
· Set the Tolerance to 1-2 hours to compensate daylight saving time or asynchronous
logger/camera clocks. This way, the track records can be paired with the corresponding images,
even if the camera and logger clocks are not fully synchronized.
· Load the GPX file to pair the tracks with the images
· Press Save to close the dialog and write the new GPS data to the EXIF fields of the image(s)

More options
· If you opened only a single image in the map dialog, or if the image already has GPS data and you
called the Show on Map context menu, you can press Create Collage to load the image into the
Image Editor and automatically place a map layer on top of it. You can also call this feature
directly from the editor.
· In the dialog, you can capture a map by pressing the Camera button at the bottom right of the
map panel. You can also call Tools > Map Capture in the Explorer for a shortcut.
· If an image already has GPS data, you will see a flag icon on the thumb. Clicking this flag will
open the GPS dialog and load the map.

Related topics
· Read more about GPX / GPS on Wiki

9.6

Compare Images
This feature enables you to:
·
·
·
·
·

Synchonously zoom/unzoom two images
Compare two images pixel by pixel using a grid
Compare EXIF/IPTC information
Show the grayscale difference between two images
Compare to other images in the same folder

Usage example:
· Select the first of the two images in the Explorer
· Call Compare Image to...
· Select the second image from the file dialog
· Click on Show Grid
· Zoom into one of the images and scroll (pan) the current view
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· Optional: continue the comparison with another image from the thumbs panel above
· Click Close Comparison to restore the desktop

Hints
· To easily compare edited images with the original, you should enable the Backup into subfolder
option in the Image Options.
· Never edit images without a backup, if you are not sure about your monitor settings, or if you are
working in a very dark or very bright environment. If in doubt, regularly apply a monitor calibration
tool.
· Also see: Search Similar Images

9.7

Search Similar Images
The search for similar images is one of the most difficult tasks in digital photography. CodedColor
combines a number of different algorithms, in order to detect similar images. However, the word
"similar" needs to be defined. It's a wide misunderstanding, that the search for a "cow on a pasture"
should only find images with "cows on pastures". In fingerprint recognition this is possible, but not in
photos containing a number of overlapped objects from different views, in multiple lighting conditions,
and with different sizes and colors. There is basically no way to reliably distinguish a cow from a horse,
a pasture from a golf course or a golf cart from a baby carriage. So in our cow example, you may also
find images of a "cactus patch in the desert" and a "sailboat on a lake".
CodedColor relies on a number of mathematical comparisons (histogram, color average) and pattern
recognitions (grayscale analysis, texture & color map) to find images with similar color
compositions, lighting conditions and textures. CodedColor is not capable of object recognition, so try
to interpret your results more in the sense of "similar moods". The example below is taken from a
folder of vacation photos with different locations and lighting situations. As you can see, candidates 1 &
2 are pretty good matches, whereas candidate 3 can be considered a failure, and it is not clear at first
why candidate 4 has a much lower score.
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1. Score 89.77%

2. Score 88.11%

Grayscale: 88.99%
Histogram: 94.14%
Dimensions: 100.00%
Texture Map: 81.85%
Color Map: 90.34%
Color Average: 93.62%

Grayscale: 81.01%
Histogram: 93.57%
Dimensions: 99.00%
Texture Map: 76.77%
Color Map: 90.71%
Color Average: 88.80%

3. Score 87.06%

4. Score 84.14%

Grayscale: 83.14%
Histogram: 93.33%
Dimensions: 99.37%
Texture Map: 78.90%
Color Map: 89.06%
Color Average: 76.69%

Grayscale: 79.70%
Histogram: 93.52%
Dimensions: 99.32%
Texture Map: 66.49%
Color Map: 86.93%
Color Average: 87.89%

Examining the scores, the result becomes a little more obvious: candidate 3 scored better than
candidate 4, because candidate 4 has most of it's dark areas where the seach subject has light areas,
and vice versa. The two images are thus pooly matched in their pixel regions, but coincide well in their
color average, which - however - has a much lower priority. CodedColor weighs the algorithms quite
differently, resulting from elaborate tests on many different images. Here is the optimal distribution we
decided on:
Grayscale difference

0.10%

Histogram difference

0.05%

Dimension & aspect ratio

0.05%

Grayscale texture mapping

0.15%

Pixel color region mapping

0.60%

Dominant & average color

0.05%

Related topics
· Search Database
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· Compare Images
· Histogram

9.8

Backup & Restore Database
Features of CodedColor that ensure database integrity
1. Automatic broken link detection and correction.
2. Automatic saving of changes
3. Automatic datafile backups and restoration
4. Manual database backups and restoration
5. Clear Thumb Cache
6. Cleanup database
The backup options in detail:
2. Automatic saving of changes
In the Program Settings > Database tab you can define the Autosave interval in minutes, in which
changes to the database are automatically written to the disk. If you are planning on adding many
keywords and annotations to your images in a single session, then we advise you to turn this setting
on. As an alternative, you can also press Save Database Now in the annotation dialog, while you are
adding descriptions to your images.
3. Automatic datafile backups and restoration
In the Program Settings > Database tab you can enable Automatic datafile backups. Whenever you
terminate CodedColor, a backup of the last correct database file is made in the
Workdirectory\Backup folder, BEFORE the current changes are written to the disk. If anything
goes wrong during shutdown of CodedColor, your database file could become corrupted. Thus, when
you start CodedColor the next time and the database cannot be loaded for some reason, the last
automatically backed file is used. (This feature is similar to the Windows backup of the registry.)
4. Manual database backups and restoration
In regular (monthly) intervals - depending on your database usage - you should call the menuitem
Backup database. All database relevant files from Workdirectory\Data are then copied to a
folder beneath Workdirectory\Backup. This includes the database definition files and image editor
settings, which are stored in binary files. If you later experience database corruption or data loss, you
can restore these files. Note however, that calling the Restore function looses all changes of the
current CodedColor session.
5. Clear Thumb Cache
Calling this function in the Program Settings > Database tab removes all thumbs from the thumb
database. You may need to do this, if your image database and the thumb cache become
asynchronous, for instance after calling Restore Database. Deleting all thumbs has no effekt on
CodedColor or your image archives, other than temporarily slowing down the explorer, since all thumbs
now have to be recreated when browsing the image folders.

Important
· You should do manual backups at least once a month, or after you have added many annotations
(title, description and keywords) to your images.
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· You should set the Automatic datafile backup option, if you regularly add annotations and
keywords to your images. You can also call Save database now, after adding many annotations.
· Your images are never backed, only the corresponding database records. To backup your images,
you should burn CDs of finished collections, for instance of all images taken in a certain year.
· If you have checked the Automatic datafile backup option in the Program Settings, and you are
experiencing a database problem while running CodedColor, try restarting Windows and
CodedColor BEFORE calling the Restore Database menuitem. The manual restore facility only
restores your last manual backup, whereas the autobackup option uses the database file from your
last successful CodedColor shutdown.

Related topics
·
·
·
·
·
·
·

9.9

Database tab
Why does the program stay active in the tray?
How stable is the database?
Is the database compatible with other programs?
Can I view the contents of the database?
Are my images stored in the database?
Database definition

Export Database
To export the CodedColor database into plaintext (readable) XML format, go through the following
steps:
1. Select Tools > Database > Export Database
2. Change the file extension of .BIN to .XML and press Open
3. Browse to the export directory Workdirectory\Backup and double click on the file
FILES.XML
4. The file should be opened in the Internet Explorer. Depending on the size, this may take some
time. If the file is not displayed, try opening it in a simple ASCII text editor.

Related topics
· Database definition
· Glossary: XML

9.10

Database Maintenance
Cleanup database
The CodedColor database consists of a set of files found in the Workdirectory\Data folder. The
only maintenance that should be applied to the database is the menuitem Cleanup database. This
feature is NOT a binary compression like that of Microsoft Access, but rather a removal option for
obsolete image records and broken links. The function removes only those records, that hold no
relevant user information and don't seem to belong to any physical image file on your harddrives, thus
compressing the database and speeding up CodedColor in general.
The following 3 cleanup modes are provided:
Conservative Scan (default)
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Only remove broken links with no relevant information or thumbnail. Orphaned records with
thumbs or annotations are kept in the database for reference or later correction.
Typical Scan
Remove broken links on connected drives. Orphaned records on disconnected drives or
unmounted CDs are only kept in the database for reference, if they have an associated thumb.
Deep Scan
Remove broken links on connected/disconnected drives or unmounted CDs. If you later remount a
drive or CD, then the records and thumbs will be added again to the database.
Note: The conservative and typical scans keep those broken links in the database, that have a certain
probability of being automatically corrected by CodedColor at a later time, i.e. if they are pointing to
temporarily disconnected drives or unmounted CDs. So doing regular cleanups in either case does not
lead to any information loss. But even the deep scan is not really dangerous, as all EXIF/IPTC image
descriptions are stored in the image files as well.
Enable Update Creation time from EXIF data, if you want to overwrite empty OrgDate values in the
database with the corresponding EXIF image creation date. This is recommended if you intend to use
the Timeline feature. This feature depends on the OrgDate (original creation date) field.

Related topics
· Backup database
· How do you handle broken links?
· What's the difference between file date and photo date?

9.11

Additional Tools
More information on the following tools can be found on the internet:
Byngo Mobile Messenger (send Photo SMS to Outlook contacts)
Pixpedia Publisher (DTP photo layouter)
CodedColor Toolbox, see local topic1 and local topic2
Panorama Viewer, see local topic
Photo Skype, see local topic
All tools are included in CodedColor PhotoStudio Pro.

10

FAQ

10.1

What's the difference between file date and photo date?
The following topic tries to throw some light on the general confusion of date values (The EXIF
strategists added to the chaos by creating even more confusing names).
The following date values are used in Windows (1-2), CodedColor (1-7) and in the EXIF standard (5-7):
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Location

Name

Synonyms

Description

Notes

Explorer: File Properties

Created

CreationDate

Storage of
image file on
disk

= date in
Windows
Explorer

Explorer: File Properties

Modified

ModificationDate,
FileDate

Last change of
image file in
image editor

= date in
Windows
Explorer

Explorer: Database Panel CreationDate

OrgDate (database)

File storage or
time of photo

=
DateTime
Photo

Explorer: Info Panel

Filedate

ModificationDate

Last change of
image file in
image editor

= Modified

Explorer: EXIF Panel

DateTimeFile

$132, DateTime

Storage of
image file on
camera chip

editable in
annotation
EXIF
editor

Explorer: EXIF Panel

DateTimePhoto

$9003,
DateTimeOriginal

The time, the
picture was
taken with the
camera

editable
if empty,
CreationD
ate is
copied

Explorer: EXIF Panel

DateTimeDigitized

$9004

Digital
conversion of
the photo by the
camera

editable in
annotation
EXIF
editor

CodedColor improvement
Since the CreationDate in Windows is actually the birthdate of the file on the disk, and not the time
when the picture was taken, CodedColor replaces it with the EXIF DateTimePhoto. This is done when
the user first edits the image annotations.
So from that moment on, you see the actual shooting time of the picture, and not the time the file was
created on the disk, i.e. moved from your camera storage to your PC.
This fix can be done for all records at once by calling Cleanup Database.

More Infos
· Usually, all 3 EXIF date fields are identical, and the difference only applies to older cameras.
· During Image Annotation and Database Cleanup, CreationDate and DateTimePhoto are set to
equal, if one of the values is empty. Usually, you cannot edit this field manually in EXIF editors.
CodedColor makes an exception, in order to allow you to correct false camera settings. Even in
the EXIF Batch Conversion you can therefore edit all three EXIF date fields.
· In Windows it is possible, that the ModificationDate of a file is jounger than the CreationDate. This
can happen, if you move a file to another disk. For Windows, this file is "newly created" on the
disk.
· The top menuitem Tools > Restore Creation Filedates in the Explorer allows you to reset the
filedates of all edited images in the current folder to DateTimeOriginal. That way, you can sort
your images in the orignal creation order in applications like the Windows Explorer. You could also
turn on Preserve original filedates when saving image changes in the Options > Image Editor
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dialog. That way, the filedate (modification time of the file) does not change when you edit and
save the image in the Image Editor.

10.2

Why does it take long to browse a folder for the first time?
From a newsgroup thread:
Q: Why is Xnview faster in displaying thumbs, and why does the speed in CodedColor improve the
second time I browse the folder?
A: If you are in the Imageview of the Explorer, and the filmstrip at the top displays only 10 thumbs, then
only these are created and loaded, until you scroll further. This is different for the Detailsview, which
needs ALL files to allow sorting. It must "grab" each file and get infos like filedate, filesize and pixel
information, which might take longer for large images.
When in Thumbsview, all displayed thumbs must be loaded from the thumbfiles. So if your thumbs are
small and you have a large amount of thumbs on the screen, this might take long. Xniew usually has a
very small thumbpanel, so only very few thumbs are loaded at a time. In CodedColor, once all the
thumbs are created and loaded, then they are cached by the operating system (at least from w2k on),
and scrolling becomes very fast.
Remember again, that when you first enter a new directory, then the thumb files have to be created onthe-fly, in other words when viewed. So again, if you are in the thumbsview, then a lot of thumbs have
to be created, as seen by the filename disappearing at the bottom. The second time you enter this
directory (if all thumbs have been created), then you should not experience any significant delay. Our
thumb creation is also threaded, so it should be possible to continue work while thumbs are created.
Now for a small benchmark with Xnview: When enlarging the thumb panel to show an EQUAL amount
of thumbs with the SAME size as in CodedColor, I experienced a shorter loading time of about 30% in
Xnview. The drawback in Xnview is: everytime you reenter the directory, you get the same loading time
(unless you set the thumb cache option). In CodedColor when you reenter, the loading time is 50%
faster than Xnview, because we have created thumb files with a fraction of the size of the originals. So
basically, I think we can improve on the topic of "first entry" (to put some erotic into my words), but our
thumb concept already has speed advantages over most other applications.

Summary
· CodedColor generates thumbs on-the-fly, as the images are viewed in the Explorer. Once the
thumbs are created, browsing a folder becomes much faster.
· CodedColor does not store thumbs in a database like Xnview, but as files on your harddrive. This
is a more stable but slightly slower technique, which may be subject to change in the future.
· If you have a directory with a lot of images, the image (filmstrip at top) and Screenshow mode are
the fastest way of browsing the directory, because only a few thumbs need to be created at once,
as opposed to the Detailsview and Thumbsview, where a lot of files are displayed at the same
time.

Related topics
· How can I improve the overall speed?
· Database program options
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How can I improve the overall speed?
To improve the speed in the Explorer, look into the following options:
· Don't store too many images in the same folder. Even if you shoot several hundred photos a day,
maybe you can split the day into two or three topics and put each topic into a different folder.
· Program Settings > Database: Decrease the width of generated thumbs to less than 250 pixels
· Program Settings > Database: Increase the thumb creation threshold to more than 100 kb
· Compress the database by calling Cleanup database
· Program Settings > Installation: Move the Workdirectory to a faster harddrive
· Program Settings > Explorer: Uncheck the Antialias Thumbs option.
· Regularly defragment the harddrives containing your Workdirectory and your images. You can
usually find a tool for this in the Windows utilities.
· Don't view your images directly on removable media (Compact Flash Card) or network drives.
Copy or move the images to your local drive, before you start to work with them.

Related topics
· Why does it take long to browse a folder for the first time?

10.4

Are my images stored in the database?
The database only contains EXIF and IPTC data from the images, and any information you manually
entered in the annotation dialog, i.e. title, description and keywords of an image. Your images on disk
are never touched, written to or stored in the database. For each image viewed in the explorer, a
thumb file is created. This thumb file is not stored in the database, but rather in the
Workdirectory\Data\Thumbs folder.

Related Topics
·
·
·
·

10.5

Database definition
Glossary: XML
Can I view the contents of the database?
Is the database compatible with other programs?

Can I view the contents of the database?
Yes: You have to export the database as XML and open the output result named FILES.XML in a
texteditor or the Internet Explorer.

Related topics
·
·
·
·

Export Database
Database definition
Glossary: XML
Is the database compatible with other programs?
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Why does the program stay active in the tray?
When you close CodedColor, the program icon remains visible in the system tray. There is only one
reason for this: CodedColor monitors filename and directory changes on your hard drives in order to
keep the database records and catalog entries linked to the original images, in other word
synchronous. We do not only correct broken links, like other applications, but try to prevent them in the
first place. This - along with a unique broken link correction algorithm - assures, that loosing
annotations only happens if you delete your original images (which of course is a "wanted" behavior).
The automatic broken link detection and correction is one of the features which positively distinguishes
us from all other proffessional image database applications, where the database often becomes
inconsistent, large and slow after a few months. In CodedColor, you have no redundant, obsolete or
broken records!

More information
· In case you're worried about the word "monitors", here's a more detailed explanation: The
Windows Explorer sends messages into the system, when a user renames, deletes or moves files
or directories. These notifications are used by CodedColor to correct the database records. So
there are not a lot of resources used up by the trayicon, as CodedColor only becomes active when
it receives one of these notifications.
· In case you are planning on doing massive renaming and moving of (nonimage) files or directories
in the Windows Explorer, you can prevent the filechange notification by terminating CodedColor:
· Press CTRL-ALT-F4, if CodedColor is active, or
· do a Right Mouseclick on the trayicon, and choose Terminate
· If you are low on resources, you can turn off the tray monitoring in the Program Settings.

Related topics
· How do you handle broken links?

10.7

What's the difference between albums and catalogs?
Folder
Directory on your harddrive or on a CD, where your images are physically stored. If you connect a
removable media to your computer, like a Compact Flash Card, then your images are usually located
below a folder named DCIM.
Album
A marked folder, which is to be included in the database. All images in or below this folder are added
as records to the database, and can be searched, annotated or excluded from the album. Each album
receives an Album Link, which can be found in the Organizer and serves as a shortcut to the physical
folder.
Catalog
A collection of pictures independent of folder structure. A catalog is something like a sequential
slideshow, showing photos from different locations (folders) on your harddrive. The image files are not
actually copied to the catalog folder, but linked to. This saves diskspace and enables you to put the
same image into several catalogs at the same time. If you edit the original image or change the title or
annotation, then the changes are reflected in all catalogs containing this image. Catalogs are stored in
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the CodedColor Organizer.

More information
· Sorting images inside folders is done by renaming the original files.
· Sorting entries inside catalogs is done by renaming the linkfiles. The original files remain
untouched.
· You can open the catalog in the Organizer, doubleclick on an image and step though the images in
fullscreen, just like in any normal directory. The only (unnoticeable) difference is, that the catalog
contains links to original images from different directories.
· You can have albums within albums. You could for instance define an album "2003" for all your
vacations in that year, and then a subalbum "Mexico" for just your last trip.

10.8

How can I reduce the size of images?
There are several alternative ways of reducing the size of images (1-3 allows several selected images
at a time):
1.

Call Convert files. The reduced images can be found under
Workdirectory\Organizer\Conversions

2.
3.

Call Export Web album, and determine the image width. The reduced images can be found
under Workdirectory\Organizer\Album Export
Call Mail Files. The reduced images can be found under
Workdirectory\Organizer\Conversions

4.
5.

Open the image in the Image Editor. Call Edit > Resize, and save the result manually under a
new filename.
Open the image in the Image Editor. Call File > Save As, and store the image under a more
efficient format (i.e. BMP to JPEG) or using a different quality factor.

Hints
· The easiest and most efficient way to reduce the disk space for your images, is to store them in
the JPEG (photos) or GIF (web graphics) format. If you have a directory with BMP files for
instance, you can run a Batch Conversion over it, with a filetype change to JPEG, to drastically
reduce the needed disk space.
· If you archive JPEG or other compressed images using the CodedColor ZIP Utility, you will not
gain any diskspace, as JPEGs are already compressed. For uncompressed BMPs however, you
will see a reduction.

10.9

How stable is the database?
Excerpt from a newsgroup thread:
Q: I wonder how capable and stable the database is? I've seen other programs that cannot handle too
many images (I have several thousand pictures). The ACDsee database gets corrupt after a certain
point & I delete the huge thumbnail index file periodically, this of course makes the annotation feature
effectively unusable because all data is lost above a certain size.
A: The CodedColor database is very stable and tolerant to program crashes. So far we have only
experienced one database corruption for every 50.000 users. But if you're worried, do backups from
inside CodedColor regularly. Database corruption will only loose data up to the last backup.
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The thumb database can always be rebuilt. Use the Clear Cache button in the Program Settings >
Database tab for this.

Related topics
· Backup Database

10.10 How do you handle broken links?
Loosing image annotations is one of the most common problems in image applications. Not all
information, like IPTC or EXIF tags, can be stored inside the image itsself. CodedColor stores image
titles, keywords and descriptions inside a database. This ensures comfortable editing and fast
searching. We are using three innovative methods to keep your database synchronous with your
filesystem.
1. System notifications to prevent broken links. CodedColor stays active in the tray to receive
messages from Windows, related to filename or directory modifications or deletions.
2. On-the-fly broken link correction. CodedColor finds and corrects records in the database and
inside catalogs, if the corresponding image files were moved or renamed from outside of
CodedColor.
3. If you rename, move or delete images inside of CodedColor, then database records and catalog
entries are corrected immediately.

Related topics
· Why does the program stay active in the tray?

10.11 Is the database compatible with other programs?
Excerpt from a newsgroup thread:
Q: I have been warned about software that is not compatible with CSV database programs (comma
separated value). I don't know a lot about the technicalities, but I do want to be able to change to or
integrate with other database programs. Can someone explain whether the databases in Codedcolor
are proprietary or universal?
A: At the moment, we only provide the default XML database for CodedColor. At a later time, we will
enhance connectivity by adding support for Microsoft Access. If you want to view or transfer the image
data from the database now, you have to export it to XML and open the result in a texteditor or the
Internet Explorer. The output FILES.XML is a plaintext (ASCII) file, which is sort of an enhanced CSV
format. Most modern databases are capable of importing this format.

More information
· To learn more about the internal database format, see table definition.

10.12 How do I register from behind a firewall?
CodedColor is an application with many features oriented towards the web, like the LiveUpdate dialog
and the Registration form. All web interaction is done uniquely by means of the HTTP protokol, so if
you can open a browser window and navigate to an URL, you should have no problems in CodedColor.
© 2013 1STEIN GmbH

FAQ

107

If you cannot use an online feature of CodedColor, and you think this might have something to do with
a firewall between you and the internet, you may want to try to enter the URL in a standard browser.
Usually you can find the URL that failed in the Windows clipboard, where it was put by CodedColor
when the problem occurred.
If you want to register CodedColor from a different PC copy ProgramID and URL from the registration
page and enter the internet address (URL) into your browser with internet connection.

Hint
· You could also have a look at the file tracehtp.log in your CodedColor program directory. This
file shows the last HTTP commands and may give insight to the source of the problem. Open the
file in any texteditor.

Related topics
· Registration

10.13 Can I narrow the database search to a specific folder?
You can narrow the search for images in the database downto specific locations by checking the field
FilePath and adding a search value with the desired path.
Example
Narrow your search result to all images below d:\images\2002 by adding the search value
"d:\images\2002", combined with a dropdown selection with ALL the words.

10.14 Can I annotate my bookmarks with CodedColor?
Bookmark Tutorial
At the moment, CodedColor only supports bookmark collections coming from the Microsoft Internet
Explorer. To organize and annotate your internet links (Favorites), follow these steps:
1.

Open the Organizer window.

2.

Browse to the folder Online Albums, and hilite the file entry Favorites. This entry is a linkfile
pointing to your Internet Explorer bookmark collection. If you cannot find this entry here, look in
the folder Shortcuts. If you still cannot locate this linkfile, you can always manually browse to
the folder containing you bookmarks and create an album linkfile.

3.

Edit the Favorites linkfile by pressing SHIFT+F2, or by clicking on the Edit Album button.

4.

Switch to the Options tab and enable Open location as top node in Explorer. This ensures,
that your favorites folder is shown as the top entry in the explorer tree. (You can skip steps 3-4
in the future.)

5.

Press OK to save the changes, and doubleclick on the Favorites linkfile to open the location in
an Explorer window.

6.

Now you can browse and organize your Internet Explorer bookmarks. If you want to open a
webpage, just doubleclick on the corresponding linkfile.

7.

To annotate a bookmark, for instance to remember login data for a secure webpage, hilite the
linkfile and press the Edit linkfile button in the information panel at the lower left of the explorer
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window.

10.15 Why are not all keywords displayed in the dearch dialog?
The keywords are subject to the following rules:
· In the annotation editor all keywords that were ever defined by the user are displayed, regardless if
they are assigned to an image or not.
· In the database searchdialog only those keywords are displayed, which are actually contained in
the database, i.e. which were assigned to an image at some time. Obviously, it doesn't make
sense to search for a keyword that was never used for an image. The same is true for the
Keyword View of the Explorer.
· Keywords from IPTC fields are transferred to the database when the image is first viewed. In a
directory with many hundreds of images, this would require a lot of manual browsing by the user,
in order to transfer all keywords to the database. For this reason, the concept of albums was
developed. If you define an album for the specific directory, and set the checkbox Add all
database records now in the album dialog to true, then all image information of that directory
including EXIF and IPTC fields are stored immediately in the database after the dialog is closed.

Related Topics
· What's the difference between albums and catalogs?
· Why does it take long to browse a folder for the first time?
· EXIF/IPTC fields

11

Glossary

11.1

Alpha Channel
An alpha channel is a special type of channel used in graphics software for saving selections. Most
bitmap editing software allows you to save multiple alpha channels with an image when it is saved in
the program's native file format. Any of the alpha channels can be reloaded as a selection or mask at
any time, even after closing and reopening the image.
A few of the standard image formats (TIFF and PNG, for example) provide support for an embedded
alpha channel which represents up to 256 levels of transparency. Images with an embedded alpha
channel can be ported to other applications while retaining transparency as long as the other
application also supports alpha channels. Like a mask, the darkest areas of an alpha channel is most
transparent, white areas are opaque, and shades of gray represent varying levels of transparency.
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Antialias
Antialias is an algorithm to smoothen noise, artefacts, crooked lines, borders and squares resulting
from zoom or resize operations. Is is sometimes simply called Filter. The most common antialias filters
in CodedColor are Lanczos3, Fast Linear and Fast Svastano.
Example of Antialias:

Without antialias

Antialiased

Tipps
· You should always use an antialias filter when doing a resize operation in the image editor.

Related Topics
· See http://en.wikipedia.org/wiki/Antialiasing for more information

11.3

EXIF
EXIF stands for Exchangeable Image File Format, and is a standard for storing interchange
information in image files, especially those using JPEG compression. Most digital cameras now use
the EXIF format.
Read more on the web
Read how CodedColor handles EXIF

11.4

FFmpeg
FFmpeg is a free utility to convert movies. It is used in CodedColor to convert movie files into FLV
format for flash albums. If you are asked to locate FFmepg.exe on your drive, and have not
downloaded it yet, get it here, or at any other of the numerous locations on the web. Copy it into
C:\ProgramFiles\CodedColor, or wherever codedcolor.exe is installed. You must have
Admin rights to copy it into this folder. Alternatively you can tell CodedColor where this file is located
on your system.

Copyright
FFmpeg may not have been installed with CodedColor, because there are license limitations when
shipping it inside commercial programs. Generally there are no legal limitations, if you download,
install and use it privately.
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Gamma
Gamma is related to Brightness. The main difference is, that in Gamma correction, dark and midtone
areas are adjusted more than bright areas. This non-linear technique is based on the fact, that the eye
does not notice brightness changes in shadows as much as in lighter areas.

11.6

Histogram
The Histogram is the most important fingerprint of an image. It can warn you if an image is
underexposed or overexposed. Modern cameras can display the histogram before you take the
picture, so you can find the optimal exposure for the photo. The following examples show how to
interpret histograms.
The left side of the curve represents the shadows, while the highlights are on the right side. If the
histogram has a high peak on the left, a lot of pixels in the picture are dark, or in shadow. A peak on
the right of the curve means that a lot of pixels are bright, or in the highlights. Peaks in the middle of
the graph represent pixels in the midtones of your exposure. Ideally, curves blend into the horizontal
axis before reaching the right and left edges.
Balanced exposure
A histogram, that starts from the horizontal axis on the left
and the right side of the curve, can be considered well
balanced. The light is well distributed through the image.

Underexposed photo
A histogram, that seems cropped at the left side, can be
considered underexposed. This curve is missing values in
the shadows, meaning that the picture is too dark.

Overexposed photo
A histogram, that seems cropped at the right side, can be
considered overexposed. This curve is missing values in
the highlights, meaning that the picture is too bright.

Critical photo
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This photo can probably not be corrected. It was taken
against the sun, so there is a very bright sunbeam in the
photo, causing most of the rest to be badly
underexposed. This can be deducted from the two peaks
to the left and right side of the curve.

CodedColor has a number of tools to correct exposure. See the following topics for more
infomation:
· Exposure Correction
· Histogram & Curves
· SmartFix

11.7

HSV & HSL
HSV
A color model that describes color in terms of Hue, Saturation and Value. The Hue is the color like red
or blue, the Saturation is how strong the color is, and the Value is the brightness. This is sometimes
also called HSB (Hue Saturation Brightness).
HSL
A color model that describes color in terms of Hue, Saturation, and Lightness.
Details:
A. Hue
The distinct characteristics of color that distinguishes blue from red and yellow from green, etc.
Technically, hue is the dominant wavelength in the reflected or emitted light.
B. Saturation
The intensity of a color with respect to its brightness or value. Given a level of brightness, saturation
measures the amount of gray in a color. A color that lacks gray impurities will seem more intense
and vivid. Saturation is closely related to chroma. The less gray, white, or black a color has in it, the
more pure and vivid it will appear.
C.1 Value, Brightness
Describes how light or dark we perceive a color to be. The higher the brightness value, the closer the
color will be to white.
C.2 Lightness, Luminance
The lightness or luminance of a color is similar to its value or brightness, but the two are not the
same thing. In the physical world, luminance is the physically quantifiable intensity of light measured
in energy per unit area. On your computer the sun may appear brighter than a tree, but in reality
each pixel on the screen is emitting the same amount of energy. Luminance is a way to recreate that
light effect on the computer. Colors wash out as luminance increases and colors darken as
luminance decreases.
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IPTC
The International Press Telecommunications Council was established in 1965 to safeguard the
telecommunications interests of the World's Press. Since the late 1970's its activities have primarily
focussed on developing and publishing Industry Standards for the interchange of news data. IPTC
membership is drawn from major news agencies, newspaper publishers, news distributors and
vendors from around the globe.
JPEG File Information
The DataSets from the IIM Record 2 have been adopted by Adobe for their PhotoShop product and are
used to add data to an image using the "File Info" option.
Read more on the web
Read how CodedColor handles IPTC

11.9

JPEG 2000
JPEG 2000 is a new image coding system that uses state-of-the-art compression techniques based on
wavelet technology. Its architecture should lend itself to a wide range of uses from portable digital
cameras through to advanced pre-press, medical imaging and other key sectors.
Read more on the web

11.10 Lossless rotation
Lossless rotation is a very important new feature of CodedColor. Since JPEG is the standard image
format for digital cameras, and since most of your image editing is reduced to simple rotation, this
feature ensures that your images will not experience quality loss anymore. You can rotate an image as
many times as you wish, without loosing any pixel information. Not all image applications support
lossless rotation yet, so make sure to check this before doing any rotations outside of CodedColor. In
all other editing cases, you should avoid saving your changes to the original JPEG file, as you will loose
quality for every Open / Save combination!
To understand more about JPEG compression and quality loss, read this short essay from Bob
Johnson, an award winning photopgrapher:
JPEG files are by far the most common image format used to display photography on the web and
for good reason. The JPEG format does a far better job of retaining color fidelity than the GIF format.
Because of the compression scheme used by JPEG, continuous-tone images, such as photos can
be a lot smaller than GIFs. It's not uncommon for JPEGs to compress 20:1. Photos stored as GIFs
can only compress at or near 5:1. The GIF format does work better for line art and graphics with
large single-color areas.
The most important thing to keep in mind is that JPEG is a lossy compression algorithm. That means
that every time you save a JPEG, you are losing information in the process. Open a JPEG more than
once, tweak something, then resave it and the loss gets even worse. Do it a third, fourth or fifth time,
and it gets worse still. The file sizes will still be about the same, but the images will look worse each
time.
How do you get out of this vicious cycle? Never open a JPEG, edit it and resave it as a JPEG.
Instead, always save your new image in the PSD, TIFF, or other native raw format. After this, you
can re-save as a JPEG. The JPEG is your original you say? Before you do anything else, save it in
some lossless format (such as PSD or TIFF) and now you can pretend that that file is your original.
© 2013 1STEIN GmbH

Glossary

113

Related topics
· Rotating Pictures

11.11 Monitor Calibration
Gamma
Move away from your monitor and squint your eyes. In the following test strip, the numbers 2.2 should
almost disappear, meaning that you monitor is correctly calibrated to a Gamma value of 2.2. Careful:
You will get different results in very light or very dark environments.

Another test: In the following strip the first two and the last two rectangles tend to blend into each other.
If you actually see a difference, your monitor has perfect Gamma calibration.

Color depth and tone
Calibrating the color of your monitor with your eyes only is not possible. There are plenty of webpages
on the internet, where you can download color charts and compare them to printed paper strips from
KODAK or likewise. There are usually two types of color charts: RGB for monitors, beamers, websites,
presentations and films, and CMYK for print products. You may also downlad Adobe Gamma, a tool
which allows for some basic software-based calibration. If you're an image editing professional, you
should buy a hardware-based monitor calibration tool.
If you have a good personal printer, and are generally satisfied with the printed results, you can also
print out a photo (preferably showing human skin) or a color chart, hold it next to your monitor and
adjust the colors until they match the printout. Make sure your monitor is in high color or 24-bit mode
(Windows monitor & graphic properties), the room is dimmed, but not too dark, and there are no
reflections on the monitor.
Never edit your images without a backup! (see Automatic Backup Option)

11.12 Parallax
When you shoot panorama frames, there are two effects that can cause major problems for the
stitching software: Parallax and Lens Distortion.
1. The Parallax effect
Parallax results from the same physical law that allows us to see 3-dimensional. If you close one eye
and rotate your head, you will notice that objects change their relative position to each other. Since we
actually have two eyes, we can see 3-dimensional without the need for head movement. For a camera,
which is turned in order to shoot panorama frames, the same effect applies. If two objects on bordering
frames lie in the stitch area, and if these two objects are shifted due to the camera movement, then the
stitching software may have problems finding the corresponding characteristic points in the two frames.
In the best case, this can cause object ghosting, frame distortion or blurring.

© 2013 1STEIN GmbH

114

CodedColor Photostudio - Documentation

"Ghost mountain" resulting
from Parallax

How to avoid Parallax
Parallax comes from the movement of objects in 3D. If everything in the scene is approximately the
same distance from the lens, or very far away, parallax will not occur, or at least be minimized. This
is why handheld panoramas from a mountain top tend to work quite well - everything is far away from
the camera, and the distances are very large compared to the tiny distance between the nodal point
and the point of rotation.
Another way to reduce
parallax, is to use a special
tripod, which allows you to
rotate the camera around the
nodal point of the lens.

2. Lens Distortion
Wide angle and fisheye lenses have a tendency to warp the edges of the picture. The distorted view
causes the stitching software to become confused when trying to glue the frames together. The end
result again is overlapping ghost images, similar to the parallax syndrome.

Tips for shooting panoramas
CodedColor PhotoStudio tries to correct the parallax effects by warping bordering frames, until the
characteristic points overlap best. The downside is, that linear objects like trees, buildings or horizons
may appear distorted in the stitched panorama. So, it's best to try and avoid parallax in the first place:
· Try to use a tripod.
· Make sure the axis of rotation is perfectly vertical (You can also later correct the frame horizon in
the image editor)
· Try to move the nodal point of the lens over the axis of rotation. You may need to construct a
special mounting plate for this.
· Try to exclude near objects, if you are making a long distance panorama.
· Try to use a focal length of around 50 mm, in order to reduce lens distortion. Stay away from wide
angle lenses.
· Make sure you have overlapping regions of at least 20-30% (stitch area).
· Avoid shooting frames against the sun (backlight situations).
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11.13 RAW image formats
Some, typically more professional, cameras allow you to store images in RAW format. RAW format is
not really an image standard. It is different for every camera model. RAW format images contain all the
data that is taken directly from the camera's image sensor, before the software in the camera applies
things like white balance, sharpening etc. Most professional photographers use RAW format, because
it offers them maximum flexibility for later image editing. The downside is, that RAW image files can be
very large, and loading time for software applications can increase immensely.
CodedColor supports the following RAW image formats. All formats are read only, i.e. you cannot save
images in RAW format in the image editor.
RAW file type

Description

CRW, CR2

Canon digital camera

MRW

Minolta digital camera

NEF

Nikon digital camera

ORF

Olympus digital camera

RAF

Fuji digital camera

PEF, PTX

Pentax digital camera

X3F

Sigma digital camera

DCR, KDC

Kodak digital camera

SRF, SR2

Sony digital camera

RAW

Panasonic, Casio, Leica digital camera

DNG

Adobe RAW file format (Digital NeGative)

BAY

Casio digital camera

A complete list of supported cameras can be found on our webpage.

More Infos
· Few people know, that the TIFF image format is like a "standardized" RAW format. Some
cameras offer this format for maximum image quality.
· CodedColor loads half size RAW images in the Explorer to improve speed. In the Fullscreen
mode and the Image Editor, the original RAW images are loaded.

11.14 RGB & CMYK
RGB
An additive color model that starts with black, the absence of light.
Computer monitors emit a combination of three colors: Red, Green, and
Blue to create a full color display. Unlike the subtractive CMYK model, with
all three RGB colors combined, we get white light.
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CMYK
A color model based on four process colors: Cyan, Magenta, Yellow, and
Black. The colors are mixed to create a full-color image on a printer. The
printing press prints an image in four separate layers starting with yellow,
then cyan, magenta, and black.
The CMYK color model is different from the RGB model used on your
computer display and digital cameras. Unlike a computer screen which
emits light, ink absorbs it and the color our eyes perceive is the color that
is reflected from the paper. Because the process involves absorbed
instead of emitted light, CMYK is a subtractive color model (you start with
white light and create colors by absorbing certain wavelengths of that
light).
Cyan absorbs the red component of white light, magenta absorbs green,
and yellow absorbs blue. As you mix cyan, magenta, and yellow together,
you will eventually get black.

11.15 TWAIN
TWAIN is a standard for getting input from scanners through an API for Microsoft Windows and Apple
Macintosh operating systems. The standard was first released in 1992, and is currently ratified at
version 1.9 as of January 2000. TWAIN is typically used as an interface between image processing
software and a scanner or digital camera.
The word TWAIN is from Rudyard Kipling's "The Ballad of East and West" - "...and never the twain
shall meet...", reflecting the difficulty at the time, of connecting scanners and personal computers. It
was up-cased to TWAIN to make it more distinctive. This led people to believe it was an acronym, and
then to a contest to come up with an expansion. None were selected, but the entry Technology Without
An Interesting Name continues to haunt the standard.

Related topics
· TWAIN Import in CodedColor

11.16 XML
Extensible Markup Language (XML) is a simple, very flexible text format derived from SGML.
Originally designed to meet the challenges of large-scale electronic publishing, XML is also playing an
increasingly important role in the exchange of a wide variety of data on the Web and elsewhere.
Read more on the web
Below is the top part of the CodedColor FILES.XML database export, as viewed in the Internet
Explorer or any texteditor:
<?xml version="1.0" standalone="yes" ?>
- <DATAPACKET Version="2.0">
- <METADATA>
- <FIELDS>
<FIELD attrname="FID" fieldtype="i4" readonly="true" SUBTYPE="Autoinc" />
<FIELD attrname="Checked" fieldtype="boolean" />
<FIELD attrname="Volume" fieldtype="string" WIDTH="50" />
<FIELD attrname="VolumeID" fieldtype="i4" />
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<FIELD attrname="DrvType" fieldtype="i4" />
<FIELD attrname="FilePath" fieldtype="string" required="true" WIDTH="255" />
<FIELD attrname="FileSize" fieldtype="r8" />
<FIELD attrname="FileDate" fieldtype="dateTime" />
<FIELD attrname="FileAttr" fieldtype="i4" />
<FIELD attrname="Created" fieldtype="dateTime" />
<FIELD attrname="FileUrl" fieldtype="string" WIDTH="255" />
<FIELD attrname="OrgDate" fieldtype="dateTime" />
<FIELD attrname="Title" fieldtype="string" WIDTH="255" />
<FIELD attrname="Description" fieldtype="bin.hex" SUBTYPE="Text" WIDTH="255" />
<FIELD attrname="Keywords" fieldtype="string" WIDTH="255" />
<FIELD attrname="UserData" fieldtype="bin.hex" SUBTYPE="Text" WIDTH="255" />
<FIELD attrname="ImageData" fieldtype="bin.hex" SUBTYPE="Text" WIDTH="255" />
</FIELDS>
<PARAMS AUTOINCVALUE="4455" />
</METADATA>
- <ROWDATA>
<ROW FID="1" Checked="TRUE" Volume="DATA4" VolumeID="386542634" DrvType="3"
FilePath="E:\Eigene Bilder\Stupsi\blazer1.jpg" FileSize="209200"
FileDate="20010719T13:56:26000" FileAttr="32" Created="20010719T14:57:14000"
FileUrl="" OrgDate="20000331T20:46:07000" Title="" Keywords="" ImageData="$XVER=1
$XTYPE=1 $10F="CASIO" $110="QV-2000UX" $112=6 $11A=72/1 $11B=72/1 $128=2
$131="99.09.07.11.08. ......" $132="2000:03:31 20:46:07" $213=1 $8769=210
$829A=10000/640204 $829D=20/10 $8822=2 $9000="0210" $9003="2000:03:31 20:46:07"
$9004="2000:03:31 20:46:07" $9101="...." $9102=2048000/480000 $9204=0/3
$9205=20/10 $9207=5 $9209=1 $920A=191102/10000 $927C="$A000="0100" $A001=1
$A002=800 $A003=600 $A005=790 $1="R98" $2="0100" $A300="." $XMS=CASIO $1=1 $2=3
$3=3 $4=1 $5=13 $6=2078 $7=1 $A=65536 $B=0 $C=0 $D=0 $14=80" />
<ROW FID="2" Checked="TRUE" Volume="DATA4" VolumeID="386542634" DrvType="3"
FilePath="E:\Eigene Bilder\Stupsi\domrep1.jpg" FileSize="108132"
FileDate="20010204T14:42:48000" FileAttr="32" Created="20010718T19:59:44000"
FileUrl="" OrgDate="20010718T19:59:44000" Title="" Keywords="" />
...

More records...

12

Appendix

12.1

Database definition
The following list describes the database fields available as of version 2.7 of CodedColor. The list is
subject to change in later versions. Some fields like "UserData" are currently not used and reserved for
later versions. The database can be exported into XML, so the data can be viewed in the Microsoft
Internet Explorer.
Extract of the field definition file Workdirectory\Data\Files.tdf
[FID]
DataType=ftAutoInc
Description_EN=Unique record identifier
Description_DE=Primärschlüssel
[Checked]
DataType=ftBoolean
Description_EN=Include in albums and printing
Description_DE=Bilder ausgewählt (z.B. für Alben, Export, Druck)
[Volume]
DataType=ftString
Description_EN=Volume or CD label
Description_DE=Datenträger Bezeichung
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[VolumeID]
DataType=ftInteger
Description_EN=Volume or CD serial number
Description_DE=Datenträger Seriennummer
[DrvType]
DataType=ftInteger
Description_EN=Removable: 2; fixed: 3; remote: 4; CD drive: 5
Description_DE=Wechselspeicher: 2; Festplatte: 3; Netz: 4; CD: 5
[FilePath]
DataType=ftString
Description_EN=Path and name of local file
Description_DE=Dateiname inkl. Pfadangabe
[FileSize]
DataType=ftFloat
Description_EN=Filesize in bytes
Description_DE=Größe der Datei in Byte
[FileDate]
DataType=ftDateTime
Description_EN=date when file was last modified
Description_DE=Letzte Änderungsdatum der Datei
[FileAttr]
DataType=ftInteger
Description_EN=File attributes
Description_DE=Attribute der Datei
[Created]
DataType=ftDateTime
Description_EN=Creation time of filesystem
Description_DE=Erstelldatum der Datei
[FileUrl]
DataType=ftString
Description_EN=Adress of remote file
Description_DE=Verknüpfungsziel der Datei oder Internetadresse
[OrgDate]
DataType=ftDateTime
Description_EN=Time of photo or file creation stamp
Description_DE=Aufnahmedatum des Fotos oder Erstelldatum der Datei
[Title]
DataType=ftDropdown
Description_EN=Titel
Description_DE=Titel des Fotos bzw. der Datei
[Description]
DataType=ftMemo
Description_EN=File annotation
Description_DE=Beschreibung des Fotos bzw. der Datei
[Keywords]
DataType=ftCheckList
Description_EN=List of words for searching
Description_DE=Liste von Schlagwörtern zum katalogisieren des Fotos bzw. der Datei
[UserData]
DataType=ftMemo
Description_EN=Additional user fields (IPTC)
Description_DE=Weitere Felder (IPTC)
[ImageData]
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DataType=ftMemo
Description_EN=EXIF image information
Description_DE=EXIF Informationen (z.B. von der Kamera)

12.2

Supported File Types
CodedColor supports the following major file formats and compression standards.
Picture file types (list incomplete)
·
·
·
·
·
·
·
·
·
·
·
·
·
·
·
·

Adobe Photoshop, view only (PSD, PDD)
Bitmap (Windows & OS2) (BMP, DIB, RLE)
Wireless Bitmap (WBMP)
Graphics interchange format (GIF, animated GIF)
Joint Photographics Experts Group (JPG, JPEG, JPE).
JPEG2000 (JP2, J2K)
Kodak Photo CD, view only (PCD)
Portable Bitmap, Greymap and Pixelmap (PBM, PGM, PPM)
Portable Network Graphics (PNG)
Tagged Interchange File Format (TIFF, multipage TIF)
Truevision TARGA (TGA, TARGA)
Windows Cursor, view only (CUR)
Windows Icon, view only (ICO)
Windows Metafile (WMF, EMF)
ZSoft PaintBrush (PCX)
All RAW camera formats

Multimedia filetypes
· Microsoft AVI files
· Apple Quicktime (MOV) - requires Quicktime DirectShow Codec. We recommend installation of
the free K-Lite Codec Pack.
· Moving Picture Experts Group (MPEG)
· Advanced Windows streaming format (ASF)
· Windows Media Video (WMV)
· MP4 and all other filetypes supported by the K-Lite Codec Pack (search for "DirectShow" in
Online FAQ)
Advanced features
·
·
·
·
·
·

Jpeg Lossless transformations
Load of Exif information
Editing of multi TIFF: extract, insert and delete single images.
Editing of animated GIF: extract, insert and delete single images.
Read/Write IPTC (IIMV4) information (like PhotoShop file info) from JPEG. Can replace IPTC
information without load or change original image.
Load Alpha Channel (transparent images) for GIF, TIFF, PNG, ICO, CUR, TGA

Important
·
·
·

For storing pictures we recommend JPEG, due to the space savings and benefits of embedded
data.
For textscans and screenshots we recommend GIF
For web graphics we recommend PNG (transparency)
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Date Format String
Specifier

Displays

d
dd
ddd
dddd
m

Displays the day as a number without a leading zero (1-31).
Displays the day as a number with a leading zero (01-31).
Displays the day as an abbreviation (Sun-Sat)
Displays the day as a full name (Sunday-Saturday)
Displays the month as a number without a leading zero (1-12). If the m specifier
immediately follows an h or hh specifier, the minute rather than the month is displayed.
Displays the month as a number with a leading zero (01-12). If the mm specifier
immediately follows an h or hh specifier, the minute rather than the month is displayed.
Displays the month as an abbreviation (Jan-Dec)
Displays the month as a full name (January-December)
Displays the year as a two-digit number (00-99).
Displays the year as a four-digit number (0000-9999).
Displays the hour without a leading zero (0-23).
Displays the hour with a leading zero (00-23).
Displays the minute without a leading zero (0-59).
Displays the minute with a leading zero (00-59).
Displays the second without a leading zero (0-59).
Displays the second with a leading zero (00-59).
Uses the 12-hour clock for the preceding h or hh specifier, and displays 'am' for any
hour before noon, and 'pm' for any hour after noon. The am/pm specifier can use
lower, upper, or mixed case, and the result is displayed accordingly.
Uses the 12-hour clock for the preceding h or hh specifier, and displays 'a' for any hour
before noon, and 'p' for any hour after noon. The a/p specifier can use lower, upper, or
mixed case, and the result is displayed accordingly.
Displays the date separator character using windows settings
Displays the time separator using windows settings.
Characters enclosed in single or double quotes are displayed as-is, and do not affect
formatting.

mm
mmm
mmmm
yy
yyyy
h
hh
n
nn
s
ss
am/pm
a/p
/
:
'xx'/"xx"

Note: If the string specified by the Format parameter is empty, the value is formatted using the
windows default setting

Related topics
· What's the difference between file date and photo date?
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